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Welcome to your printer

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 914 mm (36 in)
wide. Some major features of the printer are shown below:

e  Print resolution of up to 2400 = 1200 optimized dpi, from a 1200 = 1200 dpi input, using the Best print-
quality option, the Maximum Detail option and photo paper.

e  The printer can be controlled from its front panel or from a remote computer using the Embedded Web
Server, HP DesignJet Utility, or HP Click Printing Software (see http://www.hp.com/go/desianjetclick).

e  Touch-sensitive front panel in color, with an intuitive graphical user interface.

e  Job previews in the front panel.

° Job previews on remote computers.

e Includes Web-connected features such as automatic firmware updates, HP ePrint, and Mobile Printing.

e  Driverless printing: Files in common graphical formats can be printed directly without needing a printer
driver. Just insert a USB flash drive or use HP Click Printing Software.

e  Paper flexibility and automatic easy load, see Paper handling on page 34, with information and presets
accessible from the front panel and the HP DesignJet Utility.

e  Handles cut-sheet and roll paper.

e  Six-ink system.

e  Accurate and consistent color reproduction with automatic color calibration.
e  Economode for printing economically.

e  Tworolls loaded at once (T2600MFP dr only) provide fast and easy switching between different rolls, or
long runs of unattended printing.

e  High productivity features such as job previewing and nesting using HP Click Printing Software.

e Ink and paper usage information available from the Embedded Web Server, see Embedded Web Server
on page 15.

e  Access to the online HP Support Center (see HP Support Center on page 222).

Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.

Full name Short name
HP DesignJet T2600 T2600

HP DesignJet T2600 PostScript Printer T2600 PS
HP DesignJet T2600dr T2600dr
HP DesignJet T2600dr PostScript Printer T2600dr PS
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Safety precautions

Read these safety precautions before using your printer. Also read your local Environmental, Health, and Safety
regulations.

This equipment is not suitable for use in locations where children are likely to be present.

For any maintenance or part replacement, follow the instructions provided in HP documentation to minimize
safety risks and to avoid damaging the printer.

General safety guidelines

There are no operator-serviceable parts inside the printer except those covered by HP's Customer Self Repair
program (see http://www.hp.com/go/selfrepair). Refer servicing of other parts to qualified service personnel.

Turn off the printer and call your service representative in any of the following cases:
e  The power cord or plug is damaged.

e  The printer has been damaged by an impact.

e  Thereis any mechanical or enclosure damage.
e  Liquid has entered the printer.
e  Thereis smoke or an unusual smell coming from the printer.

e  The printer has been dropped.

e  The printeris not operating normally.

Turn off the printer in either of the following cases:

e  During a thunderstorm.

e  During a power failure.

Take special care with zones marked with warning labels.

Ventilation measures for your location, whether office, copy room, or printer room, should meet local
environmental health and safety (EHS) guidelines and regulations.

Electrical shock hazard

AWARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous voltages
capable of causing death or serious personal injury.

Unplug the printer’'s power cord before servicing the printer.

The printer requires a building installation circuit breaker, which must meet the requirements of the printer and
should be in accordance with the Electrical Code requirements of the local jurisdiction of the country in which the
equipment is installed.

To avoid the risk of electric shock:
e  The printer should be connected to earthed mains outlets only.

e  Avoid overloading the printer's electrical outlet with multiple devices.
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Fire hazard

Do not remove or open any closed system covers or plugs.

Do not insert objects through slots in the printer.

Take care not to trip over the cables when walking behind the printer.

Insert the power cord securely and completely into the wall socket and printer inlet.

Never handle the power cord with wet hands.

To avoid the risk of fire, take the following precautions:

The customer is responsible for meeting the printer’s requirements and the Electrical Code requirements
according to the local jurisdiction of the country where the printer is installed. Use the power supply voltage
specified on the nameplate.

Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not use the
power cord with other products.

Do not insert objects through slots in the printer.

Take care not to spill liguid on the printer. After cleaning, make sure all components are dry before using
the printer again.

Do not use aerosol products that contain fltammable gases inside or around the printer. Do not operate the
printer in an explosive atmosphere.

Do not block or cover the openings of the printer.

Mechanical hazard

The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions
when working close to the printer.

4 Chapter 1

Keep your clothing and all parts of your body away from moving parts.

Avoid wearing necklaces, bracelets, and other hanging objects.

If your hair is long, try to secure it so that it will not fall into the printer.

Take care that sleeves or gloves do not get caught in moving parts.

Do not operate the printer with covers bypassed.

If you need to replace the cutter assembly, take care not to cut yourself on the sharp cutting edge.
Internal fan blades are hazardous moving parts. Disconnect the printer before servicing.

Never insert your hands into the printer while it is printing, due to the moving parts inside.
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Heavy paper hazard
Special care must be taken to avoid personal injury when handling heavy papers.

e  Handling heavy paper rolls may require more than one person. Care must be taken to avoid back strain
and/or injury.

e  When handling heavy paper rolls, wear personal protective equipment, including boots and gloves.

e  Follow your local Environmental Health and Safety regulations for handling heavy paper rolls.

Ink handling

HP recommends that you wear gloves when handling ink supplies.

Warnings and cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer
from being damaged. Follow the instructions marked with these symbols.

AWARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or
death.

A CAUTION:  Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the printer.

Warning labels

Label Explanation

Electric shock hazard. Power Supply inside that operates at
hazardous voltages. Disconnect all power sources before servicing.

Before starting, read and follow the operating and safety
instructions.

Moving part. Keep your fingers and hands away from the moving
paper system.
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Label Explanation

Moving parts. Rotating roll bar. Keep hands out.

Do not lift. Your fingers or hand may be trapped or crushed.

[%9 NOTE: The final label position and its size on the printer may vary slightly, but labels should always be visible
and close to the potential risk area.
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Main components

The following front and rear views of the printer illustrate the main components.

Front view

B NOTE: This illustration shows the T2600dr.

1. Scanner

2. Printhead

3. Stacker

4.  Front panel

5. Ink cartridge slot

6. Basket

7. lower roll cover ( T2600dr only)

8.  Upper roll cover
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Rear view

1. Power socket
2. Gigabit Ethernet port, to connect to a network
3. Diagnostic LEDs (to be used by service engineers)

The Hi-Speed USB host port is on the other side of the printer, beside the front panel.

Turn the printer on and off

*} TIP:  The printer can be left powered on almost without wasting energy. Leaving it on improves response time
and overall system reliability. When the printer has not been used for a certain period of time (the default time is
determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's
front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing
immediately. To change the sleep mode time, see Change system options on page 13.

@’ NOTE: Insleep mode, the printer performs maintenance service to the printheads from time to time. This
avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the printer
powered on or in sleep mode to avoid wasting ink and time.

If you want to turn the printer on or off or reset the printer, the normal and recommended method is to use the
power key beside the front panel.
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However, if you plan to store the printer for a long period or the power key does not seem to work, you are
recommended to unplug the power cord at the rear.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the
printheads. Preparing the printheads takes about 75 seconds. However, if the printer has been off for six weeks
or more, preparing the printheads could take up to 45 minutes.
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Front panel

The front panel is a touch-sensitive screen with a graphical user interface, located on the front right of the
printer.

It gives you complete control of your printer: from the front panel, you can view information about the printer,
change printer settings, monitor printer status, and perform tasks such as supplies replacement and
calibrations. The front panel displays alerts (warning and error messages) when necessary.

IO\

It includes the following components:
1. Thefront panelitself: a 15.6 inch, full-color, touch-sensitive screen with a graphical user interface.
2. The power key, with which you can turn the printer on or off, or wake up from sleep mode.

3. AHi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be printed.
When a USB flash drive is inserted, a USB icon ===l is displayed on the front panel's all-apps page.

The front panel has a large central area to display dynamic information and icons.
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Home pages

There are three top-level pages that you can move between by sliding your finger across the screen:

e  The main screen provides direct access to the main printer functions.

E
7

Print Scan Copy Job queue

© ¢ & @®

Paper Optimize quality Connectivity

127
About printer Usage Settings User's guide
EE
L
[
Print Scan Copy Job queue
ﬁ 1]

ENWW

The all-apps page displays a list of all apps available in your printer, and the status of each of them.

Front panel
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e Ifyouswipe left to the widget page, you can see at a glance the status of ink, paper supplies and job queue.

D HOW PRINTING

5 upnext e

© wstoRy L]

OF | |
N

e Atthe top of the all-apps page there is a dashboard that displays alerts related to the main functions of the
printer. Swipe down the dashboard to access the Status Center.

Dim mode

After some time with no activity (5 minutes by default), the printer goes to dim mode, which reduces the
brightness of the front panel by 25%. Any activity, such as the use of the front panel or the arrival of a print job,
ends dim mode and restores normal brightness. After some time in dim mode (15 minutes by default), the
printer changes to sleep mode. The time periods can be changed from the front panel.

Sleep mode

Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some elements to
save energy. Printer features can be enabled from this mode, and the printer maintains network connectivity,
waking up only as necessary.

The printer can be woken from sleep mode any of the following ways:
e By pressing the power button

e By openinga cover

e Bysendingaprint job

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep mode, the
power button blinks.

To change the time that elapses before sleep mode, see Change system options on page 13.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Utility and Web
JetAdmin continue to be available during sleep mode. Some remote management tasks offer the option of
remotely waking up the printer if needed to perform the task.

Change the language of the front-panel display

If you can understand the current front-panel display language, tap

, then System > Language.
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The language selection menu should now appear on the front-panel display. Tap your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish,
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Change system options

You can change various printer system options from the front panel. Tap , then System.

e Language.
e  Display brightness to change the brightness of the front-panel display.

e Date and time options to view or set the printer's date and time.

e Unit selection to change the units of measurement in the front-panel display. Select English or Metric. By

default, units are set to Metric.

e  Speaker volume to change the volume of the printer's loudspeaker. Select Off, Low, or High.

e  Power options > Printer sleep to change the length of time the printer waits before going into sleep mode
(see Sleep mode on page 12). You can set the time from 5 to 60 minutes. The default time is <15 minutes

(total time including 5 minutes in dim mode).

e  Power options > Auto-off due to inactivity to turn off the printer automatically after 120 minutes of
inactivity.

e  Restore factory settings to restore the printer settings to their original values as set in the factory. This

option restores all of the printer settings except the administrator password and the paper presets.

e  Firmware update to configure the automatic firmware update..

HP Utility

ENWW

The HP Utility is a Windows only tool that enables you to manage your printer from a computer with a TCP/IP

connection.

You can install the HP Utility from http://www.hp.com/go/Desian)etT2600/drivers.

HP Utility
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How to launch the HP Utility

14

Start the HP DesignJet Utility from the [ icon on your taskbar or from the Start menu > HP > HP DesignJet
Utility. This launches the HP DesignJet Utility, showing the printers installed on your computer. When you
open the HP DesignJet Utility for the first time, it may offer you an automatic update with enhanced
functionality that we recommend you to accept.

When you select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

@ HP DesignJet Utility

Devices (o} Overview Supplies Support Admin Color Center O ?

€

@ HP Designlet
T47084r(15.83.3.157)

Printer details Supplies Alerts

HP DesignJet T2600dr 36-in Estimated ink levels (%)
HP DesignJet 79 44in PostScript MFP
(15.87.235.27) PK G MK c M Y

h, Cyan cartridge low on ink

Gray cartridge low on ink

Magenta cartridge low on ink

HP DesignJet 79 24in

(15.87 233.208) - I
| B S
HP DesignJet XL 29 20 1 23 23 25

3600 PS MFP
{15.23.19.66) Estimate only, actual ink levels may vary. 1

, Malte black cartridge very low on ink

HP DesignJet XL Product number.  3EK15A Faeri
per in use

00 LS ME Serial number.  GNOZROH043
(15.87.235.100) i Status: Roll 1 ready

FW version CYCLOPSNEPTU
HP DesignJet T125 NE_01_19_13.1 Paper type Photo Gloss Paper
24-in Printer . s
(15.83.362) Connection IP (15.87.239.21) Width 14 mm

HP DesignJet
T1708dr
(15.83.10.180)

HP DesignJet
@ T2600dr PostScript
MFP(15.87 239 21)

HP Print Preview

The HP Print Preview application enables you to see a basic preliminary preview of how your job will be printed.
This application is available only under Windows. You can install the HP Print Preview by downloading the
integrated installer from http://www.hp.com/go/DesignJetT2600/drivers.

If you use a V4 PDF driver, you can change the rotation, scaling, color mode and the paper source settings in the
application before you print.

Chapter 1

Introduction ENWW


http://www.hp.com/go/DesignJetT2600/drivers

@ HP Print Preview

g i Cutteg madc GF1_An 23121 42 inpaf

PORTRAIT

Ab - AT

LOCALPORT

STANDARD

yaa T T

Embedded Web Server

The following browsers are known to be compatible with the Embedded Web Server:
e  Microsoft Internet Explorer 11 and later for Windows 7 and later

e  Apple Safari 8 and later for 0S X 10.10 and later

e  Mozilla Firefox (latest version)

e  Google Chrome (latest version)

To use the Embedded Web Server on any computer, open your Web browser and enter the printer's IP address in
the browser's address bar. You can find your printer's IP address in the printer’s front panel: tap and then
Network. See Configure your printer on page 16.

fi? NOTE: Your browser may display a security warning when you enter the IP address. If you have entered the

correct address, it is safe to ignore the warning and continue to access the Embedded Web Server.

The Embedded Web Server window displays a menu used to access all the supported functionality. It supports
the following languages: English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish, Russian,
Simplified Chinese, Traditional Chinese, Korean, and Japanese. It uses the language that you specified in your
Web browser options. If you specify a language that it cannot support, it is displayed in the language selected in
the printer, or else in English.

To change the language, change your Web browser's language setting. To complete the change, close and
reopen your Web browser.

Demo prints

ENWW

The demo prints give various kinds of information about your printer. They can be requested from the front
panel.

Before requesting a demo print, check that the printer and the paper are ready for printing.

Embedded Web Server
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To print a demo print, tap

The loaded paper should be at least A3 landscape—419 mm (16.53 in) wide—otherwise the print may be
clipped.

The front panel should be displaying the Ready message.

, then scroll down and tap Internal prints, then Demo prints, and select a print. The

following prints are available:

° Cad Color

° GIS

° Render

e  Architectural Presentation Panel
Configure your printer

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in the
same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front panel:

tap .

X TIP: Consider making a note of the printer’s IP address, because you may need it during the setup process of
connecting your Windows or Mac 0OS computer clients.

Gigabit Ethernet X

Connected

SUMMARY

GENERAL INFORMATION

Modify network configuration

To modify the current network configuration, go to the front panel and tap , then o then Network > Gigabit

Ethernet. From here it is possible, though not normally necessary, to change the settings manually; this can also
be done remotely using the Embedded Web Server.

For full details of the available connectivity settings, see Networking on page 55.
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If you accidentally misconfigure the printer’s network settings, you can restore the network settings to their
factory values from the front panel: tap , then o then Restore factory settings. Then you must restart the

printer. This automatically provides a working network configuration for most networks. The printer’s other
settings remain unchanged.

Install your printer under Windows

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 64 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your network
on page 16).

Now you can proceed to install the printer software and connect to your printer.

Printer software installation

1. Make a note of the printer’s host name and IP address from the front panel (see Connect the printer to your
network on page 16).

2. Install the printer software from http://www.hp.com/go/DesignJetT2600/drivers, following the software
installation instructions. By default, the following driver is installed:

e  Non-PostScript printers: The raster driver
° PostScript printers, with Windows 7 or Windows Server 2008R2: The PostScript driver
e  PostScript printers, with Windows 8, Windows Server 2012, or later: The PDF driver

3. Once downloaded, open it, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps
you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order
to find the printer. You also have the options of searching for the printer by its hostname, IP address or MAC
address.

Uninstall the printer software under Windows

Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Connect a computer to the printer by network (Mac 0S X)

HP Click is the recommended way to connect with your printer to a network. See http://www.hp.com/go/
clickDesignJet for installation instructions.
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Set up printer services

You can set up the following services:

e  Receive automatic firmware updates
e  Enable email printing

e  Enable additional printer services

A network connection is required, so the printer will test its own connectivity. Remember to connect the network
cable to the printer.

Each printer service can be enabled or disabled individually as explained below.
During initial printer setup, you are asked whether you want to enable these services. That decision can be

changed later by tapping , then o then Services > Data Collection & HP Privacy Statement.

If you are part of the HP Partner Link Pay-per-use service, tap , then ﬁ then <.+, then Register new service
in order to register the printer service.

Verify printer connection to HP

You can check that the printer is able to connect to HP services by tapping and viewing the status there. You
can see detailed information by clicking the Network or Service card.

GENERAL INFORMATION

If there is any problem connecting to HP, you will be provided with a description of the problem and some
possible solutions.

Enable email printing with HP ePrint

18

The HP Connected service makes it easy to send jobs to your printer by attaching them to an email message.

You must accept the Data Collection & HP Privacy Statement in order to use HP Connected.

To enable email printing, in the front panel, tap , then Qat the right top corner of the page, then Services. >
HP Connected > Setup Web Services. A printer email address and printer code are assigned to the printer.
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To see your printer email address, tap > Oin the right top corner of the page, then Services. > HP
Connected > Printer email address.

Alternatively, you can configure it from the Embedded Web Server, Go to the HP Web Services menu and click
Enable HP web Services to register and enable HP ePrint.

N
e

If you are the printer administrator, log in at HP Connected (http://www.hpconnected.com) to customize your
printer’'s email address or manage printer security for remote printing. Refresh the printer’'s email address from

the front panel, tap > Oin the right top corner of the page, then Services. > HP Connected > Printer email
address.

Visit http://www.hpconnected.com to register yourself and your printer (using the printer code).

HP ePrint job policies

By default, the jobs sent by email are directly printed. To change the settings, tap , then o at the right top
corner of the page, then Services > HP Connected > HP ePrint jobs.

You can select the roll to be used for HP ePrint jobs, or let the printer decide (save paper).

Configure ePrint connectivity service

You can remove the connection to HP ePrint if required for security. At the front panel, tap , then o at the
right top corner of the page, then Services > HP Connected > Remove Web Services.

To use remote printing again, you will need to set it up again from scratch.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download firmware
updates.

[%Hf NOTE: If an administrator password has been set, it will be required to change these settings.

e Inthe Embedded Web Server: Click About printer > Firmware update.

e  Using the front panel: Tap then System > Firmware update.
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The following settings are available:
e  (heck for updates automatically: The printer will inform you when new firmware is available.

e  Download new firmware automatically: The printer will automatically download new firmware whenever it
becomes available. Deactivate this option to download new firmware manually.

[%r NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install the
new firmware, you must confirm the installation manually.

e  Firmware update history.

LDAP Configure the email address book

The printer uses Lightweight Directory Access Protocol (LDAP), which provides access to a network address book
for scan-to-email and authentication purposes.

The following instructions explain how to use LDAP to connect the printer to a network email address book, and
to authenticate users of the printer using their LDAP credentials.

Email lookup

When the printer uses LDAP for scan-to-email, it searches a database of email addresses. When you enter the
email address and click the Search button, LDAP searches a list of email addresses for matching characters. You
can refine the search results by typing additional characters and performing a new search.

Printers that support LDAP also support the use of a standard outgoing email profile, so they do not require a
connection to an LDAP server in order to send email.

Information needed before starting
Ensure that you have the following information before starting the configuration:
e  Server address (hostname or IP).
e  Server authentication requirements.
e  Pathto start search (BaseDN, Search Root) (for example, o=mycompany . com).

e  Attributes for matching the name entered (such as cnor samAccountName), retrieving the email
address (such as mai 1), and how the name will be displayed on the control panel (such as
displayName).

Address book setup

In the Embedded Web Server, click Settings >Address book. Here you can configure the printer to obtain email
addresses from an LDAP server, so that they are available when users perform a search from the Scan to Email
screen.

1. Open the Embedded Web Server.
2.  Click Settings >Address book.
3. Enable the LDAP server (mandatory to continue with the LDAP configuration).

Network Directory Server section:
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4.  Inthe Network Directory Server section, enter the name of the LDAP server address (for example,
ldap.mycompany.com) and Port.

Server Authentication requirements section:

5. Inthe Server authentication requirements section you can select the appropriate authentication type in the
server (Windows credentials, simple credential, use printer user’s credentials). It is mandatory to fill the
Domain name, Username, and password.

LDAP Database search settings section:
6.  Fillin these fields:

e Inthe path to start a search (BaseDN, Search Root) box, enter the path to start searching the
database (for example, o=mycompany . com).

e Inthe recipients's display name box, enter the name of the attribute that contains the person's name
(for example, displayName).

e Inthe recipient's email address box, enter the name of the attribute that contains the person's email
address (for example, mail or rfc822Mailbox).

e  Use the LDAP filter condition box to set up an optional filter to filter out e-mail addresses.
7.  Click the Apply button to save the settings. Setup is complete.
8.  To check that the LDAP retrieval is set up correctly, enter at least three characters of a network contact
name in the Test box, and then click the Test button. If the test is successful a message is displayed.
Configure a network folder

In the printer's Embedded Web Server, click the Settings tab and Network folder. See Embedded Web Server
on page 33.

ENWW Configure your printer
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On the Network folders page, click oat the top of the page, and fill in the various fields:

e  Display name: Name displayed in the front panel when you are choosing the file’s scan destination/printing
origin (depending of the functionality use).

e  Network path: Should contain the network name of the remote computer and must start with // followed
by the path.

e  Protocol: SMB

e  Functionality Use: Choose between Print only, Scan only, Print and Scan or None.

e  Default Network destination: Enable this option to configure this folder as the default destination for files.
e  Browse Network folder Structure: Enable to browse through the structure of folders.

e  Authentication requirements: Enter the login username and password for the printer to access documents
and images in the network folder. The username and password are stored and encrypted in the printer's
memory. There are 3 options:

—  None: Use this setting for an unprotected folder on the network (no credentials required).

—  Automatic login using following credentials: Enter username and password only once during
configuration and later use the folder in the front panel without entering credentials.

—  Prompt for credentials when needed: Enter username and password in the front panel every time you
use it.
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[%9 NOTE: User password should contain the password of the user. Domain should contain the name of the
domain in which the user name exists. If the user does not belong to any domain, leave this field empty.

e  Security Pin Option: Create a 4-digit security PIN to prevent unauthorized people from accessing
documents and images in this network folder.

For a network folder, enter the remote computer’s name or IP address, the shared folder’s, and the username
and password of the user already created on the remote computer. Leave the user domain field empty unless
the user is a member of a Windows domain. If the user is only a local user of the remote computer, leave the
field empty. You can use the name (instead of the IP address) in the server name field, only if the shared folder is
on a Windows computer in the same local network.

e  (lick Apply to save the configuration.

e  The printer automatically checks that it can access the network folder. If not, see Cannot access the
network folder on page 116.

[%”f NOTE: If the product has already been configured for scanning to network/printing from networks and you now
want to use a different shared folder, click #".

You can check that the shared folder remains accessible by clicking Verify in the Embedded Web Server at any
time. A correctly configured shared folder can become inaccessible if the user’s password is changed, or if the
shared folder is moved or deleted.

Example: Create a network folder under Windows
1. Create a new user account on the remote computer. You can use an existing user
account for this purpose, but it is not recommended.
2. Create anew folder on the remote computer, unless you want to use an existing folder.

3. Right-click the folder and click Properties.
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In the Sharing tab, click the Advanced Sharing button.

@
General Sharing Security Previous Versions Customize

Network File and Folder Sharing

. obso
As Shared

Metwork Path:

- D . . g — - - - - - ———— -
Share...

Advanced Sharing

Set custom permissions. create multiple shares, and set other
advanced sharing options.

| @Advanced Sharing...

Close || Cancel Apply

Advanced Sharing X

[ share this folder
Settings
Share name:
[R8D

Limit the number of simultaneous users to:

Comments:

OK Cancel | | Appiy
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Ensure that the user has the correct permission settings depending of the functionality use of the network
folder. If you configured a scan-to-folder, you need to ensure full read/write control over the shared folder
so that the user(s) can add files to folder. To do this, click Permissions and grant Full Control to the user (or
to any suitable group that includes that user). If the user(s) is going to use the folder to print documents, a

read-only permission is enough.

| Share Pemmissions

Group or user names:
;“Everyme

Permissions for Everyone

Allow

Full Control

Change
Read

{aad

noo|g g

OK

Apply

Configure your printer
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6.  For scanner users, If there is a Security tab in the Properties window for your folder, then you must also
grant the same user Full Control over the folder in the Security tab. Only some file systems such as NTFS
require this.

L
General Sharing Security Previous Versions Customize
Objectname: C\Users\gomemar\OneDrive - HP Inc\Learning Produ

Group or user names:
&2 Everyone
| | B&SYSTEM
e
82

To change permissions, click Edit Edit..

Allow Deny

Full control

Madify

Read & execute
List folder contents
Read

Write v

For special permissions or advanced settings. Advanced
click Advanced. -

Close Cancel Apply

Example: Create a scan-to-network folder under Mac OS

1. Create a new user account for the Scanner user on the remote computer. You can use an existing user
account for this purpose, but it is not recommended.

2. Create or choose a folder on the remote computer. By default, Mac OS users have a Public folder that can
easily be used for this purpose.
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3. Open the System Preferences application and click the Sharing icon.

@ < 1 Sharing Q Searct

Computer Name:

Computers on your local network can access your computer at: Edit
| on service ® File Sharing: On
| DVD or CD Sharing Other users can access shared folders on this computer, and administrators

| Screen Sharing all volumes, at smb://wintests-mbp.bcn.rd.hpicorp.net.

«  File Sharing Options..
| Printer Sharing
" Shared Folders: Users:
Remote Login
| Remote Management | & | wintest's Public Folder ,l Read & Write 2
| Remote Apple Events n ReadOnly ¢
113 No Access ¢

Internet Sharing
‘ Bluetooth Sharing

4.  Depending of the functionality of the folder, make sure the user has the right permissions. For scanning
purposes, Read & Write is needed to access the folder.

5. Click Options.
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6.

7.

8.

Chapter 1

Check the Share files and folder using the SMB box, and make sure that the scanner user is checked in the

On column.
Sharing
b4 Share files and folders using SMB
Computer Nal e 9
Number of users connected: 0
. Edit...
Share files and folders using AFP
i File Sharing: Off
on |sarvica: B Windows File Sharing:

— Sharing files with some Windows computers requires storing d inistrat
DVD or CD the user's account password on this computer in a less secure Qe Bovs it
Screen Sha manner. When you enable Windows sharing for a user account,

ou must enter the password for that account. i
File Sharing you P = Options...
Printer Sha On  Account | -
Remote Log
Remote Ma Read & Write £
Remote Ap| Read Only ¢
~
Internet Sh No Access &
| Bluetooth §
? [ Done |

I

T 1=1 EdE r
?

Click Done. You can now see file sharing enabled and Windows sharing on.

) Sereen Sharing all volumes, at smb:/J i e

File Sharing

® 0 < 5 Sharing Q Search
Computer Name: wintest’s MacBook Pro
Computers on your local network can access your computer at: Edit
— ——— -
On  Service @ File Sharing: On
i DVD or CD Sharing Other users can access shared folders on this computer, and administrators

Options...
Printer Sharin: R
£ » Shared Folders:
Remote Login - )
Remote Management & wintest's Public Folder v Read & Write
Remote Apple Events anr Ra?d Only
Internet Sharing Write Only (Drop Box)
Bluetooth Sharing
+ —

You must configure the printer to send scans to the folder.
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Configure the email server

To configure the email server using the Embedded Web Server, click Setup > E-mail server, and fill in the
following fields, which are usually supplied by the email server provider.

e  SMTP server and port number: The IP address or fully qualified domain name of the outgoing mail server
(SMTP) that will process all email messages from the printer. If the mail server requires authentication,
email notifications will not work.

e  Printer e-mail address: The email address assigned to the account that is being configured in the printer.
This email address will appear in the From: field of all the email messages sent by the printer. This is not
the same email address that is used by HP Connected.

e  Attachment size limit: The maximum size of a file attached to an email message. When you scan to email
from the front panel, you will be warned if an attachment is higher than this limit, but you can ignore the
warning and send the message anyway.

e  UseSSL certificates: Check this box to use SSL certificates if the server requires an encrypted connection.
Click the link to configure advanced certificate settings.

e  Authentication. If you choose authentication, you are also asked for your username and password.

Once you have configured the email server, you are strongly recommended to check the configuration.

Control access to the printer

Manage printer security with HP Connected

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your
printer's email address can print to your printer just by sending a file to it. Although HP provides a spam filtering
service, you should be careful about giving out your printer's email address, as everything sent to that address
may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status to lock mode
by visiting HP Connected at http://www.hpconnected.com. You can also customize your printer's email address
and manage print jobs from there. At your first visit, you will need to create an account at HP Connected using
the printer's code.

Embedded Web Server security settings

ENWW

From the Embedded Web Server menu, you can click Security and then Administrator password to control access
to the printer by specifying an administrator account to control access to the Embedded Web Server and the
printer’s front panel.

The administrator can also define other types of permissions in the control panel through the Access control
menu option. In this section, the administrator can create new printer user accounts and assign them specific
permissions depending on their role.

Other security settings are available under the Security settings menu option, which apply to all users.

Configure your printer
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Front-panel security settings

From the front panel, you can tap

, then Security, to control some of the features of the printer:

e  Usersessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.
e  Embedded Web Server: Enable or disable the Embedded Web Server.

e  Printing & management Web services: Enable or disable Web services that are used by printing and
management tools such as the HP Utility, HP Click, and SDK for RIPs.

If an administrator password has been set, it must be given in order to perform the following operations:
e  (hange the security settings (including the administrator password itself).

e  (Change the configuration of the Internet connection.

e  (Change the Automatic Firmware Update configuration.

e  Enable or disable automatic downloading and/or installation of automatic firmware updates.

e  Restore an earlier firmware version.

e  Reset factory defaults.

[%,/r NOTE: The administrator password can contain only characters that appear on the front panel's on-screen

keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not appear
in that limited character set.

Require account ID

Drivers

If you want to keep records of printer usage by different users, you can set your printer to require an account ID
for each job. At the front panel, tap , then Job management > Account ID required.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on
hold for accounting"”.

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting” by
the printer, you can introduce the account ID in the driver or front panel, by going to the job queue and clicking
the job that is on hold. A window with a text box is displayed and you can enter the account ID into it.

There are various different drivers for your printer; which is best for you depends on your circumstances:
e  Your operating system

e  The type of applications from which you print

e  The number of printers you have

° The output accessories you have

You may wish to install one or several drivers according to your needs.

You can find the latest driver software at http://www.hp.com/go/DesignJetT2600/drivers/.
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Specific Windows drivers
The following driver is recommended:
e  Non-PostScript printers: The raster driver
e  PostScript printers, with Windows 7 or Windows Server 2008R2: The PostScript driver

° PostScript printers, with Windows 8, Windows Server 2012, or later: The PDF driver

HP Universal Print Driver configuration tool

To install the HP Designjet Universal Print Driver, go to http://www.hp.com/go/DesianJetT2600/support and click
Software and drivers > Driver - Universal Print Driver > Download. We recommend to select the HP DesignJet
UPD PostScript Driver if you have a PostScript Printer.

At the end of installation, go to Printer > Device Settings > Properties, and confirm that Generic is displayed in
Current model.

i HP Designlet Universal Print Driver P53 Properties b3
Goneral Shading Ports Advanced Color Management
Socurity Deviens Settings Aot

# Advanced Features
Font Substitution Table
Output Protocct ASCI
Send CTRL-D Before Each Job: No
Send CTRL-D After Each Job: Yes
Convert Gray Text to PostSeript Gray: No
Convert Gray Graphics to PostScript Gray: No
Add Eure Cumency Symbaol to PostScript Fonts: Mo
lob Timeout (seconds): 0
Wait Timeeut (seconds): 300
Minimum Font Size to Download as Outline (pixels): 100
Maximum Font Size to Download a5 Bitmap (pixelsk 500
Show Printer Information: Yes

Cument Model: JEcee v

o] |

To install the tool, go to http://www.hp.com/go/DesignJetT2600/support and click Software and drivers >
Software — Utility > UPD configuration tool > Download.

For information about how to install and use the tool, go to https://support.hp.com/us-en/document/
c05658213.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to
set color or paper-saving options. To do this, click the Start or Search button on your computer's screen, then
click Devices and Settings or Devices and Printers. In the next window, right-click your printer's icon, and click
Printing Preferences. Any settings you change in the Printing Preferences window will be saved as default values
for the current user.

To set the default values for all users of your system, right-click the printer’s icon, click Printer Properties, go to
the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will be saved for
all users.
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Change the graphic language setting

You can change the graphic language setting from the front panel. Tap then Default printing configuration >
Graphics language.

Then select one of the following options:

e  Select Automatic to let the printer determine which type of file it is receiving. This is the default setting; it
works for most software applications. You should not normally need to change it.

e  Select PS (PostScript) only if you are sending a file of that type directly to the printer, without going through
a printer driver.

e  Select PDF only if you are sending a file of that type directly to the printer, without going through a printer
driver.

e  Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through a
printer driver.

e  Select CALS/G4 only if you are sending a file of that type directly to the printer, without going through a
printer driver.

e  Select TIFF only if you are sending a file of that type directly to the printer, without going through a printer
driver.

e  Select JPEG only if you are sending a file of that type directly to the printer, without going through a printer
driver.

Mobile printing

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple
steps wherever you are; using your mobile device OS or sending an email to your printer with PDF, TIFF, or JPEG
attachments.

e  For Android printing, install the HP Print Service App from Google Play. If you have have already installed it,
check that it is up to date. You can obtain the latest version from https://play.google.com/store/apps/
details?id=com.hp.android.printservice.

e  You can also download the HP Smart App to enhance your printing capabilities from a smartphone or
tablet.

—  Latest i0S version from https://itunes.apple.com/app/id469284907

—  Latest Android version from https://play.google.com/store/apps/details?id=com.hp.printercontrol

e To enable email printing, ensure that the service is enabled, and retrieve the printer's email address from
the front panel.

For more detailed information, see http://www.hp.com/go/designjetmobility.

Accessibility

Front panel

If required, the front-panel display brightness and the loudspeaker volume can be changed (see Change system
options on page 13).
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Embedded Web Server

From the Embedded Web Server, you can see the status of the printer, and perform other actions without using

the front panel.

For information about the accessibility features of the Embedded Web Server, click Support > Accessibility.

R

®© @ | MW ® e 4

&)

See http://www.hp.com/hpinfo/abouthp/accessibility/ for information about the HP Accessibility Program, and

Home Accessibility
$ee accassibilly features
Job queue
Accessibility

Ink v
Paper v Refresh rate (seconds):
Usage v List of area access keys

Area
Security ~

Header
About printer v

Menu
Network v Content
Support ~ Move through elements

Note: Keyboard shortcuts are supported under Windows and Mac OS
Online support links

Service support

Accessibility

Access key combination

ALT +

ALT +

ALT +

TAB

HP's commitment to making its products and services accessible to people with disabilities.

Other sources of information

The following documents can be downloaded from http://www.hp.com/go/DesignJetT2600/manuals/:

ENWW

Introductory information
User guide
Legal information

Limited warranty

Other sources of information
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General advice

A CAUTION: Before starting a paper loading process, ensure that you have enough room around the printer, both
in front and behind. You need at least enough space behind the printer to open the basket fully.

A CAUTION:  Ensure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

A CAUTION:  All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape
orientation.

> TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

1

Load a roll onto the spindle

1. Opentheroll cover.
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2. Remove the black end of the spindle from the printer, then the blue end.

A CAUTION: Be sure to remove the black end first. Removing the blue end first could damage the black end.

AWARNING! Do not insert your fingers into the spindle supports during the removal process.
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3. Thespindle has a stop at each end. The blue stop can move along the spindle and has a latch to lock it in
place. Open the latch and remove the blue stop from the end of the spindle.

4. Ifthereis already a roll or core on the spindle, remove it.

5. Iftherollis long, rest it horizontally on a table and insert the spindle into it.

¥ TIP: You may need two people to handle a large roll.

6.  Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the
roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the
correct orientation.

@ NOTE: From the front of the printer, the blue stop should be inserted into the right-side holder.

e
S

ENWW Load a roll onto the spindle 37



7.  Put the blue stop onto the open end of the spindle, and push it towards the end of the roll.

8.  Ensure that the blue stop is pushed in as far as it goes; until both ends are against the stops, then close the
latch.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of
different paper types on different spindles. Extra spindles are available for purchase, see Supplies and
accessories on page 175.

Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle on page 35.

*} TIP: Do not try to open both roll covers at once; this may cause problems. Always close one cover before
opening the other.

@” NOTE: The first two steps below are optional: you can start with step 3. However, in this case the printer will
not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So you are
recommended to follow all the steps, starting with step 1, unless you have turned off the Printing paper info
option. See Printing paper info on page 49.
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1. From the front panel, press , then the rollicon, then Load.

If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.

2. Ifyou start to load roll T while roll 2 is already loaded, roll 2 is withdrawn to the standby position, so that it
can be printed on again without reloading whenever required (and vice versa).

’L%y NOTE: If at any time you open a roll cover while that roll is loaded but not printing, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print onit.

3. Open theroll cover.

4.  Load the spindle into the printer, with the blue stop on the right. Hold the spindle by its ends and not in the
middle, to avoid touching the paper and perhaps leaving marks on it.

(A48
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5.  If the edge of the rollis not straight or torn (sometimes due to tape used to hold end of the roll), pull the
paper slightly and cut a straight edge.

6. Insert the edge of the paper into the printer.

A WARNING! Do not push your fingers inside the printer's paper path.
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7. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it feeds it in automatically. You will hear a beep.

8. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode, which falls
into the basket.

9. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper category
and type.

X TIP: f you have loaded a paper type whose name does not appear in the paper list, see Paper type is not
in the driver on page 183.

10. The front panel may ask you to specify the length of the roll. See Printing paper info on page 49. Press
OK.

11. Close the roll cover only when the front panel prompts you to do so.

I% NOTE: If you have an unexpected issue at any stage of the paper loading process, see Paper cannot be loaded
successfully on page 182.

Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the
appropriate procedure as described below.

Quick procedure with paper on the roll

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically. The front panel
prompts you to load a new roll or sheet.
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[%’ NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the length
of the roll when it is next loaded. See Printing paper info on page 49.

[%’ NOTE: If you open the a roll cover while a sheet is loaded, the sheet is also unloaded.

Front panel procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.
1. Press @ then the roll icon, then Unload.

2. Youmay need to open the roll cover.

Load a single sheet

1. Measure sheet length before loading (if it is not standard size).
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2. Ensure that both roll covers are closed. If a roll cover is opened while a sheet is loaded, the sheet is
immediately unloaded.

AWARNING! Do not load the sheet before starting the loading process from the front panel.

3. Atthe front panel, press @ then the sheet icon, then Load > Load sheet.

4. If arollis already loaded, you have to wait while it is automatically unloaded. The roll is not unloaded, but
withdrawn to the standby position, so that it can be printed on again without reloading as soon as the
sheet paper has been unloaded.

[f_%f NOTE: If at any time you open a roll cover while that roll is loaded but not printing, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print on it.

5. Select your paper category and type.

X TP f you have loaded a paper type whose name does not appear in the paper list, see Paper type is not
in the driver on page 183.

6.  When prompted by the front panel, insert the sheet into the front of the printer.
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7. Align the left-hand edge of the sheet with the blue line on the left-hand side of the printer.

/ -
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8.  Push the sheet into the printer until it will not go any further.

7

!
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\
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AWARNING! Do not push your fingers inside the printer's paper path.

9.  Guide the sheet into the printer until the printer beeps and starts pulling the paper.
10. The printer checks the alignment.

11. If the sheet is not correctly aligned, it is ejected, and you will have to try again.

[% NOTE: If you have an unexpected problem at any stage of the paper loading process, see Paper cannot be
loaded successfully on page 182.
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The stacker

1. Basket
2.  Stacker pivoting cover
3. Stacker

By default, the printer cuts the paper after every print job. The resulting printed sheet of paper is neatly stacked
on top of the other printed sheets by the stacker.

To empty the stacker, stand in front of the printer and pull the stack of printed sheets out of the stacker. The
stacker cover may open during this process; make sure that it is closed after you have removed the sheets.
Normally the return spring will close it automatically.
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¥ TIP: Although you can remove sheets from the stacker while the printer is printing, you are recommended to
remove all the prints together while the printer is not printing.

TIP:  You can lock the stacker cover in the open position to collect special jobs. Make sure that you close it
afterwards.

TIP:  If you want to use a photo paper for printing in normal printing mode to the stacker, you are
recommended to use an HP Instant-Dry Photo Paper.

TIP:  For stacking papers below 75 gr/m2 activate the blue separators located in the laterals of the stacker
cover. Make sure you deactivate them when using the rest of papers.

Manual printing with the stacker open

The stacker's manual printing mode is designed to be used when you want the highest-quality print possible on
photo paper, and you are willing to stand in front of the printer to ensure it.

You can choose attended mode either for a particular job (for example, from the printer driver), or by putting the
printer into attended mode from the front panel.

e Ifyousend ajob with attended mode selected, the job is put on hold, and other jobs can continue printing,
until you select it for printing from the front panel (the front panel can guide you through this process) and
open the stacker cover.

& | Print & Copyjobs o -

B -
1 | < nowprinTiNG POF Job
D

Naprinting jobs & Onholdfor attended mode.

Selected paper type needs tobeprinted n attended mode.
I O UPNEXT o~
Noupcoming jobs n n
A4 ONHOLD ~
2
PDF Job
© HISTORY @ ~

© PDFJob
Convidat

©  POFJob
Comddat

© POFlob

© POFJob

e Ifyou put the printer into manual mode from the front panel, all jobs in the queue are put on hold for
manual mode, and you can print them from the queue. When you exit manual mode, any jobs still in the
gueue return to their previous status.

[%’ NOTE: When opening the stacker to enter manual mode, lock the stacker cover into the open position.
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In manual mode:
e  Youcan print only one page at a time. You must start each page manually from the front panel.
e  You print with the stacker cover open, and stand in front of the printer to check the print as it emerges.

e  With the stacker cover open, you have a better view of the print as it emerges, but the stacker cannot
guarantee that the print will follow the correct paper path, so you must watch over it to prevent possible
damage.

e  You cannot scan or copy because the stacker cover is blocking the scanner.

e |[fthe printeris left idle and in manual mode for more than 15 minutes, manual mode is cancelled, and you
are advised to close the stacker.

e  You can exit manual mode from the front panel or by closing the stacker.

Manual mode is indicated in various front-panel screens by the o icon.

Top stacker

Ready

Attended mode

To enter manual mode, on the front panel tap @ then output options > top stacker > attended mode.

The basket

The stacker is normally used to collect prints. If you decide not to use the stacker, you can send your prints to the
basket. You may decide to use the basket if the stacker is full, or if you want to separate ajob from the other
jobs printed to the stacker.

The basket can accept up to 10 A1 or D-sized sheets of bond paper. Larger prints should be removed from the
basket immediately after printing.

% TIP: Ensure that you have routed all cables correctly, so that they do not interfere with paper falling into the
basket. Otherwise you may experience paper jams.
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View information about the paper
To view the loaded paper information, press , then the roll icon.

The following information is displayed on the front panel:
e  The paper type you have selected

e  Roll or sheet status

e Width of the paper in millimeters (estimated)

e  Length of the paper in millimeters (estimated)

e  (alibration status

The same information is displayed in the HP DesignJet Utility for Windows (Overview tab > Supplies tab) and the
HP Utility for Mac 0S X (Information group > Supplies Status).

Paper presets

Each supported paper type has its own characteristics. For optimum print quality, the printer changes the way it
prints on each different paper type. For example, some may need more ink and some may require a longer
drying time. So the printer must be given a description of the requirements of each paper type. This description
is called the paper preset. The paper preset contains the ICC profile, which describes the color characteristics of
the paper; it also contains information on other characteristics and requirements of the paper that are not
directly related to color. Existing paper presets for your printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only contains paper
presets for the most commonly used paper types. If you have a paper type for which your printer has no preset,
you cannot select that paper type.

There are two ways to assign a preset for a new paper type.

e  Use one of the existing HP factory paper presets by selecting the closest category and type in the front
panel or the printer driver. See Paper type is not in the driver on page 183.

[% NOTE: Colors may not be accurate. This method is not recommended for high-quality prints.

e  Download the correct paper preset from http://hp.globalbmag.com/paperpresets.

[:?’”f NOTE: HP provides presets for HP paper types only. If you do not find the paper preset you want on the
Web, you may find that it has been added to the latest firmware for your printer. You can check the
firmware release notes for information, see Update the firmware on page 168.

To install a downloaded paper preset

1. After finding the right paper preset at http://www.globalbma.com/hp/paperpresets, or the paper
manufacturer's website, click the Download Now button and save the paper preset (an .oms file) on your
computer.
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[%9 NOTE: If you do not find the paper preset you want on the Web, you may find that it has been added to
the latest firmware for your printer. You can check the firmware release notes for information, see Update
the firmware on page 168.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is stopped.
Installing a new paper preset will interrupt any printing that is in progress.

3. Start the HP DesignJet Utility or the Embedded Web Server.
e Inthe HP DesignJet Utility for Windows, select the Color Center and then Import Paper Preset.

e Inthe Embedded Web Server, click the Paper tab. In the Paper Management section, click the Import
Paper Preset tab.

4.  Onthe Import page, select the paper preset file that you downloaded in step 1.
5. Click the Import button and wait for the update process to finish. It may take some time.

6. Check that the new paper type appears in the Additional paper or Custom paper category in your printer's
front panel.

Now that you have imported the paper preset, you can select the paper type from the front panel and from the
driver. The ICC profile for the new paper type is ready to use by your application.

Printing paper info

Enable the Printing paper info option to record the printer's estimate of the remaining roll length, paper width
and type. The information is a combination of barcode and text that is printed on the leading edge of the roll
when the paper is unloaded from the printer.

I (YT LR AT T

138 feet (42.1 m.) of 42 inch (1067 mm.) Photo Gloss Papet

Ej?)y NOTE: The paper-length estimate is available only if the printer registered the amount of paper that was on
the roll when you loaded it. To provide this information to the printer, specify the roll length on the front panel
when loading the paper, or load a roll that has the paper-data barcode printed on it.

[Z;’/f’ NOTE: The barcode and text are printed on the roll only when the loading and unloading processes are started
from the front panel's Paper menu.

ERk)

[ NOTE:  This option can be expected to work only with papers that are completely opaque. It may fail with
transparent or translucent papers.

To enable the Printing paper info option, go to the front panel and press :
info > Enable.

, then Paper source > Printing paper

Ej?)y NOTE: Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You
may want to do this in order to have more or less white space between the last print and the next one when the
cutter is disabled; or to increase top margin of the next print.
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To move the paper, press then Paper source > Move paper.

Maintain paper
To maintain paper quality, follow the recommendations below.
e  Storerolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e  C(leaninput and output platens

e  Keep the scanner lowered unless you need to lift it for some reason

[1_%?9 NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 198.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where
time is of higher importance or when you need to be sure ink is dry before handling.

Extended, to set a longer than recommended time to ensure ink is completely dry

Press

, then Default printing configuration > Print retrieval > Drying time. You can select:

e  Optimal, to set the default and recommended time for your selected paper (this is the default setting)
e  Reduced, to set a shorter than recommended time when quality is of lower importance

e None, to disable the drying time and remove your print as soon as it finishes printing

A CAUTION:  If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the
print.

[% NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to
the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then
performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the
paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off:

° From the front panel, press

, then Default printing configuration > Cutter > Horizontal cutter.

The default setting is On.

If the cutter is turned off, it does not cut the paper between jobs, but continues to cut the paper on loading,
unloading, switching between rolls, and switching between the stacker and the basket.

*} TIP:  To cut roll paper while the automatic cutter is disabled, see Clean cut on page 51.
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Clean cut

If you go to the front panel and tap , then tap the cutter icon at the top of the page, the printer advances the

paper and makes a straight cut across the front edge. There are several possible reasons why you might want to
do this.

e Totrim the leading edge of the paper if it is damaged or not straight. The cut strip falls into the basket.
e Tofeed and cut the paper when the automatic cutter has been disabled.

e To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more
pages.

Ej?f)y NOTE: The printhead is serviced after each print, and the paper cannot be cut until the process completes, so
you may notice a delay.

E#"f NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 198.

s} TIP:  To move the paper without cutting it, see Move the paper on page 49.
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3 Working with two rolls (T2600dr only)

° Advantages of a multiroll printer

° How the printer allocates jobs to paper rolls
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Advantages of a multiroll printer

A multiroll printer can be useful in several different ways:
e  The printer can automatically switch between different paper types according to your needs.

e  The printer can automatically switch between different paper widths according to your needs. This enables
you to save paper by printing smaller images on narrower paper.

e Ifyouload two identical rolls into the printer, you can leave it printing unattended for a long time, because
it can switch from one roll to the other automatically when the first is exhausted. See Unattended printing/
overnight printing on page 77.

The current status of both rolls is shown on the front panel if you tap .

[Z?’”r NOTE: Bear in mind that a paper type is protected from use unless that paper type is specifically requested.
See Protect a paper type on page 77.

[%“f NOTE: If you use a paper not supported by your printer, you may find that automatic switching is disabled, in
which case jobs sent to the standby roll are put on hold until the roll is manually unloaded.

99

[ NOTE:  When you print from a USB flash drive, multiroll printing is considerably simplified: either you specify
manually which roll you want to use, or you can select Save paper, in which case the printer chooses the
narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls

When you submit a print job from the printer driver, you can specify (using the Paper type or Type is option) that
you want it to be printed on a particular paper type; you can even specify (using the Paper source, Source is or
Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The printer will try to satisfy these
requirements, and it will also look for a paper roll large enough to print the image without clipping.

e Ifbothrolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll
policies on page 87.

e Ifjust one of the rolls is suitable for the job, it will be printed on that roll.

e If neither rollis suitable for the job, it will be put on hold for paper, or printed on an unsuitable roll,
depending on the paper mismatch action. See Solve paper mismatch on page 88.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer, and
on which rolls.

Here are some settings that may be used in typical situations.

[Z?’”r NOTE: The Paper settings are in the printer driver; the Roll switching policy is set in the front panel.

e  Withdifferent paper types loaded:
—  Paper types: select the paper type you require
—  Paper source: Use printer settings
—  Roll switching policy: doesn't matter

e  With different paper widths loaded:
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- Paper type: Use printer settings
—  Paper source: Use printer settings

—  Roll switching policy: Minimize paper waste

% TIP: You canalso save paper in some cases by rotating or nesting your images. See Use paper
economically on page 74.

e Withidentical rolls loaded:
—  Paper type: Use printer settings
—  Paper source: Use printer settings

—  Roll switching policy: Minimize roll changes
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Networking

° Introduction

° Control network protocols

° Front-panel menu items

e Link configuration methods

e  Troubleshooting
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Introduction

The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B limits, the
use of shielded I/0 cables is required.

The embedded Jetdirect print server supports connection to I[EEE 802.3 10Base-T Ethernet, IEEE 802.3u
100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected and
powered on, the printer auto-negotiates with your network to operate with a link speed of 10, 100, or 1000
Mbps, and to communicate using full- or half-duplex mode. However, you can manually configure the link using
the printer's front panel, or through other configuration tools once network communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For
security, it includes features to control IP traffic to and from the printer and supports configuration of IP Security
(IPsec) protocols.

Control network protocols

The printer can simultaneously support multiple network communication protocols. This allows network
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. For some
protocols, required parameters are automatically sensed and user-specified settings are not needed. However,
for other protocols, there may be many parameters to configure.

Enable or disable network protocols

If a network protocol is enabled, the printer may actively transmit on the network even when there are no
computers on the network that use the protocol. This may increase network traffic. To eliminate unnecessary
traffic, you can disable unused protocols. Disabling unused protocols lets you:

e  Reduce network traffic by eliminating broadcast messages from unused protocols

e  Provide better control over who prints to the printer by eliminating users from other networks who might
route print jobs to this printer

e  Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front-panel menu items on page 56.
More detailed control of network protocols is available in the printer's Embedded Web Server, in the Networking
section web pages. For other tools, such as system command access to the embedded Telnet server, see the
HP Jetdirect Print Server Administrator’s Guide for your print server model.

Front-panel menu items

To access the printer network configuration settings, go to the front panel and tap , then o then Network
> Gigabit Ethernet > Modify Configuration.

Menu item Sub-menuitem  Sub-menuitem  Values and description
Information Print Sec Report Yes: Prints a report.
No (default): Does not print a report.
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Menu item Sub-menuitem  Sub-menuitem  Values and description

TCP/IP Host Name An alphanumeric string, up to 32 characters, used to identify the device. This name is listed on
the HP Jetdirect configuration page. The default host name is NPIxxxxxx, where xxxxxx is the
last six digits of the LAN hardware (MAC) address.

IPV4 Settings Config Method Specifies the method that TCP/IPv4 parameters will be configured on the HP Jetdirect print

server.
Bootp: Use BootP (Bootstrap Protocol) for automatic configuration from a BootP server.
DHCP (default): Use DHCP (Dynamic Host Configuration Protocol) for automatic configuration
from a DHCPvA4 server. If selected and a DHCP lease exists, DHCP Release and DHCP Renew
menus are available to set DHCP lease options.
Auto IP: Use automatic link-local IPv4 addressing. An address in the form 169.254.x.x is
assigned automatically.
Manual: Use the Manual Settings menu to configure TCP/IPv4 parameters.

DHCP Release This menu appears if Config Method was set to DHCP and a DHCP lease for the print server
exists.

No (default): The current DHCP lease is saved.
Yes: The current DHCP lease and the leased IP address are released.

DHCP Renew This menu appears if Config Method was set to DHCP and a DHCP lease for the print server
exists.

No (default): The print server does not request to renew the DHCP lease.
Yes: The print server requests to renew the current DHCP lease.

Manual Settings  (Available only if Config Method is set to Manual) Configure parameters directly from the

printer control panel:

IP Address: The unique IP address of the printer (n.n.n.n).

Subnet Mask: The subnet mask for the printer (n.n.n.n).

Syslog Server: The IP address of the syslog server (n.n.n.n) used to receive and log syslog
messages.

Default Gateway: The IP address (n.n.n.n) of the gateway or router used for communications
with other networks.

|dle Timeout: The time period, in seconds, after which an idle TCP print data connection is
closed (default is 270 seconds, 0 disables the timeout).

Default IP Specify the IP address to default to when the print server is unable to obtain an IP address
from the network during a forced TCP/IP reconfiguration (for example, when manually
configured to use BootP or DHCP).

Auto IP: A link-local IP address 169.254.x.x is set.
Legacy: The address 192.0.0.192 is set, consistent with older HP Jetdirect devices.

Primary DNS Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in the
Config. Precedence table, configured through the embedded Web server.

Secondary DNS  Specify the IP address (n.n.n.n) of a Secondary Domain Name System (DNS) Server.

NOTE:  This item will appear only if Manual configuration is a higher priority than DHCP in the
Config. Precedence table, configured through the embedded Web server.
ENWW Front-panel menu items
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Menu item Sub-menuitem  Sub-menuitem  Values and description

IPV6 Settings Enable Use this item to enable or disable IPv6 operation on the print server.

Off: IPv6 is disabled.
On (default): IPv6 is enabled.

Address Use this item to manually configure an IPv6 address.

Manual Settings: Use the Manual Settings menu to enable and manually configure a TCP/ IPv6
address.

Enable: Select this item and choose On to enable manual configuration, or Off to disable
manual configuration.

Address: Use this item to type a 32 hexadecimal digit IPv6 node address that uses the colon
hexadecimal syntax.

DHCPV6 Policy Router Specified: The stateful auto-configuration method to be used by the print server is
determined by a router. The router specifies whether the print server obtains its address, its
configuration information, or both from a DHCPV6 server.

Router Unavailable: If a router is not available, the print server should attempt to obtain its
stateful configuration from a DHCPv6 server.
Always: Whether or not a router is available, the print server always attempts to obtain its
stateful configuration from a DHCPv6 server.

Primary DNS Use this item to specify an IPv6 address for a primary DNS server that the print server should
use.

NOTE:  This item will appear only if Manual configuration is a higher priority than DHCP in the
Config Precedence table, configured through the embedded Web server.

Secondary DNS  Use this item to specify an IPv6 address for a secondary DNS server that the print server
should use.

NOTE:  This item will appear only if Manual configuration is a higher priority than DHCP in the
Config Precedence table, configured through the embedded Web server.

Proxy Server Specifies the proxy server to be used by embedded applications in the device. A proxy server is
typically used by network clients for Internet access. It caches Web pages, and provides a
degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-qualified domain name. The name can
be up to 255 octets.

For some networks, you may need to contact your Independent Service Provider (ISP) for the
proxy server address.

Proxy Port Type the port number used by the proxy server for client support. The port number identifies
the port reserved for proxy activity on your network, and can be a value from 0 to 65535.

Security Print Sec Page Yes: Prints a page that contains the current IPsec security settings on the HP Jetdirect print

server.

No (default): A security settings page is not printed.
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Menu item Sub-menuitem  Sub-menuitem

Values and description

Secure Web

For configuration management, specify whether the embedded Web server will accept
communications using HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS Required: For secure, encrypted communications, only HTTPS access is accepted. The
print server will appear as a secure site.

HTTP/HTTPS optional: Access using either HTTP or HTTPS is permitted.

NOTE: The factory default setting depends on the print server model.

IPSEC

Specify the IPsec or Firewall status on the print server.
Keep: IPsec/Firewall status remains the same as currently configured.

Disable: IPsec/Firewall operation on the print server is disabled.

802.1x

Enable Wipe

Reset Security

Specify whether the current security settings on the print server will be saved or reset to
factory defaults.

No (default): The current security settings are maintained.

Yes: Security settings are reset to factory defaults.

Link Speed

The link speed and communication mode of the print server must match the network. The
available settings depend on the device and installed print server. Select one of the following
link configuration settings:

CAUTION:  If you change the link setting, network communications with the print server and
network device might be lost.

Auto (default): The print server uses auto-negotiation to configure itself with the highest link
speed and communication mode allowed. If auto-negotiation fails, either T00TX HALF or 10TX
HALF is set depending on the detected link speed of the hub/switch port. (A T000T half-duplex
selection is not supported.)

10T Half: 10 Mbps, half-duplex operation.

10T Full: 10 Mbps, Full-duplex operation.

100TX Half: 100 Mbps, half-duplex operation.

T00TX Full: 100 Mbps, full-duplex operation.

100TX Auto: Limits auto-negotiation to a maximum link speed of 100 Mbps.

T1000TX Full: T000 Mbps, full-duplex operation.

Link configuration methods

The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex communication

modes (a 1000T half-duplex selection is not supported). By default, it will attempt to auto-negotiate its link

operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will configure
itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-negotiating 10
Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.
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If the printer is not able to connect to the network through auto-negotiation, you can set the link setting by one
of the following methods:

e  The front panel
e  The Embedded Web Server
e  The Telnet interface, through a system command prompt

e  Network management tools such as HP Web Jetadmin

Troubleshooting

|0 Configuration card

The 10 Configuration card provides comprehensive print server status. The information provided is an important
diagnostic tool, especially if network communication is not available. For a description of messages that may
appear on the card, see the HP Jetdirect Print Servers Administrator’s Guide for your print server model.

For detailed connectivity information, go to the Connectivity menu and click Network card or Services card to see
all the information available.

The network card provides details about the network configuration and status. The services card provides
information about the state of connections to HP services, such as HP ePrint.

To verify correct operation:

1. Onthe network card, look for the status message I/0 Card Ready.

2. If1/0 Card Ready appears, the print server is operating properly. Proceed to the next section.
If a message other than I/O Card Ready appears, try the following:
a.  Turnthe printer off and then on again to re-initialize the print server.
b.  Check that the status indicator lights (LEDs) are providing proper status.

See the HP Jetdirect Print Servers Administrator’s Guide for your print server model to interpret and troubleshoot
other messages.

Reset network parameters

If you accidentally misconfigured the printer’'s network settings, they can be reset to factory default values by
tapping , then o then Network > Restore connectivity factory settings.

A CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved during reset to factory default values.
However, a Certificate Authority (CA) certificate that has been installed by the user to validate a network
authentication server will not be saved.
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Link troubleshooting

The printer has status lights (LEDs) beside the network connector that indicate the link status and network
activity.

e  Whenthe green light is on, the printer has successfully linked to the network.
e  When the yellow light is blinking, there is network transmission activity.

If the printer does not successfully connect to the network:

e  Both LEDs will be off.

e  Thealert No network cable connected will appear on the front panel.

If a link failure is indicated, try the following:

1. Check the cable connections at both ends.

2. Consider replacing the cables by known good ones.

3. Consider switching to another network connector in the network switch, hub, or device to which the printer
is connected.

4. Manually configure the link setting to match the port configuration of the network hub or switch. For
manual configuration methods, see Link configuration methods on page 59. Turn the printer off, then on
again, to re-initialize the setting.

5. Print a Connectivity Configuration page and check link settings.

Item Description

Port Config If the printer is properly linked, this item has one of the following values:
° TOBASE-T HALF: 10 Mbps, half-duplex
° TOBASE-T FULL: 10 Mbps, full-duplex
e 100TX-HALF: 100 Mbps, half-duplex
e  100TX-FULL: 100 Mbps, full-duplex
e  1000TX FULL
If the printer is not properly linked, one of the following messages will appear:
o  UNKNOWN: The printer is in an initialization state.

e  DISCONNECTED: A network connection has not been detected. Check network cables. Reconfigure the
link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

e  ON (default): The printer will attempt to automatically configure itself onto the network at the proper
speed and communication mode.

o  OFF: You must manually configure the link speed and communication mode using the front panel. Your
settings must match those of the network for proper operation.

6. Incase of doubt or misconfiguration of link settings, reset the network parameters to their factory settings.
See Reset network parameters on page 60.
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Communication failures between computer and printer

Some symptoms are:

The front-panel display does not show the Received jobs message when you have sent jobs to the printer.
Your computer displays an error message when you are trying to print.

Your computer or printer hangs (stays idle), while communication is taking place.

Print jobs get stuck in your computer’s print spooler.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so on).

To solve a communication problem:

Ensure that you have selected the correct printer when sending your job.
Ensure that the printer works correctly when printing from other applications.

If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, or cable converters, try using it when connected directly to your
computer.

Try another network cable.
Remember that very large prints may take some time to receive, process and print.

If your printer displays warning or error messages that reqguire action, take the required action before
trying to print.

Cannot access the Embedded Web Server

1.
2.

6.

If you have not done so already, read Embedded Web Server on page 15.

Make sure that Embdedded Web Server functionality is enabled in the printer: from the front panel, tap
then Security > Connectivity > Embedded Web Server (EWS) > On.

Check the proxy configuration in your Web browser in case it is preventing communication with the printer.
Ensure that the printer works correctly when printing or accessed from other applications.

If the printer displays warning or error messages that require further action, take the action to resolve the
problems.

If all else fails, turn the printer off and on again with the power key on the front panel.

Cannot access the printer from the HP Utility

1.
2.

If you have not done so already, read HP Utility on page 13.

Make sure your printer is not in sleep mode.

Make sure your printer driver is available and working correctly for the HP Utility in Windows.

From the front panel, tap
it is enabled. If it is disabled, some parts of the HP Utility may not work properly.

, then Security > Web services > Printing & management, and make sure that
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Print jobs take too much time to be received by the printer

ENWW

If you send a very large print to the printer, there will normally be some delay before it starts printing. However,
if you think you are experiencing abnormally long delays, there are various things you could check:

Make sure the network cable connected to the printer is rated at least Cat5e.

Make sure that gigabit-speed networking equipment and cabling interconnects your computer client to the
printer.

Make sure that there are no network link issues. See Link troubleshooting on page 61.

Take into account that, in network deployments with IPSec security protocols enabled and configured in the
printer, network performance may be reduced due to the use of cryptographic algorithms to protect
network communications.

Try resetting the network configuration to its factory settings in order to get default settings that are
suitable for most standard network environments. See Reset network parameters on page 60.

You may also find it helpful to test connecting the computer to the printer directly, using a normal Ethernet
(Cat5e or Catb) cable point-to-point, without passing through an Ethernet switch or router. In this
configuration, the printer and the computer should both automatically change their IPv4 addresses to the
form 169.254.x.x . In this point-to-point configuration you can discard any issues caused by other network
equipment.

Troubleshooting
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5 Printing

° Introduction

° Print from a USB flash drive

° Print from the network folder

° Print from a computer using a printer driver

° Advanced print settings
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Introduction

There are various different ways in which you can choose to print, depending on your circumstances and
preferences:

Print a TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript file directly from a USB flash drive. See Print from a USB

flash drive on page 65.

Print a TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer, using HP Click.
See http://www.hp.com/go/DesignJetclick.

Print any kind of file from a computer connected to the printer, using a software application that can open
the file, and a printer driver supplied with your printer. See Print from a computer using a printer driver
on page 67.

Print from a smartphone or tablet. See Mobile printing on page 79.

Print from a network folder. See Print from the network folder on page 66.

Print from a USB flash drive

ENWW

1.

Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript files into the
printer's USB port.

@”f NOTE: To print PDF or PostScript file, you must have a PostScript printer.

Lﬁ/f NOTE: The use of USB flash drives with your printer may be disabled by the administrator.

At the front panel, go to the home page and tap ﬁ

You can tap folders to browse their contents. Files are shown as document thumbnails, and you can
preview a file by tapping the preview icon. When the preview is displayed, you can zoom in and out. Files

that cannot be printed are indicated with . For more details, press the information button.

Select .

Select a file to be printed. A preview of the document is displayed. Multipage documents are supported
only in PDF files; in this case, you can also select a page to print. Use the toolbar buttons to zoom in and
out to see information about the selected job. You can also choose the predefined zoom modes fit to
screen, pinch to zoom or original document size. Press OK to go to the quickset selection.

Introduction
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5. The list of print-from-USB quicksets is displayed. You can choose and/or edit one of the quicksets for the
selected job.

[%’ NOTE: If you edit a quickset after selecting a job, the changed settings are applied only to the current job
and are not saved permanently. You can change any of your own quicksets permanently by tapping {)

then manage quicksets, or by tapping

©)

, then Quicksets.

[i;’/f’ NOTE: The factory quicksets cannot be modified.

The following settings are available:

Quickset name allows you to name the quickset you are working with.
Print quality allows you to set the print quality to Fast, Normal, or Best.

Output scale allows you to resize the print in two different ways: to a percentage of its original size, or
to fit a particular paper size. The default is 100% (its original size).

Color options allows you to choose color or grayscale.

Paper source allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

Paper category allows you to choose the type of paper.
Page order allows you to choose first page on top, or last page on top.
Collate allows you to turn collation on or off.

Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which
rotates the print automatically if that will save paper.

Print margins allows you to change the default printer margins.

Storage mode offers two options, print and delete (the job is not retained in the job queue) and print
and store (the job is retained in the job queue).

Output destination.

6.  When you are satisfied with the quickset settings, tap OK to continue. You can tap ««e, then show quickset
details panel to show the most common quickset settings used.

7. Copies, Page order, and Collate can be selected in the right column of the screen. Tap Print to continue.

8.  After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home page, the temporary settings used for the previous file are
used again.

Print from the network folder

1. Confirm the network folder is configured. See Configure a network folder on page 21.

2. Atthe front panel, go to the home page and tap ﬁ

3.  Select Network.
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4.  Select afile to be printed. Multipage documents are only supported in PDF; in this case, you can also select
a page to print.

5. Thelist of print-from-Network quicksets is displayed. You can choose and/or edit one of the quicksets for
the selected job.

[%f NOTE: If you edit a quickset after selecting a job, the changed settings are applied only to the current job
and are not saved permanently. You can change any of your own guicksets permanently by tapping {)

©)

7 NOTE: The factory quicksets cannot be modified.

then manage quicksets, or by tapping , then Quicksets.

The following settings are available:
e  Quickset name allows you to name the quickset you are working with.
e  Print quality allows you to set the print quality to Fast, Normal, or Best.

e  QOutput scale allows you to resize the print in two different ways: to a percentage of its original size, or
to fit a particular paper size. The default is 100% (its original size).

e  Color options allows you to choose color or grayscale.

° Paper source allows you to specify printing onroll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

e  Paper category allows you to choose the type of paper.
e  Page order allows you to choose first page on top, or last page on top.
e  (ollate allows you to turn collation on or off.

e  Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which
rotates the print automatically if that will save paper.

e  Print margins allows you to change the default printer margins.

e  Storage mode offers two options, print and delete (the job is not retained in the job queue) and print
and store (the job is retained in the job queue).

e  QOutput destination.

6.  When you are satisfied with the quickset settings, tap OK to continue. You can tap «s-, then show quickset
details panel to show the most common quickset settings used.

7.  Copies, Page order, and Collate can be selected in the right column of the screen. Tap Print to continue.

8.  After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home page, the temporary settings used for the previous file are
used again.

Print from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the
computer (see Install your printer under Windows on page 17), and the computer must be connected to the
printer.
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When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

Advanced print settings

The rest of this chapter explains the various print settings that you can use when printing with a printer driver or
the front panel. These methods offer a relatively large number of settings in order to satisfy all requirements.

> TIP:  In general you are recommended to use the default settings unless you know that they do not meet your

requirements.

TIP: If youintend to reuse a particular group of settings repeatedly, you can save those settings under a name
of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the Windows
printer driver, and as a 'preset' in the Mac OS printer driver.

Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while
fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed.
With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also
select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases
printing speed even further, but reduces print quality. Economode can be selected only from the custom options
(not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See
High-quality printing on page 73.

[%/r NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print

Quality Options dialog box (click Custom options > Settings).
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You can select print-quality options in the following ways:

e Inthe Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. If you use Standard Options, you will see a simple slider with which you
can select speed or quality. If you use Custom Options or Advanced (depending on the driver version), you
will see the more specific options described above.

o=
|
Paper/Quality |layout/Output Color  Job Storage  Services  Advanced
|
| Quicksets:
| Factory defaults ~ Save Delete
| Paper Options
Document size:
A4 ~||  custom...

"
cat | Quality level:

| Fast -

© [ Maximum Detail
[[]EconoMode Print Quality

(O standard options

Pag

|: OK Cancel

I@ Custom options Settings...

Paper type:

| Use printer settings V| Rendering resolution (ppi): 600

Printing resolution (dpi): Automatic

oK Cancel

, then Default printing configuration > Print quality.

e  Using the front panel: Tap

r_ﬁ”f NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

[:?’”f} NOTE: You cannot change the print quality of pages that the printer is already receiving or has already received
(even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

[% NOTE: The paper size specified here should be the paper size in which the document was created. It is possible
to rescale the document to a different size for printing. See Rescale a print on page 72.

e Inthe Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver version), then
select your paper size from the Document Size list.

[’_5? NOTE: If you are printing with the V4 driver and from Adobe Acrobat, the page size and orientation are
determined by the application.

[’_ﬁf’ NOTE: If your application offers no Page Setup dialog, use the Print dialog.

, then Default printing configuration > Paper options > Paper size.

e  Using the front panel: tap

[% NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.
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Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various
different ways to specify it.

Use the Windows printer driver (version 3)

1.
2.
3.

4.

Click the Paper/Quality tab.
Click Custom.
Enter the name and dimensions of your new paper size.

Click OK. The new paper size is automatically selected.

Use the Windows printer driver (version 4)

1.
2.
3.

4.

Click the Paper tab.
Click Document size.
Enter the dimensions of your new paper size into the two fields in the custom area.

Click the arrow button.

A custom paper size created with the printer driver has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

The paper size is local to the printer queue. It will not be seen from other printer gueues in the same
computer.

In Domain server networks, the paper size is local to the computer. It will not be seen from other computers
sharing the printer queue.

In Workgroup networks, the paper size will be shared among all the computers sharing the printer queue.

If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms

1.
2.

©® N o

From the Start menu, or from the Control Panel, select Printers and Faxes.

From the File menu, select Server Properties.

In the Forms tab, check the Create a new form box.

Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

Click the Save Form button.

Go to the printer driver, and select the Paper/Quality or Paper tab (depending on the driver version).
Select More... from the drop-down list of paper sizes.

Select your new paper size from the group of Custom sizes.
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A custom paper size created with Windows forms has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

Restricted users cannot create paper forms. The “manage documents” role in the Windows Active Directory
is the minimum required.

The paper size is local to the computer. It will be seenin all the printer queues that have been created on
the computer and that support paper of that size.

If a printer queue is shared, this paper size will appear in all the client computers.

If a printer gueue is shared from another computer, this paper size will not appear on the driver’s
document size list. A Windows form in a shared queue needs to be created in the server.

If the printer queue is deleted, the paper size is not deleted.

Select margin options

By default, the printer leaves a 3 mm margin between the edges of your image and the edges of the paper
(increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

Choose between 3 and 5 mm margins

In the Windows V3 driver dialog: Select the Advanced tab, then click Advanced features > Document
options > Printer features > Margin, and select the margin size.

In the Windows V4 driver dialog: Select the Layout tab and select your margins from the With Margins list.

Using the front panel: Tap , then Default Printing Configuration > Margins.

Choose margin layout options

ENWW

In the Windows V3 driver dialog: Select the Paper/Quality tab, and click the Margins/Cutter Settings button.
The Layout and Margins window is displayed.

In the Windows V4 driver dialog: Select the Layout tab and go to the Layout Mode area.

Using the front panel: Tap , then Default printing configuration > Margins layout.

You will then see at least some of the following options.

Use application settings (drivers)/Use standard (front panel). Your image will be printed on a page of the
size you have selected, with a narrow margin between the edges of the image and the edges of the paper.
The image should be small enough to fit between the margins.

Oversize. Your image will be printed on a page slightly larger than the size you have selected. If you cut off
the margins, you will be left with a page of the size you selected, with no margins remaining between your
image and the edges of the paper.

Clip contents by margins. Your image will be printed on a page of the size you have selected, with a narrow
margin between the edges of the image and the edges of the paper. In this case, if the image is the same
size as the page, the printer assumes that the extreme edges of the image are either white or unimportant,
and do not need to be printed. This may be useful when your image already contains a border.

Advanced print settings 71



Print on loaded paper

To print a job on whichever paper is loaded in the printer, choose the following Paper Type option in your printer
driver:

e Inthe Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver version), then
select Use Printer Settings in the Paper Type drop-down list.

EY NOTE:  Use Printer Settings (Windows).

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally
larger). This may be useful:

e Ifyour software does not support large formats

e Ifyourfileis too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

e Inthe Windows driver dialog: Go to the Layout Output or Layout tab (depending on the driver version) and
look at the Resizing Options section.

—  The Actual size option leaves the size of the image unchanged.

—  The Fit to option adjusts the image size to the paper size you have selected. For example, if you have
selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If
the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

—  The % of actual size or Scale % option (depending on the driver version) enlarges the printable area of
the original paper size (the page minus the margins) by the percentage indicated, then adds the
margins to create the output paper size.

e Using the front panel: Tap {G}

, then Default printing configuration > Paper options > Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise
the image will be clipped.

Change the treatment of overlapping lines

299

B NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:
e  Off: Where the lines cross, only the color of the top line is printed. This is the default setting.

e  On: Where the lines cross, the colors of the two lines merge.

, then Default printing configuration > HP-GL/2 options >

Merge. You can set the merge option from your software in some applications. Settings in your software override
the front-panel settings.

To turn merge on, go to the front panel and tap :
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Preview a print

Previewing a print on the screen allows you to check the layout of the print before printing, which may help you
to avoid wasting paper and ink on a bad print.

e  Topreview a print under Windows, you have the following options:
—  Use the HP Print Preview application:

Check the Show preview before printing box, which you can find in the right bottom corner of the
driver dialog. Click Print, then wait a few seconds for the HP Print Preview application to be launched.

Check that the preview of the job is what you wanted. If so, click Print, otherwise click Cancel; you can
readjust the driver settings before trying again.

[17? NOTE: The Show preview before printing box appears in the driver dialog only if HP Print Preview is
installed in your computer. See HP Print Preview on page 14.

—  Use your application's print preview option.
e  Topreview a print under Mac OS X, you have the following options:
—  Use your application's print preview option.

— Aprint preview is always shown on the print dialog box for most applications.

Print a draft
You can specify fast draft-quality printing in the following ways:

e Inthe Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. Move the print-quality slider to the extreme left (‘'Speed’).

e  Using the front panel: Tap , then Default printing configuration > Print quality > Select quality level >
Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for
documents containing only text and line drawings.

e Inthe Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. Select Custom Options or Advanced (depending on the driver version),
then set the quality level to Fast and check the Economode box.

e  Using the front panel: Tap , then Default printing configuration > Print quality > Enable economode.

Ej?)f NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing
You can specify high-quality printing in the following ways:

e Inthe Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and
look at the Print Quality section. Move the print-quality slider to the extreme right ('Quality’).

e Using the front panel: Tap §B}, then Default printing configuration > Quality level > Best.

[:?’”r NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.
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If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum detail option.
This option is available only if you are printing on glossy paper and you have selected Best print quality.

e  Using the front panel: Tap , then Default printing configuration > Print quality > Enable maximum detail.

[%f NOTE: The Maximum detail option results in slower printing with photo papers, but it does not increase the

amount of ink used.

Print in gray shades

You can convert all colors in your image to shades of gray: see Printing in grayscale on page 123.

Print with crop lines

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines
with individual jobs in the following ways:

e  Inthe Windows V3 driver dialog: Select the Paper/Quality tab, then click the Margins/Cutter Settings button.
Check the Draw cutting lines box in the Layout and Margins window.

e Inthe Windows V4 driver dialog: Select the Output tab and check the Crop lines box.
Alternatively, you can choose to print crop lines with all jobs by default:

e  Using the front panel: Tap , then Default printing configuration > Paper options > Enable crop lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 75), you must select a different
option:

, then Job management > Nest options > Enable crop lines > On.

{C}

e  Using the front panel: Tap

Use paper economically

74

Here are some recommendations for making economical use of paper:

e Ifyou are printing relatively small images or document pages, you can use nesting to print them side by
side instead of one after another. See Nest jobs to save roll paper on page 75.

e  You may be able to save some roll paper by using the following options:
—  Inthe Windows driver dialog:

o Withaversion 3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button,
then check the box Remove blank areas.

o With aversion 4 driver: Click the Output tab, then Roll options, then check the box Remove blank
areas.

You can also select the Layout/Output or Layout tab (depending on the driver version) and then select
one of the Rotation options.

e Ifyou check the print preview on your computer before printing, you can sometimes avoid wasting paper
on prints containing obvious mistakes. See Preview a print on page 73.
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Nest jobs to save roll paper

Nesting means automatically printing images or document pages side by side on the paper, rather than one
after the other. This is done to avoid wasting paper.

1.  Direction of paper flow
2. Nesting off
3. Nestingon

4.  Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:
e  The printer is loaded with roll paper, not sheet paper.

e  The printer's Nest option is turned on. See How to turn nesting on and off on page 76.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless
there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be
split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the following ways:
e  All pages must have the same print quality setting (Economode, Fast, Normal or Best).
e  The Maximum Detail setting must be the same on all pages.
e  The Layout/Margins setting must be the same for all pages.
e  The Mirror Image setting must be the same for all pages.
e The Rendering Intent must be the same for all pages.
e  The Cutter setting must be the same for all pages.

e  Pages must be all color, or all grayscale: not some in color and some in grayscale.
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e  All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same
nest):

—  PCL3,RTL, TIFF, JPEG
—  PostScript, PDF

e JPEGand TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

How to turn nesting on and off

To turn nesting on or off, you must first make sure that the start of printing is set to After Processing (see Select
when to print a job on page 87).

Then go to the front panel and tap , then Job management > Nest options > Nesting.

You will see the following options:

e Inorder: Pages are nested in the order in which they are sent to the printer (this is the default option). The
nested pages are printed as soon as one of three conditions is met:

—  The next page will not fit on the same row as the other pages already nested.
— No page has been sent to the printer during the specified wait time.

—  The next page is incompatible with the pages already nested (see Nest jobs to save roll paper
on page 75).

e  Optimized order: Pages are not necessarily nested in the order in which they are sent to the printer. When it
receives an incompatible page, the printer holds it and waits for compatible pages to complete the nest.
The nested pages are printed as soon as one of three conditions is met:

—  The next page will not fit on the same row as the other pages already nested.
— No page has been sent to the printer during the specified wait time.

—  The incompatible-page queue is full. The printer can queue up to six incompatible pages while
nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

e  Off: nestingis disabled.

¥ TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print because the
printer waits for compatible pages to arrive.

How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check whether a
subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time;
the factory default nest wait time is 2 minutes. This means that the printer waits for up to 2 minutes after the
last file is received before printing the final nest. You can change this waiting time from the printer's front panel:

, then Job management > Nest options, and select the wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel and in the
Embedded Web Server.
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Use ink economically

Here are some recommendations for making economical use of ink:

e  Fordraft prints, use plain paper and move the print-quality slider to the left end of the scale (‘'Speed’). For
further economy, select custom print quality options, then select Fast and Economode.

e  (leanthe printheads only when needed, and clean only those printheads that need cleaning. Cleaning the
printheads can be useful, but it uses a small amount of ink.

e  Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done,
the printer may need to use much more ink later to restore the health of the printheads.

e  Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some
ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs
can save ink as well as saving paper (see Nest jobs to save roll paper on page 75).

Protect a paper type

You can protect selected paper types to avoid printing on them unintentionally. A protected paper type will be
printed on only when the paper type is explicitly specified in the job.

To protect a paper type, tap then Job management > Roll policies > Paper Type Protection, then select the
category of paper you want to protect.

When a paper type is protected, the ¥ icon appears before the paper name.

To print on a protected paper category, just select the paper type explicitly when submitting the job from a
printer driver or other job submission software.

[:?’”r NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an out-of-

paper message will appear.

Unattended printing/overnight printing
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The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent image
quality.

Here are some recommendations to help you deal with a long queue of printing jobs.
e |[ffeasible, use brand-new long rolls of paper.

e Ifyou want to print on partly-used rolls, you can check the paper type and the remaining length in the
Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your jobs.

[%”f’ NOTE: Information on the remaining length is available only if you told the printer the length of the roll
when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

e Ifyou have a T2600dr printer, load two rolls of paper suitable for your jobs. If the printer finishes one roll, it
will automatically switch to the other.

° HP recommends the use of papers approved for your printer. See Supplies and accessories on page 175.

e  (Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put on
hold for paper if the paper mismatch action is set to Put job on hold (see Solve paper mismatch
on page 88).
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e  (Check the ink levels remaining in your ink cartridges.

e  When you have submitted your print jobs, you can use the Embedded Web Server from a remote location
to monitor their status.

e  Drying time should be set to Optimal.

e  T2600dronly: Tap § 5, then Job management > Roll policies > Use most depleted roll > On.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Recommended settings for unattended printing

Print type Print mode Maximum detail Drying time Paper types

Lines Normal Off Optimal Coated, Bond, Heavyweight
Coated, Glossy

Lines and fills Normal Off Optimal Coated, Bond, Heavyweight
Coated, Glossy

Maps Best Off Optimal Coated, Heavyweight Coated,
Glossy

Renderings, photographs Best Off Optimal Coated, Heavyweight Coated,
Glossy
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° Introduction

° Print from Android

° Print from Chrome 0S

° Print, scan, and share from the HP Smart App

e  Print by email (HP ePrint)

° Mobile specifications
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Introduction

You can print to your printer from many mobile devices and from almost any location. There are two main
methods of Mobile Printing:

e  Direct printing by connection to the same network
e  Printing by e-mail
Your printer can be connected to the Web, providing various benefits:

e  Automatic firmware updates (see Update the firmware on page 168)

° Print on HP printers from almost anywhere
e  Print on HP printers from almost any device, including smartphones, tablets, and laptops

See http://www.hp.com/go/designjetmability for more detailed information.

You can enable Web Services when setting up the printer: see Set up printer services on page 18 or the
Assembly Instructions for more information.

[Q” IMPORTANT:  The printer must be connected to a network with Internet access: connect an Ethernet cable. See
Connect the printer to your network on page 16.

Print from Android

99

B NOTE: Printing is only available from applications that offer printing or sharing.

For Android printing, install and enable the HP Print Service App from Google Play (https://play.goodle.com/
store/apps/details?id=com.hp.android.printservice&hl=en), if it is not already installed in your device. You must
have Android KitKat 4.4 or later.

1. Open the document or photo you want to print, and press the menu icon, and select Print.
2. Choose your printer from the list.

3. (Check the print settings, then press Print.

Print from Chrome 0S

Printing from Chromebook devices is as easy as installing the HP Print for Chrome extension from the Chrome
Web Store (https://chrome.google.com/webstore/detail/hp-print-for-chrome/
cjanmonomjogheabiocdamfpknlpdehm).

1. Choose your content. Open the document or photo you want to print, tap the menu icon and select Print.
2. Choose your printer. Select from the list of printers that appears.

3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed
documents.

949

B NOTE: Printing is only available from applications that offer printing or sharing.
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Print, scan, and share from the HP Smart App

Use the screen on your mobile device to control printer scan and print functions. Send scans directly to your
mobile device from your printer. Print PDF, photos, email attachments, and more from virtually anywhere.

You can download the HP Smart App from the following locations:

e  Android: https://play.google.com/store/apps/details?id=com.hp.printercontrol

e i0S: https://itunes.apple.com/app/id469284907

Make sure your device and printer are operating on the same network, and follow the steps below:

i0S and Android printing with the HP Smart App
1. Openthe HP Smart App and select your printer.

2. Select whether you want to print documents or photos from your local device, or link your Google Drive,
Dropbox, or other accounts to access your content.

3. Usethe edit options to adjust quality, color, and other settings if you wish to make such adjustments.

4.  Tap Print and collect your printed documents.

i0S and Android scanning and sharing with the HP Smart App
1. Load the paper to be scanned to. Place the document that you want to scan on the printer.

2. Openthe HP Smart App and trigger scanning from it. You can either store the document in your mobile
device, send it by email, or upload it directly to your preferred cloud repository.

Print by email (HP ePrint)

FJ IMPORTANT:  To enable email printing, see Enable email printing with HP ePrint on page 18.

If you can email it, you can print it. Simply attach a PDF or other print-ready file to an email message, and send it
to your printer’s dedicated address.

You can print from anywhere with an Internet connection, with no need for a printer driver, but there are a few
limitations to bear in mind:

e  The attached files to be printed must be in PDF format.
e  The maximum file size is 10 MB, but your email server may have a lower limit.

e  Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in
portrait orientation (some printers may offer autorotation).

For more information, see https://www.hpconnected.com.

Mobile specifications

e  Mobile devices must have an Internet connection and email capability.

e  Print, scan, and copy control requires the mobile device and printer to be on the same network.
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e  Printing by email also requires the printer to be connected to the Internet.

e i0S7.0and above, or Android KitKat4.4 and above, is required.
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Job queue management

Job queue in the front panel

Print job queue in the Embedded Web Server or HP DesignJet Utility

Scan gueue in the Embedded Web Server or HP DesignJet Utility
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Job queue in the front panel
Tap 4_, on the home screen to view the job queue(s) on the front panel.

You can choose Print & Copy queue or Scan queue from the tabs at the left of the screen. The job queue page
shows all jobs that are available in the selected job queue.

Print & Copy queue

The Print & Copy queue(s) includes jobs that are in different phases: being received, parsed, rendered, printed,
already printed, and so on.

Tap the name of the job to see all the job details, including information about status and preview. The details
displayed depend of the type of job.

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below and jobs
to be printed above. You can scroll up and down. Once scrolled, the queue remains static and does not move
automatically.

Jobs in the left pane are divided into four categories (Up next, Now printing, On hold, and History) in
chronological order starting from the top. On hold is shown only when there are one or more jobs on hold. Below
the job name, you can see its status:

Up next
e  Waiting to process: The job has been received by the printer and is waiting to be rendered.
e  Processing: The printer is parsing and rendering the job.
e  Waiting to print or Paused: The job is processed and waiting for the print engine to be ready to proceed with

printing.

84  Chapter 7 Job queue management ENWW



Now printing
The job is being printed.

e  Paused: The job is paused.

[%f NOTE: Sometimes, while printing, you may see a Self-servicing status, which means that the printer is
performing some task such as paper type change or print mode change between pages of the same job.

On hold
The job will not be printed until you take some action. You should respond in one of the following ways:
e  Onhold: Private job: Enter the PIN required to print the job. The job will be deleted from the queue after
printing.
e  Ohhold: Personal job: The job is not automatically printed: you must select it from the queue. No details
can be seen.
e  Onhold to preview: The job is not automatically printed: you must select it from the queue.
e  Onhold for paper mismatch: Load the paper required by the job.
e  Onhold for accounting: Enter an account ID to be used for the job.
e  Onhold: Recovered job: After a printer recovery, some jobs that were not printed are kept on hold.
History
e  Printed: In chronological order, divided into today, yesterday, last week, and so on.
e (anceled: Canceled by the user.
e  Failed: The job has failed for one or more reasons.
Scan queue

The scan queue structure is similar to the Print & Copy queue, but with the files organized by date. The main
details (selected destination and its respective status) are in the left panel, below each job.

In the right pane, detailed information appears after scrolling:
a.  Scanned by

b.  Dateandtime

c.  Filetype

d.  File Size (if there are several sizes, value will be several)
e. Content type

f.  Size

g. Color mode

h.  Resolution

i. Destination
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Scan queue actions

Some job queue actions are determined by the settings selected. Depending on the environment, it may be
worthwhile to change some default settings; to do so, tap in the home screen, then Job Management.
Alternatively, in the job queue, tap ««-at the top right, then Settings.

Print
In the left panel, tap the job to print, then on the details screen select Print. On the following screen, select the
number of copies, choose a quickset, and edit the printing preferences. When you press Print, there is an option
to manage the job in the job queue.

Delete

To delete ajob manually, select the job and tap Delete.

Cancel Sending

The transfer of a file can be canceled if it is in the status: waiting to be sent or sending.

Send to
Available only if the file has already been sent or failed. When you tap Sent to options appear:

e To Network folder: possible only if a network folder is configured. See Configure a network folder
onpage 21

° To email: see Configure the email server on page 29

° USB drive: see Scanning and copying on page 93

Scan queue options

Delete all scan jobs

To delete the whole job queue: tap «««, then Delete all jobs.

Manage remotely

Tap ««« at the top of the screen, then manage remotely. A QR code is displayed. To access the scanned files in
the EWS, scan the QR code or enter the URL shown. See Scan gueue in the Embedded Web Server or HP
DesignJet Utility on page 91.

[%’/r NOTE: The device used to connect to this link must be on the same network as the printer.

Job queue actions

Some of the actions in the job queue are determined by the settings selected. Some default settings may be
worth changing, depending on your environment. To do so, tap in the home screen, then Job management.
Alternatively, in the job queue app, tap =+« at the top right, then Settings.

Pause the job queue

You can pause the job queue by tapping [m] and resume by tapping [0] The pause takes effect at the end of
the page that is currently printing.
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Reprint

In the History section, tap the job you want to reprint. On the details screen, tap Reprint. On the next screen, you
can select the number of copies, the source, and the destination.

Print next

If you want to change the position of a job in the queue to be printed immediately after the currently printing job,
select the desired job and tap the Print next button.

Select when to print a job

[%f NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a job in the queue. Tap , then Job management > When to start

printing.
There are three options you can select:

e  When After Processing is selected, the printer waits until the whole page has been processed and then it
starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

e When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting, but
the printer may stop halfway through a print to process data. This setting is not recommended for complex
images with dense color.

e  When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and Immediately
settings.

See job details

Tap the name of the job to show its details, including information about status, pages, copies, total, and preview.
Scroll down as necessary to see all of the information.

By tapping the thumbnail, you can navigate over all pages of the job. From there you can zoom in and out (pinch
and zoom) and see more information about each page.

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below and jobs
to be printed above.

Roll policies

ENWW

At the front panel, tap 1, then «e«, then {) then Roll policies.

{C}

The following options are available:

Alternatively, tap §©%, then Job management > Roll policies.

e Increase productivity: To increase the productivity of the printer.
— Job autorotation: The printer can rotate a job automatically in order to save paper.
e  Automatic roll selection:

—  Roll width selection: The printer can be more or less restrictive when selecting the roll width on which
to print. You can select:

Job gueue in the front panel
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o Print on the same width only: Each page prints on a roll with the same page width.
o Print on the same width or wider: Each page prints on a roll with the same width or wider.

—  Use most depleted roll (T2600dr only): When there are two with the same paper type and width, the
roll selected is the roll with less paper.

e  Paper type protection (T2600dr only): You can avoid printing accidentally on special paper types by
protecting them. Protected types are eligible for printing only when paper type or roll are specified in the
job.

See also Protect a paper type on page 77.

Solve paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can
automatically solve the conflict or give a number of choices depending on the printer policies. Such a conflict
may be caused by a job sent to the printer with no specific roll or paper type assigned to it, or by a roll coming to
its end during printing. The following options are available in the paper mismatch settings menu; you can reach

this menu from the job queue by tapping ««, then {) then Mismatch actions > Paper mismatch; or by tapping
, then Job management > Mismatch actions > Paper mismatch.

e  Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This option is
recommended when the printer is attended. A message appears, asking what you want to do: cancel the
job, print anyway, put on hold, or load paper. These options are also available in the job queue.

e Hold job and continue with next: Put mismatched jobs on hold until the correct paper is loaded, and
continue printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. This
option is recommended when the printer is unattended, even though the integrity of a job may be
disrupted, to avoid stopping the queue. Once the paper required for the job is loaded, the job or pages are
automatically resumed.

e  Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose the roll
to print according to the following criteria: first where the page fits and then the same paper type. This
option will never select a paper type that has been protected.

Job queue options

To change the job queue options, tap , then Job management > Job queue. Alternatively go to 1 then see,
then Settings > Job queue.

You can select the maximum number of printed jobs to have in the queue, when to delete printed jobs, and
whether to delete jobs on hold after a specified time.

Default printing preferences

At the front panel, tap , then Default Printing configuration to define the default properties of jobs sent to
your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, PostScript, Print retrieval.

Job deletion

If the printer runs out of storage space for new jobs, the oldest printed jobs are automatically deleted from the
queue.
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You can request that printed jobs should be automatically deleted from the queue when the total number of
printed jobs exceeds a specified limit (the maximum number in the history setting), or when the jobs were
printed more than a specified time ago (clear history settings).

To delete jobs on hold, the setting Delete jobs on hold allows you to define the time after which these jobs will be
removed (2-48 h).

To delete a job manually, select the job and tap Delete on the bottom right.

The Delete option deletes the job from the queue, while the Cancel option cancels the job but leaves it in the
gueue, marked as Canceled by the user in the history category.

To cancel a job while printing, tap X. To cancel a job from the Up Next category, tap the job name on the list and
then tap Cancel job on the bottom right.

4" NOTE:  If you tap X, you cancel the currently printing job only.

Print job queue in the Embedded Web Server or HP DesignJet Utility

The HP DesignJet Utility provides a different way of accessing the Embedded Web Server's job management
facilities, but the facilities are exactly the same whether you use the Embedded Web Server or the HP DesignJet
Utility.

To see the queue in the Embedded Web Server, select Job queue in the Main menu.
Printing

Job queue page

By default, access to the job queue is open to all users. An administrator can set a password so that users are
required to enter a password to access the page.

The job queue page shows all jobs that are available in the queue. The queue includes jobs that are being
received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:
e  File name: The name of the job.

e  Status: The current status of the job.

e  Pages: The number of pages in the job.

e  (Copies: The number of copies printed.

e  Total: The total number of pages (including copies).

e  Sentby: The username.

e  Account ID: The account ID for the job.

e Date: The date and time attached to the job that was received by the printer, shown in the locale of the
Embedded Web Server.

e  File source: The application from which the job was sent to print.

e  Paper destination: The output option selected for the printed job.
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You can perform the following operations on one or all jobs in the queue:

e (ancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains
stored in the printer, but will not be printed unless you click Reprint.

e  Hold: Holds the select jobs until you click Continue to print.

e  Resume: All selected jobs, which are on hold, continue printing.

e  Reprint: Prints more copies of a job.

e  Next print: Sends all selected jobs to the top of the job queue.

e  Print anyway: The printer will try to print the job even if there is some problem with it.

e Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

Prioritize a job in the queue

You can select any job in the queue and make it the next one to be printed. After selecting the job, click Move to
front.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed
next, and not nested with others, first turn nesting off in the front panel and then move it to the front of the
queue.

In the following cases, the Next print button is not displayed:

The job is already at the front of the queue.

e Thejobis on hold—in this case the Resume printing button is displayed instead.
e  Thejob has finished—in this case the Reprint button is displayed instead.
e  Thejobhas some error condition.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off
the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it,
you can simply select the job and then click Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can click Cancel and then Delete.

Reprint a job in the queue

To reprint an already-printed job, select the job from the queue, then click Reprint. When reprinting a print job,
you cannot change the print settings, because the job has already been rasterized.

Job status messages
These are the possible job status messages, approximately in the order in which they may be seen:
e  Downloading: The printer is receiving the job from the computer.

e  Processing: The printer is parsing and rendering the job.
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e  Waiting to print: The job is waiting for the print engine to become free to proceed with printing.

e Nested: The printer is set up with Nesting=0n and is waiting for other jobs in order to complete the nest
and proceed with printing.

e  Preparing to print: The printer is performing writing system checks before printing the job.

e  Onhold for preview: The job was sent with the on hold for preview option.

[% NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed
job will appear in the queue as on hold when the printer is next turned on. When you resume the job, it will
start printing at the page at which it was interrupted.

e  Onhold for paper: The job cannot be printed because the right paper is not loaded in the printer. Load the
required paper, see Paper handling on page 34, and click Continue to resume the job.

e  Onhold for accounting: The job cannot be printed because the printer requires all jobs to have an account
ID: enter the account ID and then click Continue to resume the job.

% TIP:  To setanaccount ID, see Require account ID on page 30.

e Printing

e Drying

e  (utting paper

e  Ejecting page

e (anceling: The job is being canceled, but will remain in the printer job queue.
e  Deleting: The job is being deleted from the printer.

e  Printed

e (anceled: The job has been canceled by the printer.

e  (anceled by user

e  Emptyjob: The job does not contain anything to print.

Reactivate a job on hold

When the printer puts a job on hold you receive an alert, see Alerts on page 218, which explains why the job is
on hold. Follow the instructions on the screen to remove the hold and continue printing.

Scan queue in the Embedded Web Server or HP DesignJet Utility

ENWW

To see the queue in the Embedded Web Server, tap Job queue > Scan queue.

By default, access to the job queue is open to all users. The administrator can set a password for users to access
the page.

The Embedded Web Server displays the following information for each job:
e  File name: name of the job.

e  Status: current status of the job.

Scan queue in the Embedded Web Server or HP DesignJet Utility
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e  Pages: number of pages in the job.

e Date: date and time attached to the job that was scanned.

° Destination: storage location.

You can perform the following operations on one or all jobs in the queue:

e  Delete all: deletes all jobs from the job queue from the top of the window. You are asked to confirm before
the job is deleted.

e  Delete: press the button at the bottom of the window to delete selected jobs from the job queue. You are
asked to confirm before the job is deleted.

e  Download: the selected job can be download and saved to your local disk.

e  Tap preview to see the job in full-screen. If the job is multi-page, select the page you want to preview.

Manage scanned files remotely

During the scan process you can request a QR code to manage your job remotely. Scan the QR code with your
mobile phone to access your printer's embedded web server remotely, and select the job to manage from the
job gueue.

[%/r NOTE: Your device must be on the same network as the printer.
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Quicksets

Scanning and copying use quicksets. A quickset is a named group of settings with default values defined, which
helps you to be more efficient and is convenient for inexpert users.

Factory quicksets

The printer comes with some factory quicksets already defined, designed to support typical user requirements.
Quicksets can be used for scan, copy, and print jobs.

User quicksets

Depending on the permissions set in your printer, you can create, delete, reorder, or change a quickset. To do
these things, tap Print, Scan & Copy quicksets in the settings application, or tap Manage quicksets from the scan,
copy, or print workflow.

Your own quicksets can be duplicated, edited temporarily or permanently, and deleted. Factory quicksets can
only be duplicated.

You can reorder the quicksets from Manage quicksets. Tap an entire quickset and drag it to the desired position.
The Last settings quickset is always shown first.

Scanning
1. Tap['L.
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t e

Print Scan

Select an appropriate quickset for your scan job. Any quickset can be modified by tapping . You can select
the file format, single or multiple pages, and change the default filename.

Copy

Job queue

@ | Scan configuration

22 20000 ] Lines

Last settings 7
7] Lines £ 300dpi
2 Color ;) White paper
Color lines

8 Color J White paper

|| B&w lines

£52 300 opi [E] Lines

3 Grayscale J Wnite paper

1] Mixed content

| 22 200 dpi 2 Mixed
2 Color # White paper

To change a quickset permanently, tap ««+, then Manage quicksets.

Last settings C
Resolution 300, »

St background removal

Detailed background removal

Black enhancement

Select the scan destination.

File format: Single-page TIFF

am

Saveas:
® Separate single-page files
O Onemulti-page file

[

File name prefix: Scan_

° @

Printer

e  Scanto printer

USB drive

e  Scanto USB flash drive

Email

Network folder

e  Scanto email (if an email server has been configured). See Configure the email server on page 29.
You can also configure an address book. See LDAP Configure the email address book on page 20

e  Scan to network folder (if a network folder has been added). See Configure a network folder

onpage 21

Scanning

95



4. Insert the original, facing upwards. The front panel will display the live preview of the page. You can stop
the process by pressing the Stop scan button.

5.

% TIP: Torelease the page, you can select automatic release in the quickset settings, or keep the original on
hold until you tap @at the top of the page, or insert a new original.

6.  One of the most useful options is the one to scan a multipage or single-page document.
e  Multipage: The result will be a single file containing all the scanned pages.

When scanning a multipage document, insert the next page when prompted. The panel on the right
side of the screen displays Insert New Page.

OBSERVATION
BOSTS .
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e  Single-page: The result will be a single-page file for each scanned page.

When scanning a single page, the document is automatically saved. If you insert another page, a new
document is created.

OBSERVATION
& )
i

TIFF

Dy

Scan_201_2_195839

[%”r NOTE: By tapping =+« you can show or hide the toolbar, show or hide the background removal setting,
and change the scan settings for the following pages. Change the settings as you like and they will be
applied to the next page scanned.

[’_ﬁ{ NOTE:  With the toolbar buttons you can zoom in and out, and see scanner information about the selected
page. In a multipage document, you can delete a page. You can also choose the predefined zoom modes fit
to screen, original document size, or pinch to zoom.

27 NOTE:  You can edit the scanned page with Edit page.

7.  Exit the scan by tapping Finish for single-page documents, or Finish & Save for multipage documents.

8.  Tap New scan to scan again with the same settings. Tap Job queue to see the status of the scanned jobs.
With USB viewer (only when scanning to USB) you can go to the USB flash drive to confirm that the job is
there and preview it. See Scan gueue on page 85 for how manage the scan jobs.

v

The document has been successfully saved.
It is now safe to remove the USB flash drive.

E IS

ScanQuese | USB

The following settings are available in scan quicksets:
e  Quickset name allows you to name the quickset you are working with.
e Content type allows you to set the content type to Lines, Mixed, or Image.

e  Original paper type allows you to set the content type to White paper, Photo paper, Old/recycled paper,
Translucent paper, Blueprint, or Ammonia/old blueprint.

e  Blueprints invert allows you to invert blueprints.

e  Auto-release original allows you to auto-release the page once scanned.
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Input size allows you to set the input size page to Automatic, Custom size, a list of the available loaded rolls
(Roll width), or a fixed list of standard sizes, by width and length (Standard size).

If you select Custom size, two new settings are displayed:

—  Custom width allows you to set a specific scan area width, or enter 0 (zero) for automatic width
detection.

—  Custom length allows you to set a specific scan area length, of enter 0 (zero) for automatic length
detection.

Orientation allows you to set the page orientation to Landscape or Portrait when Input size is set to Custom
size, or any Standard size except AQ.

Positioning allows you to set the position of the original page in the input size area, when input size is not
automatic. The options are Top-left, Top-center, Top-right, Middle-left, Middle-center, Middle-right,
Bottom-left, Bottom-center, Bottom-right.

For example, if you are scanning an A1 original and the input size is smaller (such as A2), top-left
positioning crops the original page from the top left corner.

If you are scanning an A2 original and the input size is larger (for instance A1), top-left positioning places
the original image in the top-left corner and adds white margins on the right and bottom to create an AT
image.

Scan resolution allows you to set the resolution to 200, 300, 600, or 1200 dpi.

Color options allows you to choose Black and white, Grayscale, or Color.
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Smart & detailed background removal may be used if you have an original with a background that is not
completely white, or an original on translucent paper.

Smart background removal analyses the content of the scanned original and automatically removes the
background to make it pure white without removing the contents (lines and areas). Smart removal is
available only for Lines and Mixed images (content type) in Grayscale (color option). After the scan process
the main window is displayed, go to «e«and select Background removal.

Background removal

Scan_201..9_154928

Detailed background removal allows you to fine-tune the result of the smart background removal when it
is on, or to set @ manual level of background removal when smart removal is off, for any type of original.

You can define these values on a scale of darker to lighter measured in values from -6 to +6. The default

value of both options is zero.

For example, if you are copying an original blueprint (lines with the blue background) and the result of the
smart background removal shows some background noise, you can increase the detailed background
removal (for instance, to +3) in order to remove the background and make it whiter. Keep in mind that the
smart background removal is analyzing each page; so, if you have pages with different backgrounds, it
automatically sets a different removal value for each page.

[%f NOTE: For better results, most original paper types should be inserted with their contents (lines, area

fields, title box) in the first 8.4 cm length of the scanned area.

The ammonia/old blueprint paper type can be inserted from any side because background removal uses a
smart algorithm optimized for originals with a non-uniform or noisy background.

Black enhancement can be used to change dark grays to black.

For example, if you are copying a brochure with a mixture of text and pictures, the text is often digitized to
a color that we may see as black but is really a dark gray. When the printer receives this gray text, it may be
printed with a halftone pattern, meaning scattered dots instead of solid black.

By increasing the black enhancement value, you can force the text to be copied in real black, and it will
therefore appear clearer. Use the black enhancement option with caution, because it can change other dark
colors (not only grays) into black, making small dark spots appear in the picture.

Both black enhancement and background removal function as cutoff values in which pixels under or over a
certain value are affected by the setting. You define these values on a scale of low to high lightness
measured in values from 0 to 255 for the black enhancement and from -6 to +6 for the detailed
background removal.

For example, you have copied an original and want to improve it by making the text blacker and the
background whiter. Adjust the black enhancement value upwards from its default of zero (to 25, for

Scanning
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example) and increase the detailed background removal (to 6, for example), making pixels with low
lightness values go to black and lighter background pixels go to white.

e  De-skew allows you to turn the digital skew correction on or off.

e  Reduce scan speed to enhance quality allows you to reduce the scan speed to get better scan results when
scanning at 200 and 300 dpi.

e  Format allows you to set the file format to Single-page PDF, Multi-page PDF, JPG, Single-page TIFF, Multi-
page TIFF, or PDF/A.

[% NOTE: PDEF file output is available only with the appropriate license. If you have the license, enable the
setting in the front panel: then Scanner preferences > PDF/A.

e  (Compression allows you to set the level of compression.
e  File name prefix allows you to set the file name prefix for the generated file.
e Job storage mode offers two options:

—  Scan and delete: Scanned files are not saved in the scan queue.

—  Scan and store: Scanned files are saved in the scan queue.

Copying
1. Tap @

o P 8 B

Print Scan Copy Job queue
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2. Select an appropriate quickset for your copy job. Any quickset can be modified by tapping &.

Number of copies:

Colate:  Page order:

O First page ontop

@ Lastpage ontop

stacker 5§ 3
olo White paper ke
Mixed content ’ Detaled background removal  ——_S
- +
Topstacker B 200 dp
¥ 22 oo White paper

Copy

3. Youcanselect the number of copies, the page order (first or last page on top), and whether you want
collation.

The right-hand side of the screen shows a representation of how the job will be printed (depending on the
number of copies, collation, order, and the output device).

4. You can change the copy mode by tapping s+, then Choose copy mode.
The copy mode allows you to choose between two ways of printing copy jobs:
e  Send copy job directly to print queue while scanning

—  Print the copy job while scanning the pages (depends on output destination and printing
preferences).

— The copy job takes priority over other jobs in the queue.
—  The option of deleting pages of the copy job is not available.
—  Theinput length is always automatic: you cannot set a manual value.

— If youwant to print an urgent job interrupting the job currently being printed, select Allow copy
to interrupt current print job.

[%f NOTE: When the page order selected does not match the order needed for the output device, or
when collation is activated, the job is sent to the job queue when you tap Finish & Print.

e  Scanall pages, then send to print queue
—  Print the copy job after scanning all pages.
—  Thejob queue continues printing other jobs during the copy job.
—  The option of deleting pages of the copy job is available.

5.  Tap Copy to continue.
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6. Insert the original, facing upwards.

7. Inthe next screen you can see a preview of each copied page and browse the thumbnails.

Copy using: Last settings
Background removal
OBSERVATION
EGSTS. .

Page2

E 1
+
"
f
/
-
P
b2

Cancel ‘ Edit page: ‘Mr;hﬁF'hn[

[%y NOTE: By tapping ««« you can show or hide the toolbar, show or hide the background removal setting,
and change the copy settings for the following pages. Change the settings as you like and they will be
applied to the next page scanned.

9

[ NOTE: With the toolbar buttons, you can zoom in and out, and see scanner information about the
selected page. You can also choose the predefined zoom modes fit to screen or original document size.
When using the Scan all pages, then send to print queue copy mode, you can delete a page.

8.  Tap Finish when there are no more pages to copy.

If you want to change the main settings of the quicksets before starting the copy, you can tap s« and then
select Show quickset details panel.

@ | Copy configuration

Last settings Z Last settings
Number of copies:
& Mixea 22 color Color | = S
White paper Top
B
B8&W lines k. | >

Colate:  Page order:

| Y O First page on top
Save papes

® Last page ontop

pstac £ 300 dpy
. mart background removal
2 Color ) white paper
Mbced content Detaledbackgroundremoval S
- +
Topstacker B8 200 ¢ ‘
olo White paper More sett
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The following settings are available in copy quicksets:
e  Quickset name allows you to name the quickset you are working with.
e C(ontent type allows you to set the content type to Lines, Mixed, or Image.

e  Original paper type allows you to set the content type to White paper, Photo paper, Old/recycled paper,
Translucent paper, Blueprint, or Ammonia/old blueprint.

e  Blueprints invert allows you to invert blueprints (or not).
e  Auto-release original allows you to auto-release the page once scanned.

e Input size allows you to set the input size page to Automatic, Custom size, a list of the available loaded rolls
(Roll width), or a fixed list of standard sizes, by width and length (Standard size).

If you select Custom size, two new settings are displayed:

—  Custom width allows you to set a specific scan area width, or enter 0 (zero) for automatic width
detection.

—  Custom length allows you to set a specific scan area length, of enter 0 (zero) for automatic length
detection.

e  Orientation allows you to set the page orientation to Landscape or Portrait when Input size is set to Custom
size, Roll width, or any Standard size except AO.

e  Positioning allows you to set the position of the original page in the input size area, when input size is not
automatic. The options are Top-left, Top-center, Top-right, Middle-left, Middle-center, Middle-right,
Bottom-left, Bottom-center, Bottom-right.

For example, if you are scanning an A1 original and the input size is smaller (such as A2), top-left
positioning crops the original page from the top left corner.

If you are scanning an A2 original and the input size is larger (for instance A1), top-left positioning places
the original image in the top-left corner and adds white margins on the right and bottom to create an A1
image.

e  Scanresolution allows you to set the resolution to 200, 300, or 600 dpi.

e  Color options allows you to choose Black and white, Grayscale, or Color.
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e  Smart & detailed background removal may be used if you have an original with a background that is not
completely white, or an original on translucent paper.

Smart background removal analyses the content of the scanned original and automatically removes the
background to make it pure white without removing the contents (lines and areas). Smart removal is
available only for Lines and Mixed images (content type) in Grayscale (color option).

Background removal

Scan_201..9_154928

Detailed background removal allows you to fine-tune the result of the smart background removal when it
is on, or to set a manual level of background removal when smart removal is off, for any type of original.
You can define these values on a scale of darker to lighter measured in values from -6 to +6. The default
value of both options is zero.

For example, if you are copying an original blueprint (lines with the blue background) and the result of the
smart background removal shows some background noise, you can increase the detailed background
removal (for instance, to +3) in order to remove the background and make it whiter. Keep in mind that the
smart background removal is analyzing each page; so, if you have pages with different backgrounds, it
automatically sets a different removal value for each page.

[%f’ NOTE: For better results, most original paper types should be inserted with their contents (lines, area
fields, title box) in the first 8.4 cm length of the scanned area.

The ammonia/old blueprint paper type can be inserted from any side because background removal uses a
smart algorithm optimized for ariginals with a non-uniform or noisy background.

e  Black enhancement can be used to change dark grays to black.

For example, if you are copying a brochure with a mixture of text and pictures, the text is often digitized to
a color that we may see as black but is really a dark gray. When the printer receives this gray text, it may be
printed with a halftone pattern, meaning scattered dots instead of solid black.

By increasing the black enhancement value, you can force the text to be copied in real black, and it will
therefore appear clearer. Use the black enhancement option with caution, because it can change other dark
colors (not only grays) into black, making small dark spots appear in the picture.

Both black enhancement and background removal function as cutoff values in which pixels under or over a
certain value are affected by the setting. You define these values on a scale of low to high lightness
measured in values from 0 to 225 for the black enhancement and from -6 to +6 for the detailed
background removal.

For example, you have copied an original and want to improve it by making the text blacker and the
background whiter. Adjust the black enhancement value upwards from its default of zero (to 25, for
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example) and increase the detailed background removal (to 6, for example), making pixels with low
lightness values go to black and lighter background pixels go to white.

e  (ontrast allows you to set the level of contrast.
e  De-skew allows you to turn the digital skew correction on or off.

e  Reduce scan speed to enhance quality allows you to reduce the scan speed to get better scan results when
scanning at 200 and 300 dpi.

e  Print quality allows you to set the print quality to Lines/Fast, Uniform areas, or High detail.
e  Qutput scale allows you to select the output page size.

e  Paper source allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

[%”f NOTE: The printer setting Roll width selection has two values: Print on same width only and Print on
same width or wider. When Print on same width only is selected, each page is printed only on a roll with the
same width as the page.

e  Paper category allows you to change the paper category used for printing.
e Rotation allows you to set the rotation to Automatic, 0°, 90°, 180°, or 270°.
e  Alignment allows you to decide the position of the image on the roll.
e  Copy margins allows you to change the default printer margins.
e Job storage mode offers two options:
—  Print and delete: The job is not retained in the job queue.
—  Print and store: The job is retained in the job queue.
e  Qutput destination allows you to select the paper output from those available to the printer.

e  Folding style allows you to select the folding style when the folder is installed. To use the folder, you must
select Folder in the Qutput destination setting.

Scanner preferences

ENWW

You can select the following settings by tapping , then Scanner preferences.

° Print Scanner 1Q plot see Scanner diagnostic plot on page 116 for details.

e  (alibrate Scanner see Calibrate the scanner on page 173 for details.

e  Load delay allows you to add a delay before the scanner feeds in the original document.

B NOTE:  The minimum delay is 1 second, you can add more if required.

e  PDF/Aallows you to enable the PDF/A format for archiving.

e  Enhanced colors for white papers allows you to capture enhanced colors when the Original paper type is
White paper.
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Scanner troubleshooting

In this section the most common defects and failure modes are shown, sorted by relevance and frequency of
appearance. A defect is a common image artifact that usually appears when using any CIS scanner. These are
due to incorrect settings, product limitations, or easily solvable mistakes. A failure mode is due to malfunctions
of some of the scanner components.

Some of the corrective actions proposed here require the use of the scanner diagnostic plot, which you can print
and scan as indicated in Scanner diagnostic plot on page 116. Do not use any printed version of this guide to test
the scanner, as the resolution of the images included here is insufficient. Use the diagnostic plot when
recommended in response to any of the errors described in this chapter.

You are recommended to clean the CIS sensors at first installation, and at any time for good scanning quality.

Random vertical lines

This is one of the most common issues in sheet-fed scanners. Usually, the vertical streaks are caused by dust
particles inside the scanner, or miscalibration of the scanner (in these cases, the problem can be solved). Here
are some examples of images suffering from vertical lines or streaks. Note the black arrow indicating the
scanning direction in these examples.

Actions

1. Clean the scanner’s glass plate and the original to be scanned as described in Clean the scanner’s glass
plate on page 172. Re-scan your original afterwards.

2. If the streaks remain, recalibrate the scanner as indicated in Calibrate the scanner on page 173. Make sure
you clean the maintenance sheet before calibrating the scanner, and check that the maintenance sheet is
not damaged (if so, call your support representative and ask for a new maintenance sheet). Re-scan your
original after the calibration is completed.

3. If the streaks still remain, check the scanner’s glass plate visually. If it is damaged (scratched or broken),
call your support representative.

4. If the streaks remain, there may be dust particles inside the glass plate. Carefully take out the glass plate
and clean it as described in Clean the scanner’s glass plate on page 172.
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B NOTE: The problem of vertical streaks cannot always be solved, due to the technological limitations of CIS
technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the streaks remain
after the corrective actions explained above, then no further action can be taken to improve the image quality,
except to buy a more expensive CCD scanner.
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Wrinkles or folds

Scanners based on CIS technology have a high optical resolution within their focus plane, at the price of a very
limited depth of field. Hence, the images are sharp and detailed when the scanned original is perfectly flat
against the glass plate. However, whenever the original contains wrinkles or folds, these defects are clearly
visible in the scanned image (as shown in the following example).

Actions

1. Re-scan the original, setting the content type to Image, and contrast and background cleaning to zero.

2. Ifthe problem persists, re-scan the original at a lower scanner resolution (Standard quality if scanning, Fast
or Normal if copying). It may also help to flatten the original manually as much as possible before scanning
it again.

[i?)”f} NOTE: The problem of wrinkles cannot always be solved, due to the technological limitations of CIS technology.
HP offers HD Scanners with CCD technology for higher quality requirements. If the wrinkles remain after the
corrective actions explained above, then no further action can be taken to improve the image quality, except to
buy a more expensive CCD scanner.

Line discontinuities

When scanning or copying large originals, you may sometimes find issues such as that shown in the following
image, where a straight line (it does not necessarily have to be horizontal) appears with discontinuities or small
steps. Note the black arrow indicating the scanning direction in this example.
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Actions

1. Repeat the scan, preferably using a higher resolution, and this time make sure that the product is correctly
positioned (it is flat on the floor and it does not move), and that the printer is not printing while you scan.
Turning the original 90 or 180 degrees and scanning it again may also solve the problem.

2. If the problem persists, check that the original to be scanned is not skewed, and that it does not become
skewed during the scan. If so, see Incorrect paper advance, skew during scanning, or horizontal wrinkles
on page 112. You might also want to deactivate the automatic de-skew algorithm as indicated in Copied or
scanned image is very skewed on page 115.

3. Ifthereis no skew but the problem persists, clean and calibrate the scanner as indicated in Scanner
maintenance on page 171. Take care not to move the printer during the calibration (the printer should not
be printing during scanner calibration), and check that the maintenance sheet is correctly positioned before
starting the calibration. Also check that the maintenance sheet is not damaged before calibrating the
scanner (an old or damaged maintenance sheet may cause this problem); if it is damaged, call your
support representative and ask for a new maintenance sheet.

4. If the problem persists, proceed to analyze the following areas of the diagnostic plot:
a. 4 (frommodule AtoE).
b. 10, at the intersection between modules.
¢. 13 inmodules AandE, and 14 in modules B, C, and D.

If you see any of these defects in the studied areas, call your support representative and report a “line
discontinuities” error after calibration.

1|
|
1

The four vertical thin black lines at the beginning and the end of the diagnostic plot show, approximately, the
position of the intersection between CIS modules, where this kind of error usually appears. If the error appears
outside these areas, call your support representative and report “line discontinuities within a CIS module”.

Small color differences between adjacent CIS modules

When scanning wide plots, sometimes slightly different colors can be seen at both sides of the junction between
two CIS modules. This issue, if present, can be easily seen by analyzing patterns 9 of the diagnostic plot at the
intersection between CIS modules. Here are some examples. Note the black arrow indicating the scanning
direction in these examples.
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Sometimes the color mismatch between adjacent modules can be enormous, showing a serious scanner
malfunction, as in the following example.

Actions
1. Repeat the scan or copy, setting the content type to Image, reducing the background cleaning to 0 or
turning the original 90 degrees before scanning it again.
2. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance on page 171.
If calibration ended without errors, proceed to analyze again pattern number 9 and modules A through E of
the diagnostic plot.
3. After analyzing pattern 9, if you see some color differences between left and right sides of the bars for

neutral and vivid colors, call your support representative and report “small color differences between
adjacent CIS modules”.

Variable line thickness or missing lines

When scanning some CAD plots at Standard resolution, mostly when working with grayscale or black-and-white
prints that contain very thin lines, you may see a variation in line thickness, or even some missing lines, in some
places:
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Actions

1. Repeat the scan or copy using a higher resolution (High or Max if scanning, Normal or Best if copying). You
should also set background cleaning to 2, or set the content type to Mixed. You might also deactivate the
automatic de-skew as explained in Copied or scanned image is very skewed on page 115. In case you were
working in black-and-white mode, we recommend using grayscale instead.

2. If the problem persists, turn the original plot 90 degrees before scanning it again.

3.  If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance on page 171.

Inaccurately reproduced colors

You have to deal with several variables if you want perfect color matching between the original you are scanning
and the copy or scanned file you obtain as a result. If you find undesired colors in cases like the example shown
below (original on the left, scanned image on the right), you can follow these guidelines.

Actions
1. Make sure that you choose the correct paper type in the scan settings before scanning.

2. When dealing with copies, you must take into account that good color matching between a given original
and its copy can be achieved only if both are printed on the same type of paper. In the case of scanned files,
good color matching can be achieved only if your monitor is color-calibrated or compliant with sRGB or
AdobeRGB standards.

3. If the above conditions are met, you should also take into account that various scanner settings can affect
the final color result, such as contrast, background cleaning, content type and paper type. To obtain the
best possible colors, set contrast and background cleaning to 0, set the content type to Image, and select
the most appropriate type of paper according to the original you are scanning (if in doubt, use photo
paper).

4. Note that the image enhancement settings are automatically reset to default values after a certain time, so
you may get a different result from copying the same original if you have not checked the settings before
starting the job.

5. If you scanned to a PDF file, try opening the PDF file in Adobe Acrobat and saving it as a PDF/A file. For more
information, see http://www.adobe.com/products/acrobat/standards.html (English only).
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6.  For optimum color results, clean and calibrate the scanner as indicated in Scanner maintenance
onpage 171.

7. Avoid placing the scanner in direct sunlight or near sources of heat or cold.

Color fringing

The problem called “color fringing” occurs when the scanner is affected by incorrect paper advance and/or
miscalibration. Nevertheless, some amount of color fringing is unavoidable, especially at high scanning speeds. It
can be seen at the borders of sharp black text over a white background, as in the example below (original on the
left, scanned image on the right). Note the black arrow indicating the scanning direction.

e ry

Actions

1.  Repeat the scan after increasing the scanner’s resolution (choose Max quality if scanning, Best if copying).
Turn your original 90 degrees, if possible, before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance on page 171.
Repeat the scan at a high resolution (Max if scanning, Best if copying) and check whether the problem
disappears.

3. If the problem still persists, you can diagnose this issue by analyzing the patterns 6 and 8 (A to E) of the
diagnostic plot. The black horizontal lines appear slightly colored at the top and bottom of each end (in the
example on the right, below). Normally, they look red at the top and blue or green at the bottom, but it
could be the other way around.

I I

I |
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If you see this effect, call your support representative and report “color fringing problem after calibration”.
Vibration

If your printer is not properly placed on a flat surface, or if the scanner lid does not close correctly, you may
sometimes find that the scanned image suffers from vibration, as in the following example: original on the left,
scanned image on the right.
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Make sure that the scanner is placed on a flat surface, the scanner lid is correctly closed, and the printer is
not working while you are scanning. Scan your original again.

If the problem persists, change (increase or decrease) the scanning resolution and re-scan your original.
We also recommend turning the original 90 degrees before scanning it again.

If the problem persists, analyze pattern 4 of the diagnostic plot. If you see the problem shown on the right,
call your support representative and report a “vibration problem”.

Incorrect paper advance, skew during scanning, or horizontal wrinkles

Actions
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You may encounter problems with some thick glossy originals being moved through the scanner’s paper path. In
some cases, the original may become skewed during the scanning process.

If some of the paper rollers are not working correctly, you may find small horizontal wrinkles in the scanned
image, due to the paper being stuck in some regions while not in others.

Turn your original 90 degrees and repeat your scan.

M IMPORTANT: Do not hold the paper while it is being scanned.

If the problem persists, open the scanner lid. Clean the transport wheels (small gray rubber) and the
pressure rolls (wide white plastic). Check that all the pressure rolls can move freely. If you find dust
particles or objects that obstruct the movement of the rollers, try to remove them, then close the scanner
lid and repeat your scan.

If the problem persists, restart the scanner by turning it off and on again. If you find an error message on
the front panel during this operation, call your support representative and report the error message. If no
error message appears, try repeating your scan.
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4. If the problem persists, analyze patterns 4, 13 and 14 of the diagnostic plot. The plot should look like this:

If you see an image resembling the incorrect examples below, call your support representative and report
an “incorrect paper advance” problem.

e RSB e
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Vertical black band 20 cm wide

Your scanner contains various different CIS modules, each of which covers an area 20 cm (7.9 in) wide. If one of
the modules fails, and the scanner hardware check does not detect the failure, you may see a black vertical
band, corresponding to the area covered by a single CIS module, in your scanned image or copy.

Here is an example: original on the left, scan on the right. The black arrow indicates the scanning direction.

Actions

1. Openthe lid of the scanner and check that the five CIS modules show blinking red, green and blue lights

alternately. If a module is failing, call your support representative and report a “CIS module illumination”
error.

2. If all the modules lit up correctly in the previous step, restart the scanner by turning it off and on again. If
you find an error message on the front panel during this operation, call your support representative and
report the error message. If no error message appears, try repeating your scan.

3. If the problem persists, try to calibrate the scanner as indicated in Calibrate the scanner on page 173. If this
operation fails, call your support representative with the error code given on the front panel. If no error
code appears, try to repeat your scan.

4.  If the problem persists, call your support representative and report a “vertical black band 20 cm wide”.
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Scanner damages some originals

HP is aware that this scanner may cause vertical scratches on inkjet originals on thick glossy paper. Very thin
tracing paper or old originals may also be damaged. This is because CIS technology requires the original to be
held down with high pressure to obtain accurate results and avoid blurring and defocus problems.

If the original you intend to scan is valuable, and if it belongs to one of the types described above (inkjet-printed,
thick, glossy original or old/thin/tracing paper original), HP recommends using a CCD scanner such as the HP
DesignJet T1200 HD MFP.

Object replication (ghosting)

This error very rarely appears in CIS scanners. However, you can occasionally find image defects like the
following: original on the left, scanned image on the right.

Image © www.convincingblack.com, reproduced with permission.

Actions

1. Restart your printer. Then calibrate the scanner, as indicated in Calibrate the scanner on page 173, and
repeat your scan. Turn the original 90 degrees if possible before rescanning.

2. If the problem persists, analyze pattern 3, modules A through E, of the diagnostic plot. Call your support
representative and report an “object replication” issue if you see the kind of error shown on the right.

Clipping or incorrect scale factor when down-scaling in copies and prints

When doing copies or prints (from USB, or printer driver), the scaling setting is available with various possible
options. If you are experiencing problems related to border clipping, or it seems that your print has lost the
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scale-factor adjustment, read this section carefully in order to select the best value for the scaling setting in
future jobs.

e  Precise scaling: In this case, the content of the original image is scaled by the percentage factor that you
have selected. For example, in an original CAD image with a 1:100 scale, if user selects scale to 50%, the
printed plot will have an accurate scale of 1:200. Nevertheless, in the case of down-scalings when selecting
a fixed percentage, some clipping of the marginal content of the plot may occur, as it is impossible for the
printer to print up to the borders of the paper.

e  Scale to fit into page size: In this case, the content of the original image is scaled by the percentage
necessary to make sure that all the content is correctly printed and no clipping occurs. Nevertheless, in the
case of down-scalings when selecting fit to page, the scale-factor adjustment may not be an integer divisor
of the original. For example, in an original CAD plot with a 1:100 scale on A2 paper size, if user selects scale
to fit on A3 paper size, the scaling factor will not be exactly 50% and the scale of the printed plot will not be
1:200 exactly. However, the plot will be printed completely without clipping any content.

Incorrect edge detection, mostly when scanning tracing paper

Tracing or translucent papers can be scanned with good results, although totally transparent papers are not
supported. Nevertheless, the resulting image may have extra margins or some clipping of the content in some
situations when detection of the edge of the paper is not accurate, which may also happen when scanning plain
paper if the glass plate is dirty. In order to avoid these undesired effects, follow these recommendations.

Actions

1. Carefully clean the scanner’s glass plate and the original to be scanned with a cloth. Turn the original 90
degrees if possible and re-scan it afterwards. Remember to select Translucent as the paper type at the
scanner if your original is translucent.

2. If the problem persists, calibrate your scanner, and re-scan your original again afterwards.

3. Ifthe problem persists in the case of translucent paper, attach a sheet of white paper to the back of the
original to be scanned. Remember to select White paper as the paper type for the scanner in this case.

Copied or scanned image is very skewed

Originals are often loaded into the scanner with some degree of skew. In order to correct for this unavoidable
problem, the scanner has a built-in automatic de-skew algorithm, which measures the skew in the original and
rotates the scanned image so that the result is perfectly straight. However, in some cases the de-skew
algorithm may increase the skew rather than correcting it. In other cases, the skew is so bad that it cannot be
automatically corrected.

To load the original with minimum skew, grasp the original with the image facing up and your hands at left and
right edges. You are recommended to avoid resting your hands or the original on the scanner's input tray. Push
the original into the scanner insertion slot until you feel the whole top border of the original pressing against the
scanner rubber rolls, which will load the original after a delay of 0.5 seconds. Now you can take your hands off

the original. If you are not happy with the way the scanner has grabbed your original, you can tap E and try
again.

The action of the automatic de-skew algorithm can be deactivated by tapping @ or [g, Select the quickset to
use, then tap more settings and disable the de-skew setting.
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Cannot access the network folder

If you have set up a network folder, but the printer cannot access it, try the following suggestions:

Check that you have filled in each field correctly. See Configure a network folder on page 21.

Check that the printer is connected to the network.
Check that the remote computer is switched on, working normally and connected to the network.
Check that the folder is shared and that you have the correct permissions and functionality use of it.

Check that you can put/read files (depending of the functionality use), to the same folder from a different
computer on the network, using the printer's logon credentials.

Check that the printer and the remote computer are in the same network subnet; if they are not, check that
the network routers are configured to forward the CIFS protocol traffic (also known as Samba).

Scanning to file is slow

Scanning large formats creates large files. This means that scanning to file can take time even under optimal
system configurations and conditions. This is especially true when scanning across a network. However, if you
think scanning to file with your system is unreasonably slow, the following steps may help you to locate and
solve the problem.

1.

Use the front panel to check the status of your scan job. If it is taking an intolerably long time, you can
select the job and then cancel it.

Check that the Resolution setting is right for the job. Not all scanning tasks require high resolutions. If you
lower the resolution, you will speed up the scanning process. For JPEG and PDF scan jobs, you can also
change the Quality setting. Lower quality values produce smaller files.

Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher transfer
rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet configuration, you
can expect slower transfer of the scan data and thus slower scanning speeds.

Contact your network administrator for information about your network configuration, transfer rates, scan-
to-file destinations on the network and possible solutions for increasing the speeds.

If scanning to files on the network is too slow and the network configuration cannot be amended to correct
this, improved speeds can be achieved by scanning to a USB flash drive.

If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility. Your system
supports a Hi-Speed USB interface. Your USB flash drive should be compatible with Hi-Speed USB
(sometimes known as USB 2). Also check that your USB flash drive contains enough storage space for
scanned large-format images.

Scanner diagnostic plot
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Prepare the printer and the paper to print the diagnostic sheet

Turn on your printer and wait until it is functioning. Then select the paper on which the diagnostic plot is going to
be printed (you can reuse the diagnostic plot any time in the future, if it is saved carefully). Ideally, the diagnostic
plot should be printed on glossy paper, and you are highly recommended to do that if you use your printer
mostly for scanning or copying photo originals (posters, pictures printed on glossy paper, etc). If you use your
printer mostly to scan or copy matte originals, then you can use any matte white paper to print the diagnostic
plot. Do not use recycled or tracing paper to print this plot. The size of the diagnostic plotis 610 x 914 mm (24 x
36in). It can be printed on any 914 mm (36 in) landscape or 610 mm (24 in) portrait paper roll. You can also use
a single sheet that is at least 610 x 914 mm (24 x 36in).

Once the correct paper is loaded, if this paper permits color calibration then we recommend color-calibrating the
printer.

, then Scanner Preferences > Scanner IQ plot.

You can print the diagnostic plot from the front panel: tap @

Visual check for errors while printing the diagnostic sheet

Once the diagnostic plot is printed, the first step is to check that all the patterns included in it are correctly
printed. The diagnostic plot, if printed correctly, should look like this:

F T 1t t 1t 3
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If you see any problems, you should follow the recommended recovery procedure, all of which are available by
tapping @ then Scanner Preferences > Print Scanner 1Q Plot at the front panel. Once the printer has been
diagnosed and it is working correctly, you can reprint the diagnostic plot as described in Scanner diagnostic plot
onpage 116.

Scan or copy the diagnostic plot

There are two options for evaluating the diagnostic plot: scanning into a JPEG file, or copying onto paper. We
recommend using the scan option, so that the generated file can be analyzed more easily by a remote support
engineer if necessary. If you decide to scan the plot, first adjust your computer’s monitor. Once you have scanned
the diagnostic plot, remember to open the scanned file in any image viewer software and select a zoom of 100%
for correct visual evaluation of patterns.

If you decide to copy, make sure that a paper roll at least 36 in (314 mm) wide is loaded in the printer. Ideally, the
same type of paper used to print the diagnostic plot should be used for copying it.

These are the settings that you should select:
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Scan
e  Quality: Max
e  Filetype: JPG
e  (ontent type: Image
e  (Compression: medium

e  Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in doubt.

Copy
° Quality: Best

e  (ontent type: Image
e  Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in doubt.

Load the diagnostic plot into the scanner input tray, making sure that the printed side of the plot is facing up. The
black arrows on the diagnostic plot indicate the direction of loading. Make sure that the diagnostic plot is loaded
without skew, and it is centered (that is, it covers the whole scanner area).

Once you have scanned the diagnostic plot (in case you selected the scan option), remember to open the
scanned file in any image viewer software and select a zoom of 100% for correct visual evaluation of patterns.

[%r NOTE: The monitor on which the plot is going to be evaluated should ideally be calibrated.

2993

[&f NOTE: Store the diagnostic plot for future use to save reprints.

Scan from the HP Smart App

You can also scan directly to your mobile device by using the HP Smart App (available for Android and iOS). For
more information, see Print, scan, and share from the HP Smart App on page 81.
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Color management

° Introduction

° How colors are represented

e  Asummary of the color management process

° Color calibration

° Color management from printer drivers

° Color management from the front panel
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Introduction

Color management is performed using a set of software tools that allow you to reproduce a color as accurately
as possible on any display or printing device.

In addition, your printer has been engineered with advanced hardware and software features to ensure
predictable and dependable results.

° Color calibration for consistent colors

e  The Photo Black ink provides pure blacks when printing on photo papers

How colors are represented

Color is usually represented as an array of numbers: three numbers in the RGB color model or four in the CMYK
color model. These numbers are a measure of the base colors used in a mixture to create a given color. RGB
means that we are using a mixture of Red, Green, and Blue to create any specific color. In the case of CMYK, the
mixture is of Cyan, Magenta, Yellow, and Key (where Key means black, for historical reasons).

Most monitors use the RGB color model, while most printers use the CMYK color model.

An image can be converted from one color model to another, but in general the conversion is not perfect. Your
printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors a
little differently from another device, even if they use the same color model. However, color management
software can adjust the colors in animage according to the characteristics of the particular device, using a color
profile of the device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper type that
you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then
(see Color calibration on page 120). In addition, you may wish to calibrate immediately before a particularly
important print job for which color consistency is vital.

2. When printing, select the correct paper preset for the paper type you are using. The paper preset contains
the color profile* as well as various other characteristics of the paper. See Paper presets on page 48.

*A color profile is a description of a printer, ink, and paper combination, that contains all the information required
for these color conversions.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks and paper
type that you are using, and under your particular environmental conditions. After color calibration, you can
expect to get similar prints from any two different printers situated in different geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the
following circumstances:

120 Chapter 9 Color management ENWW



e  Whenever a printhead is replaced

e  Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

e  Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by going to the front panel
and tapping , then <« then o then Color calibration status. The status may be one of the following:

e Recommended: The paper has not been calibrated.

E,?'f NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is reset to
Recommended.

e  Obsolete: The paper has been calibrated, but the calibration is now out of date because a printhead has
been replaced, and should be repeated.

e Done: The paper has been calibrated, and the calibration is up to date.

e Disabled: This paper cannot be calibrated.

[ NOTE:  Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can start color calibration from the front panel: tap , then Color calibration., and press Continue. Choose
the paper and press OK.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of the
type you wish to calibrate—which should be wider than 355 mm (14 in). If you have more than one roll loaded,
the printer will ask which roll you want to use for the calibration.

The process takes about 3—5 minutes and consists of the following steps:

1. Acalibration chart is printed, which contains patches of each ink used in your printer.
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2. Thechartis allowed to dry for a period of time that depends on the paper type, so that the colors have time
to stabilize.

3. Thechartis scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent
color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to
the paper.
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Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you
print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

e  Printer-Managed Colors: In this case your application program sends your image to the printer without any
color conversion, and the printer converts the colors to its own color space. The details of this process
depend on the graphics language that you are using. HP recommends this setting for the best experience
and results.

—  PostScript: The PostScript and PDF interpreter modules perform the color conversion using the
profiles stored in the printer and any additional ICC color profiles sent with the PostScript job. This
kind of color management is done when you are using the PostScript or PDF driver.

—  Non-PostScript (PCL3, CALS/G4): The color management is done using a set of stored color tables. ICC
profiles are not used. This method is somewhat less versatile than the alternatives, but is a little
simpler and faster, and can produce good results with standard HP paper types.

[%”r NOTE: In non-PostScript printing, the printer can convert to sSRGB if you are using Windows, or to
Adobe RGB if you are using Mac 0S X.

e  Application-Managed Colors: In this case your application program must convert the colors of your image
to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC
profile of your printer and paper type.

@ IMPORTANT:  Make sure to select matching settings in the driver and in the application.

You are recommended to consult the HP Support Center (see HP Support Center on page 222) to see how to use
the color management options of your particular application. See also Print a document with the correct colors
on page 129.

To choose between Application-Managed Colors and Printer-Managed Colors:
e  Inthe Windows driver dialog: Select the Color tab.

e Insome applications: You can make this choice in the application.

Color options

Printing in color
The printer prints in color by default.
You can select color printing explicitly in the following ways:
° In your application program: Many programs provide this option.

e Inthe Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section
(whichever is available in your driver). Select Print in color.
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Printing in grayscale

You can convert all colors in your image to shades of gray in the following ways:
e Inyour application program: Many programs provide this option.

e Inthe Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section
(whichever is available in your driver). Select Print in grayscale.

Printing in pure black and white

You can convert all colors in your image to pure black and pure white in the following way:

e Inthe Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section
(whichever is available in your driver). Select Print in pure black and white.

HP Professional PANTONE Emulation

When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK or
RGB approximation to that color. But the application does not take the printer or the paper type into account, it
merely produces a generic approximation of the PANTONE color, which will look different on different printers
and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of the
printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a given
printer using a given paper type. This technology is designed to produce emulations similar to those set up
manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to dois to turn it on. In fact, it is normally on by default.

e Inthe Windows PostScript/PDF driver dialog: Go to the Color tab and select HP Professional PANTONE
Emulation.

e  From the front panel: Tap , then Default printing configuration > Color options > HP Pantone Emulation.

e Inthe Embedded Web Server: From the main menu, select the Color tab.

HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your printer; it
also gives clear information on how close the emulation is to the original spot color.

Default color spaces

ENWW

When a document or image does not specify the working color space in which the content is originally described,
the user can choose among different standards. That is, the user can determine how data should be interpreted
by the color management system during the rendering process.

You can set source profiles in the following ways:
e Inthe Windows PostScript/PDF driver dialog: Select the Color tab, and Printer Managed Colors.

The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the
most common standards for the different devices.

The options are as follows.
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Default RGB source profiles
Your printer is provided with the following color profiles:

e  None (Native): No imitation, for use when the color conversion is done by the application or operating
system, and therefore the data arrive at the printer already color-managed. Available for PostScript and
PDF drivers only.

e sRGBIEC61966-2.1 imitates the characteristics of the average PC monitor. This standard space is endorsed
by many hardware and software manufacturers, and is becoming the default color space for many
scanners, printers and software applications.

e  Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print
production work with a broad range of colors.

e  (olorMatch RGB imitates the native color space of Radius Pressview monitors. This space provides a
smaller gamut alternative to Adobe RGB (1998) for print production work. Available for PostScript and PDF
drivers only.

e  Apple RGB imitates the characteristics of the average Apple monitor, and is used by a variety of desktop
publishing applications. Use this space for files that you plan to display on Apple monitors, or for working
with old desktop publishing files. Available for PostScript and PDF drivers only.

Default CMYK source profiles

You can choose from a selection of CMYK source profiles recognized by the printer. The default CMYK profile is
Coated FOGRA39 (ISO 12647 - 2:2004), available for PostScript drivers only.

Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by tapping [<¥], then Color calibration, then

Continue and choose paper. See Color calibration on page 120.

©)

Color options (they can also be found under Advanced printing preferences).

The other color options in the front panel can all be found by tapping , then Default printing configuration >

Color/Grayscale

e  Printin color
e  Printin grayscale

e  Printin pure black and white

RGB source profile
You can choose from a selection of RGB source profiles recognized by the printer. Default: sSRGB IEC 1966-2.1.

e  Select CMYK source profile: You can choose from a selection of CMYK source profiles recognized by the
printer. Default: Coated FOFRA39 (ISO12647-2:2004).

e  Select rendering intent: You can select the rendering intent. Default: Perceptual.
e  Black point compensation: You can turn black point compensation on or off. Default: On.

° HP Professional PANTONE Emulation: You can turn HP Professional PANTONE Emulation on or off. Default:
On (PostScript and PDF jobs only).

124 Chapter 9 Color management ENWW



10

ENWW

Practical printing examples

° Print a draft for revision with the correct scale

° Print a PDF multipage job from Adobe Acrobat Reader or Adobe Acrobat Pro

° Print a document with the correct colors

° Print a project

° Print a presentation

° Print and scale from Microsoft Office
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Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. Inthe Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check
the page size.

B

File Edit View Window Help

o Reae- | BoaaoH| @b m

V[ en WO @[] 5 G

1] | Bookmarks «B]

P E PR

&
i

I Introduction

[P Paper handling

[P Working with two rolls (T1700dr only)
i Networking

[P Printing

[P Mobile printing

P Job queue management

[P color management

[P practical printing examples

s Retrieving printer usage information
[P Handling ink cartridges and printheads|
[P Maintaining the printer .
I Accessories

[P Troubleshooting paper issues

[P Troubleshooting print-quality issues

i Troubleshooting ink cartridge and
printhead issues

i Troubleshooting general printer issues
[P Front-panel error messages
[P HP Customer Care
[P Printer specifications
w Glossary
[P Index

Tools

@

User Guide

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

[%”f NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button and then select the Paper/Quality tab.

4.  Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom

paper size, click the Custom button.

Custom size

-\l

Units
@) Inches

Size

Width: 8.27 (3.00 - 40.00)

Length: 1169 (5.51-7874.02)

Custom

(e ]

5. Select the Features tab, and then Autorotate.

6.  Click OK, and check that the print preview in the Print dialog box seems correct.
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Print a PDF multipage job from Adobe Acrobat Reader or Adobe
Acrobat Pro

Using a raster driver

1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the
latest version).

2. Click File > Print.
3. Select the printer and driver.

4.  Check the Choose paper source by PDF page size box.

Printer: v Properties Advanced Hep @&
Copies: 1 e [ Print in grayscale (black and white)
pi gray:

Pages to Print Comments & Forms

[CH Document and Markups ~
O Current page

O Pages i 179
» More Options

Summarize Comments

Document: 8.3 x 11.7in

8.27 % 11.69 Inches.
Page Sizing & Handling @

A5 Poster [E] Muttiple [5) Booklet

OFit
@) Actual size
O Shrink oversized pages 7]

() Custom Scale: 100 %

| Choose paper source by PDF page size

Orientation:
(@) Auto portrait/landscape

O Portrait
O Landscape
P (] .
Page 1of 187
Page Setup... Print Cancel

5. Adjust other properties in the driver properties window, as required.
6.  Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Using a PostScript driver

1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the
latest version).

2.  Click File > Print.

3. Select the printer and driver.
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4.  Check the Choose paper source by PDF page size and Use custom paper size when needed boxes.

Printer: || Properties || Advanced Help ®

Copies: 3

[l Print in grayscale (black and white)
[Jsaveink/toner (@

Pages to Print Comments & Forms

® A Document and Markups v
(O Current page

il L Summarize Comments

(OPages  [i-196

Document: 8.3x 11.7in
8.28 % 11.7 Inches

¥ More Options

Page Sizing & Handling (1)

Size Poster Multiple Booklet

OFit
(®) Actual size
Shrink oversized pages
pag

O Custom Scales ~ [100 % e

[ Choose paper source by PDF page size
Use custom paper size when needed

S

Ornentation:

(® Auto portrait/landscape
(O Portrait

(O Landscape

Page 1 of 204

Page Setup... Cancel

5. Adjust other properties in the driver properties window, as required.
6.  Click the Print button.

If you checked the Use custom paper size when needed box, the pages will be printed on paper sizes
corresponding to the page sizes in the original document.

Using a PDF driver

With the latest versions of Adobe Acrobat Pro or Adobe Acrobat Reader, this is managed by the application, and
the pages will be printed on paper sizes corresponding to the page sizes in the original document.

Printer: v|[ Properties Advanced Help @

copesl =

Osaveinkitoner (@

Pages to Print Comments & Forms
| @an Document and Markups -
| O current page

Summarize Comments
| O Pages i - 196

» More Options
Page Sizing & Handling (1)
Size Poster
Fit

Actual size

Shrink oversized pages
Custom Scale 100

Choose paper source by PDF page size

Orientation:

Auto portrait/landscape

Multiple

Booklet

Scale: 95%
8.27x%11.69 Inches

(®) Portrait
O Landscape
il :
Page 1 of 204
Page Setup... Print Cancel
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Print a document with the correct colors

This section demonstrates how to print a document from Adobe Acrobat and Adobe Photoshop, with the
emphasis on color management.

Using Adobe Acrobat Reader

Acrobat Reader is the most basic application for PDF files; several color management tools common in more
sophisticated applications are not explicitly present, and work by default with presets that cannot be changed.
For example, there is no way to select a working color space; a default color space, most likely sRGB, is applied.
This color space is used for screen display, for example. Also, as an alternative color profile when no other is
specified by a file, as will be explained later.

The printing process is very simple.
1.  Click File > Print.

2. Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver settings can
be adjusted by clicking the Properties button.

T HP Designlet Printer Series Use
File Edit View Window Help

Do | Q8 2@ ES]=]
]

vllem o® =58 0@

| Printer: | HP Designlet T1700dr v| Properties el Hep @

Copies: |1 = [1Print in grayscale (black and white)

Pages ta Print Comments & Forms

@an Document and Markups -
(O Current page
Opages  [i-167
* More Options

Summarize Comments

Scale: 97%

827 %1169 Inches
Page Sizing & Handiing @®

B Poster [E] muttipie [5) Bookiet

@ Fit
() Actual size
() Shrink oversized pages

(O Custom Scale: 100 %

[ Choose paper source by PDF page size

Orientation:

() Auto portrait/landscape
@) Portrait

O Landscape

Page 1 of 175

Page Setup... | Print Cancel
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3.

Adjust the color settings in the driver properties window. Click the Properties button in the Print dialog and

set the Color option in the Color tab. Check the box Printer Managed Colors and, if you have a V4 driver,
select the most convenient source profile. Click OK.

Printer .-
Copies: |1 =
Pages to Print

Al

() Cusmrent page

Opages [0
» More Options
Page Sizing & Handling [
[ size 3 Pester
CFi
- .

PaperGuakly LayoutOupdt Color  Joh Storsge  Services  Advanced

Cuick stz
Factary defaults
Color Optors

@ Printin color
CIPrintin grayscale
(Pt in pure black and white

Color mansgesent:
() Apphcation managed colors
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[5] Beokiet |

it m kil

[Printin grayscale (black and white)
Comments & Forms
Dacurnent and Markups
Semmarnize Camments
Decument: 83 11.7in
82727160 Inches

Fage 1 of 175

Print
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4,

If you have a V3 driver, click the Advanced button in the Print dialog box to set color management options.
Check the box Let printer determine colors.

Printer: HP Designlet T1700dr
Copies: 1 =
Pages to Print

@ AN
(O Current page

() Pages i - 167

» More Options

Page Sizing & Handling @

e

@ Fit
O Actual size
() Shrink oversized pages

[[] Choose paper source by PDF page !

() Custom Scale:

Orientation:
(O Auto portrait/landscape
(®) Portrait

() Landscape

Page Setup...

w Properties

[1Print in grayscale (black and white)

PostScript Options

Send by Range

Jownload Asian Fonts

[ Discolared background correction

Color Management

[] Let printer determine colors

[IPrint As Image
[[] Simulate Overprinting
[]Print to File

OK

£
¢

-3 w

ments

VInches

Page10of 175

Print Cancel

If the document contains several color profiles and you are not sure what the result will be, you can flatten
the document first and print it as seen on the screen. To do this, check the box Print As Image in the
Advanced Print Setup dialog box. In this case, the rasterization is performed by Acrobat Reader before
calling the driver; whereas, if you do not check this box, the rasterization is performed by the driver. So
checking the box may have a visible effect on the look of the printed document.

Using Adobe Acrobat Pro

Acrobat Pro is a professional application that allows full color management. This section briefly describes the
options to select a working color space, convert images to a desired color space, and print.

ENWW

1.

PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working color
space by default. To choose a working color space, first click Edit > Preferences.
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m HP Designlet T1700 Printer Series User Guide - Adobe Acrobat Pro

File JETY View Window Help
E' Undo Ctrl+Z ) @ @

okl

|
&

= Redo Shift+Ctri+Z
Cut Ctri+X 8]
I_I;l Copy Ctrl+C
Paste Ctri+V
[:P Delete
Select All Ctrl+A
(f Deselect All Shift+Ctrl+A
i Copy File to Clipboard i

Edit Text & Images

Take a Snapshot

Check Spelling »
Look Up Selected Word...
(), Find Ctrl+F
Advanced Search Shift+ Ctrl+F
HP Desir
I nlation I -
g Handling ink cartridges and printheads|
g Maintaining the printer U Cuid
Ser Lul

[T Accessories

P Troubleshooting paper issues

2. Inthe Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

Preferences X

Categories: Color Setup

Commenting ~ Synchronized: Your Creative Suite applications are synchronized using the same color settings for consistent color management.
Docurments @

Full Screen

General Settings: | North America General Purpose 2 v
Page Display

Working Spaces

3D & Multimedia

Accessibility RGB: | sRGB IEC61966-2.1 v
Action Wizard

Adobe Online Services CMYK: | U.S. Web Coated (SWOP) v2 v
Catalog

Color Management Grayscale: | Dot Gain 20% >
Content Editing

Convert From PDF Conversion Options

Convert To PDF

Email Accounts Engine: | Adobe (ACE) o

Forms

Identity Use black point compensation

Internet

JavaScript Description

Language

Measuring (2D}
Measuring (3D
Measuring (Geo)
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

0K Cancel
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PDF files can contain elements with different color profiles. Some may have color profiles, some may not.
The working color space will affect only those without a color profile. If you want to attach a specific color
profile to the document, you must convert the contents of the document as follows. First, select Convert
Colors from View > Tools > Print Production or by clicking the icon in the status bar.

Zoom

» Content Editing

| Tr— D _ oz
e et [ oo i E
D) opg Fotutetiew CRENEd=RR- RN A r Wr ] customize ~ | [
Page Navigation > L
#| pageDisplay s IR =] Tools | Fill&Sign | Comment
» -
v

Taol Sets
» Pages

Content Editing

Fill & Sign Pages + Interactive Objects

Comment }| Interactive Objects » Farms
Show/Hide »| Eoms » Action Wizard
| Read Mode Gy | A » Text Recognition
= Text Recognition :
) Eull Screen Mode CtelsL % » Protection
Protection

[ Tracker.. e ~ Print Production

Rezd Out Loud
Compare Documents... JayaScript
Accessibility
Analyze

@

& Preflight

T4 Output Preview

MR eait Object

[®] Flettener Preview

[IW) Convert Colors

More Production

[Bf setPage Boxes
[8) Ada printer Marks
(& FxHoirlines

& InkMonager
Trap Presets

¥ Acrobat Distller

User Guide

Select the elements you want to convert by specifying matching criteria (object type and/or color type) and
then the conversion attributes. If you want to change the embedded color profile, you can select Any Object
and Any Colorspace in the Matching Criteria section. In the Conversion Attributes section you can choose,
for example, to embed an Adobe RGB (1998) profile by selecting it as the Conversion Profile, checking the
Embed box, clicking the OK button, and saving the file to keep the changes. The saved file will have an
embedded Adobe RGB color profile.

Cenversion Commands Document Colors

Any Object, Any Colorspace, Convert to Profile il Add @
Move Down Delete
Save Commands Load Commands
Matching Criteria Conversion Attributes
Object Type: Any Object v Convert Command: Convert to Profile v
ColorType: | Any Colorspace - T T ‘Adobe RGB (1998) | HEmbed
Minimurn Text Size: Rendering Intent: Use Document Intent .
Output Intent
Convert Colors to Output Intent Profile | US. Web Coated (SWOP) v2
Convert Options
[ Preserve Black [Promote Gray to CMVK Black [Preserve CMVK Primaries
Convert Pages
@Al O Current Page Ofrom: |1 T [i
oK Cancel

Ink Manager

To print the document, choose a printer from the Print dialog box, click the Properties button, and set the
color options in the Color tab.

@9 IMPORTANT:  Select Print in color and Printer managed colors.
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If you use the V4 driver, you can also select a default color profile, which will be used for any elements that
lack a color profile. HP suggests:

e  SRGB or Adobe RGB (sRGB is the standard for most files)
° CMYK: Choose Coated FOGRA39 or US Web Coated (SWOP) v2.

=

I Hep @
Paper/Quality Layout/Output  Color  Job Storage  Services  Advanced
Quick sets:
Factory defauits ~ Save Delete

|
{
{  Color Options
{

@) Printin color

O Printin grayscale
(O Printin pure black and white

Color management:
(O Application managed colors

(@) Printer managed colors

DT series

17
I b
QD el t Cancel

oK Cancel

134 Chapter 10 Practical printing examples ENWW



6.

7.

If you have a V3 driver, click the Advanced button in the Print dialog box, set Color Handling to Printer Color
Management, and click OK.

Printer: HP Designlet T1700dr

Copies: [T =

Pages to Print
@Al
() Current page

Print in grayscale (black and white)

Comments & Forms

Document and Markups

Summarize Comments

OPages || Advanced Print Setup

» More Optiont

Page Sizing & H
Size

@ Fit
(O Actual size
O Shrink oversizf

(O Custom Scale:
[ Choose paper
Orientation:

(@) Auto portrait/|

() Portrait
O Landscape

Page Setup...

Settings: | Custom

Printer:  HP Designlet T1700dr

~ Delete Save As

[]Print ta File Print As Image

Color Management

Color Handling: | Printer Color Management

Output
Marks and Bleeds
PostScript Options

Eu Urganagement |

(oo

o e

Color Profile:

Output Color:  Composite
Treat grays as K-only grays
Preserve Black
Preserve CMYK Primarics

Apply output preview settings

In the Print dialog box, click the Print button to print the document.

Using Adobe Photoshop

ENWW

1.

In Photoshop, click File > Print, then select your printer.
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2.

3.

In the Color Management section, set the Color Handling option to Printer Manages Colors.

Printer Setup
Printer: ‘ ~

Copies: Print Settings...
Layout: [g] [&)

¥ Color Management ~

Remember to enable the printer’s color
management in the print settings dialog box.

Color Handling: ‘ Printer Manages Colors Vl

Printer Profile:  sGray

Mormal Printing
Rendering Intent: | Perceptual w

Black Point Compensation

¥ Description

¥ Position and Size
Paosition

Clcenter 1op:[7e1 ] 1o 255 ]

v
Sralad Drint Siza

Match Print Colors Gamut Warning Show Paper White
Gnce | [ oong

In the driver’s Color tab, ensure that the color management option is Printer managed colors. This is the

correct option because you have already selected Printer Manages Colors in Photoshop.

Print a project

This section demonstrates how to print a project from AutoCAD.

Using Autodesk AutoCAD

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.
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EREN 50|~ Tvpe a command

2. Click the Plot icon at the top of the window.

nnotate  Parametric  Vie [ e Output

+ Move () Rotate +~ Trim - &

&- %§c M Fillet ~

Line Polyline Circle  Arc ' Copy k. Mimor et - ol

¥ © 8§ - R stech @lScale 5 Amay -
Modify ~

ving! Drawing2*

3. The Plot window opens.
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You can see further options by clicking the circular button in the lower right corner of the window.

A
Page setup
Mame: <None>

Printer plotter

Name:

Properties...

Flotter:
Where: File

Desaription:

Plot to file

Paper size Number of copies

ANSI expand A (8.50 x 11.00 Inches)

~ 1 =
Plotarea Plot scale
What to plot: Fit to paper
Extents v
Scale: |Custom
Plot offset (origin set to printable area) 1 inches  ~ =

¥ | 1175375 |inches [ Center the plot
0.000000 | inch Scale lineweights

Preview. .. Apply to Layout Cancel Help

[%’ NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD
viewport objects that are sent for printing.

3159

5. Select your printer and click the Properties button.

6.  Select the Device and Document Settings tab, and click the Custom Properties button.

A
Page setup
Name: <None> hd Add,.
Printer fplotter =]
Name: & HP Design
Gereral Pots  Device and Document Settings
Plotter: HP Designlet T}

Where: EMEA/Barcelong © HP Designlet T1700c
g7 Media

7.

Description: [0\ Source and Size <Size: Oversize: Latter [portrait]>
£ Medis Destination <Defaulty
[IFiot to file Graphics
8, Custom Propertiss
Paper size [e.? User-defined Paper Sizss & Calibration

Oversize: Letter {portrait)

Plotarea
What to plot:
Extents ~

Plot offset (origin set to printa

1.175375 inches
y: |0.000000 inch

Preview... Apply to

X

Custom Paper Sizes
Modify Standard Paper Sizes [Printabls dres)
Fiter Paper Sizes
Plotter Caibration

= PMP File Name <None>

Access Custom Dislog

Press the following button to access the
device diver-specific user-interface.

=

Custom Properties...

Import Save s Defauls

oK Cancel Help

In the Paper/Quality or Paper tab, select the paper type that you intend to use.

Ej?qy NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected
roll (see Protect a paper type on page 77).

8.  Select the print quality (your own choice between speed and quality of printing).

9. Ifyouintend to print on roll paper, you must decide where the printer should cut the paper.
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e  With a Windows V3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, and
select Clip content by margins.

e  With a Windows V4 driver: Click the Layout tab; then, in the Layout Mode area, select With margins >
Clip content by margins.

You can also adjust the crop lines, which indicated where to cut the paper after printing.

Layout and margins: @ (@] (@]

Use application settings Clip contents by margins Oversize

Respect settings defined previously | Content within printer marginnot | Add the printer margin on four
in application printed document edges

Preserve paper size -

Eray Horizontal cutter
Adjust [JRemove blank areas
[] Draw cutting lines

OK Cancel

10. Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid wasting
paper.

11. Click the OK button and save your configuration changes to a PC3 file.

Using clip contents by margins

You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with margins >
Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you
have selected. The printer will use the white border for its margins and you will get a page of size equal to that
which is selected in the driver.

Print a presentation

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using Autodesk AutoCAD

1. Openthe AutoCAD file and select a layout.
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SN 5Tl - Tupe a command

2. Click the Plot icon at the top of the window.

ate  Parametric  View Manage  Output
W - ¢ Move () Rotat Tim - <
@ - %C Mi et - 4
Line Polyiine Circle  Arc % Copy ik Mirror B oG
- - [® - B\ Suetch @Y Scale B Amay - £k

Draw ~ Medify ~

Drawing1 Drawing2*

3. Ensure that the correct printer is selected, then click the Properties button.
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Select the Device and Document Settings tab, and click the Custom Properties button.

A

Page setup

Name: <None > hd Add...
Printerjplotter =]

Name: S HP Design

General Pots  Device and Document Settings

Flotter: HP Designlet T!

Where: EMEA Barcelonz & HF Desianlet T1700d

-7 Media
Desaription: L), Source and Size <Size: Dversize: Letier (portrait)>
-7 Media Destination <Default>
Clpiot to fle - [ Graphics
€4 Custam Properties
Paper size g é User-defined Paper Sizes & Calibration

Custom Paper Sizes
Muodify Standard Paper Sizes [Frintable Area)
Filter Paper Sizes
Flotter Calibration
= PMP File Name <Mone>

Oversize: Letter (portrait)

Plotarea
What to plot:

Extents

> Access Custom Dialog

&

Press the following button to access the

Plot offset (origin set to printa device driver-specific user-intarface.

1.175375 inches
0.000000 inch

Apply to

X

5 Custom Propetties

Preview...

Import... Save &s.. Defaults

ak Cancel Help

5. Inthe Paper/Quality tab, select the paper type that you intend to use.

[7_5”1’ NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected
roll (see Protect a paper type on page 77).

6.  Select the print quality (your own choice between speed and quality of printing).
7. If youintend to print on roll paper, you must decide where the printer should cut the paper.
e With a Windows V3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, and
select Clip content by margins.
e  With a Windows V4 driver: Click the Layout tab; then, in the Layout Mode area, select With margins >
Clip content by margins.
Layout and margins: @ O 0
Use application settings Clip contents by margins Oversize
Respect settings defined previously | Content within printer margin not Add the printer margin on four
in application printed document edges
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, e |
________ Preservescale| | _________|________ ‘Y _______|_______ T _______|
Cutter Horizontal cutter
Adjust [JRemove blank areas
[ oraw cutting lines
oK Cancel
8.  Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid wasting
paper.
9.  (Click the OK button and save your configuration changes to a PC3 file.
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Using Adobe Photoshop
1. InPhotoshop, click File > Print and then select your printer.

2. Click Print settings, then select the Paper/quality tab.

Printer Setup
Printer: | HP Designlet T1700dr 3

Copies: - Print Settings... |
Layout: Ej

¥ Color Management )

Remember to enable the printer’s color
management in the print settings dialog box.

L Racumant Nofile: Untagged RGB

L]

a: \ Printer Manages Colors i
Paper/Quality ) ayout/Output Color  Job Storage  Services Advanced le: [ CiE RGR -
Quick sets:
Printing *
Factory defaults v save Delete

ntent: | Relative Colorimetric  *

Paper Options .
per Op int Compensation

Document size:

A4 v/ custom...

Margins/Cutter: Settings...

| cancel | | pone | | Print

Layout Options: Use application settings, Horizontal
cutter

# | currently loaded paper:

Roll 1: Plain paper, 1066.80 mm

Single sheet: Not loaded Print Quality
(® standard options
Paper source: speed Qualty
‘ Use printer settings o ‘
(D) Custom options Settings...
Paper type:
‘ Use printer setings V‘ Rendering resolution {ppi): 600
Printing resolution (dpi): Automatic
@ telp
oK Cancel

3. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, click the Custom button. Enter the width, the length
and the name of your custom paper size. Click the Save and OK buttons.

" custom size —— (2 oS

Units
@ Inches

Millmeters
Size
Width: 8.27 (3.00-40.00)
Length: 11.69 (5.51-7874.02)

Name

Custom

==

4.  Select Show preview before printing. You may also wish to change the default paper source, paper type
and print quality.

5. Inthe Color tab, the default color management option is Printer managed colors, and this is the correct
option because you have already selected Printer Manages Colors in Photoshop.
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Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office 2013.

Using Microsoft PowerPoint

1.  Click File > Print, and select the name of your printer.

Save As

Save as Adobe
PDF

Print

Share

Export

Close

Account

Options

Feedback

Print
IE# Copies: | 1

Print

Printer

HP Designlet T1700dr
'% Offline: 1 document waitiny

g

Printer Properties

Settings
=

Print All Slides

Print entire presentation

Full Page Slides
Print 1 slide per page

Collated
123 123 123

Color

Edit Header &

Footer

2. Click Printer properties > Layout/Output > Resizing options to scale the document to a particular size.

3. Select the Paper/Quality tab, then select Paper Source and Paper Type.

4.  To clip contents by margins:

Layout and cutter options

ENWW

With a Windows V3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, and
select Clip content by margins.

With a Windows V4 driver: Click the Layout tab; then, in the Layout Mode area, select With margins >
Clip content by margins.

Layout and margins:

O]

@]

o]

Use application settings

Respect settings defined previously
in application

Preserve paper size -

Clip contents by margins

Content within printer margin not
printed

Oversize

dd the printer margin on four
document edges

L [ ]
x ,,,,,,,,,
v v
x v
s x

Cutter

Adjust

Horizontal cutter
[JRemove blank areas
[] Draw cutting lines

OK Cancel
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Using Microsoft Project
1. Click File > Print.

2. Select your printer's name.

3. Inthe Settings section, you can choose the pages to print, the orientation, and the paper size.

©

New Copies: |1 =

Open

Print
Save
Save As Printer

HP Designlet T1700dr
Save as Adobe ‘3 9

PDF

Ready

Printer Properties
Print

Settings
Share [f= PrintEntire Project
‘E Print the project from start to finish
Export
Dates: [10/31/2017 ~| to [1/22/2018 -
=Y Landscape Orentation -
Account
D A4
Dptoes 827" x11.69"
Page Setup

4.  Click Page Setup to choose the Paper Size you want.

Page Setup - Gantt Chart ? %

Page | Margins | Header| Footer | Legend| view |

Orientation
O Portrait (® Landscape
Scaling

@ adjustto: [ 100 |5 % nomal size
O Fitto: |1 2 pageswide by |1 = tall

Other

Paper Size: [ A4 -

First page number: | Auto

sintriee]| [ gptons.. | [ gt conce
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5.

Select Options to go to the printer driver.

Page | Margins | Header| Footer | Legend| view |

QOrientation

() Portrait (@) Landscape

Scaling

@ Adjustte: | 100 |5 % normal size
OFitte: 1

Other

Paper Sige: | M

Figst page number: | Auto

Print Preview... Print... ok

Cancel

The default options in the Paper/Quality tab are probably suitable: Paper source: Use printer settings and

Paper Type: Use Printer Settings.

Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you can

scale the document in Project.
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Using Microsoft Excel

1. Click File > Print. Select your printer's name, then click the back arrow to leave the File menu.

2. Select the Page Layout tab, then Size, and choose the paper size you want.

Pagelayout | Formulas  Data  Review  View

=l
= =l &
gms Orlentatmn Slze Prmt Ereaks Background  Print

a2z 4]
42 cm x 59.4 cm

fe

ARCHA
22,86 cm x 30 48 cm

ARCHB
3048 cmx 4572 cm

TR

ARCHC
45.72 cm x 50,96 cm

ARCHD
80.96 cm x91.44 cm

ARCHE
91.44 cmx121.92 cm

ARCH E1
76.2 cm x 106 .68 cm

ARCH E2
86.04 cm x96.52 cm

ARCH E3
68.58 ¢cm x99.06 cm

Al

594 cmx841 cm
AD

84.1 cm x 118,88 cm

A5_IP
148 cmx 21 cm

More Paper Sizes...

itles
(]

3. Click File > Print > Printer properties to go to the printer driver. In the Paper/Quality tab, select Paper
source, Paper Type and Print Quality.

4.  Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you can

scale the document in Ex

cel.
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11 Retrieving printer usage information

Get printer accounting information

There are different ways of getting accounting information from your printer.

e  View printer usage statistics for the whole lifetime of the printer, see Check usage statistics on page 147.

e Viewink and paper usage for each of your recent jobs, see Check usage statistics for a job on page 150.

e  Use athird-party application to request printer status, printer usage or job accounting data from the printer
through the Internet. The printer provides data in XML to the application whenever requested. HP provides
a Software Development Kit to facilitate the development of such applications.

Check usage statistics

Check usage from the front panel

Tap @ on the front panel to display the usage information.

o ‘ Print categories usage
=)
=]
Print categories usage
(g
G Ink (ml) Paper area (m?) Paper length (m)
0.00 1.67 1.82
0.00 0.00 0.00
0.00 723 7.87
Gy 4802.50 3428 37.40
image
Frermm 0.00 0.00 0.00
quality image
Blueprint 0.00 0.00 0.00
TOTAL 4802.50 43.18 47.09
Print usage report

The following information can be retrieved:

e Inthe tab Print categories usage, you can see the ink, paper area, and paper length usage divided into
categories:
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—  Mono lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with less
than 1% of color pixel coverage

—  Color lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with more
than 1% of color pixel coverage

—  Low density image: Between 10% and 50% of non-white pixel coverage printed on standard paper
—  High density image: Over 50% of non-white pixel coverage printed on standard paper
- Premium quality image: Any content type printed on premium paper
—  Blueprint: Any content type printed on blueprint paper
e  Scanusage: The copy and scan usage in m2, and the total amount:

far | Scanusage

=
=

s

@

Scan usage
TOTAL 32.75m? 51.92m
32,63 m? 5143 m
Scan 0.12m? 048 m

e Inkusage: The ink consumed by each cartridge in ml, and the total amount of ink consumed.

fa | Scanusage

=
(4

@ Ink usage

TOTAL 5323.44ml

1466.39
155561
567.43
761.54
750.22
222.23

Print usage report
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e  Paper usage: Amount of paper used and the total at the top, divided into paper categories or families.
Usage can be seen at each level.

far | Paperusage

%-[ LT i

Paper usage
TOTAL 5.21 m? 47.02m
Deleted paper 0.02 m? 41.38m
Bond and Coated Paper 5.18 m? 5.64m

Print usage report

When you tap the Print usage report button, a message is displayed: The usage report was sent to the job queue

and will be printed soon.

All the values can be displayed in English or metric units.

Print the usage information

There are two different ways to print the usage information from the front panel’'s home screen:

e Tap to launch the usage information screen, then tap the Print usage report button.

° , then Internal prints > User information prints > Print usage report.

Check usage from the Embedded Web Server
The same information can be retrieved from the Embedded Web Server as from the front panel.

1. Access the Embedded Web Server, see Embedded Web Server on page 15.

2. Inthe menu at the side, click Usage.
The usage page shows all the printer usage information separated into various tables:
e  Summary: The total ink usage and the total paper usage (in units of area and length).

e  Print categories usage: The ink and paper usage and the number or pages printed for the different print
categories (content type, such as mono lines, color lines, premium quality image, blueprint paper). This
table information is shown only if the Show application categories printer setting is enabled. There are
further conditions depending on the following settings:

—  The paper printed usage is shown if the Paper area used and paper area printed setting is enabled.

—  The blueprint category is shown if the Enable the blueprint category setting is enabled.
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—  The premium quality image category is only shown if the Enable the premium quality image category

setting is enabled.

—  If the printed-paper column information is shown, the paper area used field changes the string to

"Paper area (m2 used)". Otherwise, the string shown is "Paper area (m?)".

e Inkusage: The ink usage for the whole life of the printer (with approximate values). The ink consumption

table lists the ink consumed in each color, ignoring the product number of the cartridge.

e  Paper usage: All the papers that have been used throughout the life of the printer.

Check usage statistics for a job

EY NOTE: The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 15.

2. Inthe menu at the side, click Usage > Accounting.

The accounting page shows a table of the latest printed jobs, with the following information per job (not per

page):

e  Name: The name of the job

The job name is shown only if the Show user name and job name in job accounting setting is enabled for

users under Security > Security settings.

{4 Home 2
Mass storage

Job queus

USB drives
{y Ink v
@ Paper N Protect stored data
[ Usage ~

Secure file erase mode
0, Security ~

Disk wipe
Administrator password

Security settings
Printer settings

Access Control

@ About printer ~ in job accounting

Network ~

@ Support ~

~

e  Number: The number of the job

e Time: The date and time when the job was completed

e  User: The name entered by the person who submitted the job (this item is present only if the

corresponding security setting is enabled)

Show user name and job name

Anonymous usage information

The user name is shown only if the Show user name and job name in job accounting setting is enabled for

users under Security > Security settings.
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e  Type: The type of job (print)

e  Source: The source of the job: USB, network, and so on

e  Print quality: The print quality used to print the job

e  (Copies: The number of copies requested (cumulative after reprints)
e  Pages: The number of pages completed

e  Status: The status of the job: printed, canceled by user, and so on
e Total cost: The total cost of the job (visible if cost assignment is enabled)
e  Paper type: The paper type used for the job

e  Paper area: The used paper area of the job

e  Paper length: The used paper length of the job

e Inkused: The volume of ink consumed by the job

Ajobis considered completed when all its pages have been printed, or canceled by the user, or canceled by the
printer itself. An ongoing job (waiting for printing, being printed, being canceled, on hold for preview, and so on)
will not appear on this list.

You can filter the jobs shown on the accounting page by using a drop-down control available on the same page.
This control just changes the view, the job accounting information is not deleted in the printer. Essentially, this
page will report the last N jobs (or fewer if there are not enough completed jobs), where N is the value of this
configuration parameter. By default, Nis 10.

Two buttons appear in the accounting table:
e  Help: This button opens a window displaying help information.

e  Export to CSV: This button opens a window with a progress bar, and generates and downloads a CSV file.
The downloaded file contains similar information to the accounting page, in CSV format. If the cost
assignment is enabled, the CSV displays more detailed information about the cost of the job.

Check cost assignment

Bf NOTE: The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 15.

2. Go to the Main tab.
3. (Click Usage > Cost assignment configuration.

The cost assignment page allows you to enable or disable the cost assignment setting, using the checkbox next
to Enable accounting assignment configuration at the top of the page. If the setting is enabled, you can insert or
modify the cost of the following sections.

[:?’”f} NOTE: At least one of these sections must be enabled in order to save the configuration.

° Units
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—  Currency: Enter any three-letter currency code.
—  Paper usage: Select the units, English or metric.

e  Print categories cost: Can be enabled or disabled. When enabled, you can assign a cost to each category,
and select the units of the cost (per millimeter, or the option selected in the previous Units section). The
cost is a number with two decimal digits of precision. Disabled categories are displayed grayed out.

e Inkusage cost: Can be enabled or disabled. Allows you to apply a cost to ink usage, and displays the
available inks with a field to indicate the cost.

e  Paper usage cost: Can be enabled or disabled. Allows you to apply a cost to the papers displayed. You can
add papers from the list of supported papers. The costs can be removed or edited; they cannot be empty,
but may be 0 (zero). The units selection is the same as for print categories.

e  Fixed cost: Can be enabled or disabled. Allows you to add a fixed cost to all print, scan, and copy jobs.

Enabling the cost assignment setting causes the total cost column to appear in the accounting information, and
detailed information is added to the exported CSV.
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12 Handling ink cartridges and printhead

e  About theink cartridges

° Check the ink cartridges status

° Remove anink cartridge

° Insert an ink cartridge

e  About the printhead

° Check the printhead status

° Remove the printhead

° Insert the printhead

e  Storage of anonymous usage information

e  Safe mode
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About the ink cartridges

Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper. To
purchase additional cartridges, see Supplies and accessories on page 175.

A CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the
Glossary on page 230). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, tap @ then tap the cartridge that you want information on. There is

a Replace ink cartridges option on the ink information page in case you want to do so (see also Remove an ink
cartridge on page 154).

To get more information on your ink cartridges, you can press the color of the cartridge on which you want
information.

You can also get this information from the HP Utility or Embedded Web Server.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 212.

HP Utility procedure

e Inthe HP DesignJet Utility for Windows, go to the Overview tab, each cartridge's status is under Supplies
Status > Cartridges.

e Inthe HP Utility for Mac 0S X, select Supplies Status in the Information group.

Remove an ink cartridge

There are three occasions when you need to remove an ink cartridge.

e Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can
use up the remaining ink in the first cartridge at a more convenient time).

e  Theink cartridge is empty or faulty, and you must replace it to continue printing.

e  You want to replace the printhead, and there is not enough ink left in the ink cartridge to complete the
printhead replacement process. In this case, if the cartridge is not empty you can use it again later.

A CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION:  Remove an ink cartridge only if you are ready to insert another one.

CAUTION:  Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

[*_'%f“ NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you cancel it
manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing the
cartridge, you may see some banding on the print.

1. From the front panel, press @ then Replace.
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2. Opentheink cartridge cover on the left- or right-hand side of the printer.

3. Grip the cartridge you wish to remove.

4.  Pull the cartridge straight up.

@ NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink on the
connection.

@’ NOTE: Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.
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2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (in
these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the cartridge
label.

3. Insert theink cartridge into its slot: photo black, gray, and matte black on the left; cyan, magenta, and
yellow on the right.

4.  Push the cartridge into the slot until it snaps into position. You should hear a beep and see confirmation
that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 212.
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5. When all cartridges have been inserted, close the cover.

6.  The front-panel display confirms that all cartridges have been correctly inserted.

Although it is possible to use non-HP ink cartridges, this choice has several serious disadvantages. It may not be
possible to determine with enough accuracy the ink level or status of used, refilled, or counterfeit ink cartridges.
Any service or repair required as a result is not covered under the warranty. System ink flushing, color
calibration, and printhead alignment are recommended. If you experience print-quality problems,

HP recommends changing to Original HP inks.

About the printhead

The printhead is connected to the ink cartridges and jets ink onto the paper.

A CAUTION: Observe precautions when handling the printhead because it is an ESD-sensitive device (see the
Glossary on page 230). Avoid touching pins, leads, and circuitry.

Check the printhead status

The printer automatically checks and services the printhead after each print. Follow the steps below to get more
information on your printhead.

1. Fromthe front panel, tap @ then , then tap the printhead that you want information on.

2. The front panel displays:
e  (olors
e  Product name
e  Product number
e  Serial number

° Status, see Front-panel error messages on page 220
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e  Volume of ink it has used
e  Warranty status
You can also get some of this information from the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 214.

If the warranty status is See warranty note, this indicates that expired ink is being used. If the warranty status is
Out of warranty, this indicates that non-HP ink is being used. See the limited warranty document provided with
your printer for details of the warranty implications.

Remove the printhead

A CAUTION:  Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

A CAUTION:  Printhead replacement must be performed with the printer powered on.

1. From the front panel, press @ then —/ , then Replace.

The front panel may ask whether the replacement printhead is new or used.

[%9 NOTE: You can cancel the process at any time by pressing .

2. The carriage moves automatically to the left side of the printer.

A CAUTION:  If the carriage is left in the removal position for more than three minutes without inserting or
removing the printhead, it tries to move back to its normal position in the right-hand end.
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3.  The front panel asks you to lift the scanner.

4.  Locate the printhead carriage.
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5. Raise the blue printhead cover.
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7.  Leave the black piece approximately vertical.

8.  Grasp the printhead by the blue pieces on each side.

9.  Lift the printhead out of the carriage.

Insert the printhead

[%’ NOTE: You cannot insert a new printhead successfully if a connected ink cartridge has not enough ink to
complete the printhead replacement process. In this case, you should replace the ink cartridge before inserting
the new printhead. You can use the old cartridge later if it still contains some ink.

1. Insert the new printhead.
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A CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it too
fast, or at an angle, or if you rotate it as you insert it.

2. (Checkthat the printhead is correctly aligned with its ink connectors.
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3. Lower the black piece over the printhead.
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4.  Close the blue cover and make sure that it is properly closed.

=

When the printhead has been inserted correctly and is accepted by the printer, the printer beeps.

@ NOTE: If the printer does not beep when you insert the printhead and the Replace message appears on
the front-panel display, the printhead may need to be reinserted.

5.  Lower the scanner.

6.  The front-panel display confirms that the printhead is correctly inserted. The printer starts checking and
preparing the printhead. The default routine process takes 10 minutes. If the printer finds problems in
preparing the printhead, it takes longer, up to 45 minutes. After the printhead is checked and prepared, the
printhead realignment procedure runs automatically if paper is loaded, see Align the printhead

on page 213.

7. Youare recommended to perform a color calibration after inserting a new printhead. See Color calibration
on page 120.
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Storage of anonymous usage information

Each ink cartridge contains a memory chip that assists in the operation of the printer. In addition, this memory
chip stores a limited set of anonymous information about the usage of the printer, which can include the
following: the date when the cartridge was first installed, the date when the cartridge was last used, the number
of prints printed using the cartridge, the print coverage, the frequency of printing, the printing modes used, any
printing errors that may have occurred, and the product model. This information helps HP to design future
products to meet our customers' printing needs.

The information collected by the memory chip does not include information that could be used to identify a
customer or user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling program
(HP Planet Partners: http://www.hp.com/recycle). The sampled memory chips are read and studied in order to
improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the information. Any third party
possessing the cartridge may be able to access the anonymous information on the memory chip.

If you are concerned about providing this anonymous information, you can tell the printer not to store the
information in the memory chip. To do so, access the Embedded Web Server, and select Security > Security
Settings, then in the Printer Settings section toggle to Anonymous usage information. This does not prevent the
cartridge from working normally in other respects. However, if you change your mind later, you can restore the
factory defaults to resume collecting printer usage information.

Safe mode

Under certain conditions, including printer operation outside of environmental specifications, and when a used,
refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode. HP is unable to
warrant the performance of the printing system when operated outside of environmental specifications or when
a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the
printheads from damage due to unexpected conditions, and is in operation when the icon is displayed on the
printer’s front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including original HP inks
and printheads, are designed and engineered together to provide uncompromising print quality, consistency,
performance, durability, and value—with every print.

[% NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous
ink system and install genuine HP (or compatible) cartridges.

_*Lﬁ’% NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or
compatible) to continue printing.

[:;’/f’ NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.
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13 Printer maintenance

e  Check printer status

e  (lean the exterior of the printer

° Maintain the ink cartridges

° Move or store the printer

e  Update the firmware

° Update the software

° Printer maintenance kits

° Secure File Erase

e  Disk Wipe
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Check printer status

You can check the current status of the printer in various ways:

e Ifyouaccess the Embedded Web Server, you see information about the general status of the printer. The
Supplies page in the Main tab describes the status of the paper and ink supplies.

e The front panel has three top-level screens that you can move between by sliding your finger across. The
main screen provides direct access to the main printer functions. Swipe left to the widget page and see the
status of ink, paper supplies, and the job queue.

If there are any current alerts, the upper row of the home screen shows the top-priority alert. Swipe down
the dashboard to access the Status Center and take action.

e Ifyou start the HP Utility and select your printer, you see a page of information describing the status of the
printer and its paper and ink supplies.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

AWARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean
it. Do not let water get inside the printer.

/\ CAUTION: Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the
best print quality, replace a cartridge when it reaches its expiration date. The printer's front panel notifies you
when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 167.

See also Handling ink cartridges and printhead on page 153.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the
printer, follow the instructions below.

1. Do not remove the ink cartridges or printhead.

2. Make sure that no paper is loaded.

3 Make sure that the printer is idle.

4.  Disconnect any cables connecting the printer to a network or a computer.

5. If the stacker seems likely to impede the movement of the printer through doorways, you can fold it out of
the way by removing two screws.

If you need to leave the printer turned off for a long time, follow the additional steps below.
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1. Turn off the power using the Power key on the front panel.

2. Disconnect the printer's power cable.

A CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When reconnecting the power cable, remember to route the cable tidily along the back gutter.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the
printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off for a
six weeks or more, preparing the printhead could take up to 45 minutes.

A CAUTION:  If the printer remains off for a long period of time, the printhead may become unusable. In this case,
you need to replace the printhead.

% TIP: Because preparing and purging the printhead uses both time and ink, you are strongly recommended to
leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printhead. In both
cases, the printer wakes up from time to time to maintain the printhead. Thus, you can avoid going through
lengthy preparation processes before using your printer.

Update the firmware

The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer's functionality,
enhance its features, and may correct minor problems.

M” IMPORTANT:  You are strongly recommended to update the firmware periodically in order to take advantage of
the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you find
most convenient. They can be divided into two categories: automatic and manual updates.

Automatic firmware updates

Automatic firmware updates are a convenience that is possible with Web-connected printers. Your printer can
automatically download the latest firmware release and install it for you.

Important notes

e  Your printer must be connected to the Internet; see Set up printer services on page 18.

e To configure automatic firmware updates, you can use the front panel or the Embedded Web Server; see
Set up printer services on page 18.

e [fanadministrator password has been set, it will be required to change these settings.

e Afirmware update package can be large; you may want to consider whether there are any implications for
your network or Internet connection.

e Afirmware update is downloaded in the background: the printer can be printing at the same time. However,
it cannot be installed in the background: printing must stop.

Manual firmware updates

Manual firmware updates can be performed in the following ways:
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e  Using the Embedded Web Server, select the About Printer tab and then Manual Firmware Update. If new
firmware is available, some information about the new firmware is displayed, and you are given the
opportunity to download and install it.

e  Using the HP DesignJet Utility under Windows, select the Admin tab and then Launch Firmware Update.
e  Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic updates.

e  Using a USB flash drive. Download the firmware file from http://www.hp.com/go/DesignJetT2600/firmware
into the USB flash drive and insert it into the Hi-Speed USB host port in the front panel. A firmware update
assistant will appear on the front panel to guide you through the update process.

Update the software

To update printer drivers and other software for your printer, go to http://www.hp.com/go/DesignJetT2600/
drivers.

e  Under Windows, HP Software Update regularly offers to update your software automatically, and the
HP DesignJet Utility may offer you automatic updates when restarted.

e  Under Mac OS X, Apple SW Update offers you software updates when available.

Printer maintenance kits

Two maintenance kits are available for your printer, containing components that may need to be replaced after
long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 223) and request
the maintenance kit. The kits are installed by service engineers only.

Secure File Erase

The printer's hard disk is used as a temporary storage area for print jobs. Secure File Erase can erase your
temporary files from the hard disk to protect them from unauthorized access. It begins to do so as soon as you
turn it on, but old temporary files that were already on the hard disk are not erased retroactively. If you want to
erase the old files too, see Disk Wipe on page 170.

Secure File Erase provides three different levels of security:

e  Non-Secure: all pointers to the information are erased. The information itself remains on the hard disk until
the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the
disk, it is difficult for most people to access, but may be accessed using software designed for the purpose.
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This is the normal method in which files are erased on most computer systems; it is the fastest method but
the least secure.

e  Secure Fast Erase (1 pass): all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure, but more secure. It may
still be possible to access fragments of the erased information by using special tools to detect residual
magnetic traces.

e  Secure Sanitizing Erase (5 passes): all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest
method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m
requirements for clearing and sanitization of disk media. This is the default security level when using
Secure File Erase.

While files are being erased, the printer's performance may be affected.

Secure File Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print
management software: see http://www.hp.com/go/webjetadmin.

If you have difficulty in using Secure File Erase from Web JetAdmin, please contact HP Support: see Contact
HP Support on page 223.

The Secure File Erase configuration can be changed from Web JetAdmin or the Embedded Web Server (Security
> Security settings).

Disk Wipe

Disk Wipe is the same as Secure File Erase (see Secure File Erase on page 169), except that it erases all
temporary files, including old ones.

The Disk Wipe configuration can be changed from Web JetAdmin or the Embedded Web Server (Security >
Security settings).

[%r NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several times during
the process, which will take about 6 hours with Secure Fast Erase or 24 hours with Secure Sanitizing Erase.
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14 Scanner maintenance

° Clean the scanner’s glass plate

° Calibrate the scanner
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Clean the scanner’s glass plate

You are recommended to clean the scanner's glass plate periodically, depending on how often you use the
scanner.

1. Turn off the printer using the Power key and disconnect the power cable.

2. Thereisasmall lever at the rear left of the scanner. Slide the lever up and open the scanner cover.

———

AWARNING! Do not lift the scanner while the scanner cover is open. Your fingers or hand may be trapped or
crushed.

3. Gently wipe the glass plate and the surrounding area with a lint-free cloth dampened with water and then
wrung dry. A suitable cloth is provided with the printer.

A CAUTION: Do not use abrasives, acetone, benzene or fluids that contain these chemicals. Do not spray
liquids directly onto the scanner glass plate or anywhere else in the scanner.

Do not worry about tiny droplets of water left on the glass: they will evaporate.
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4.  Optionally, for more thorough cleaning:

e  Remove the glass plate and clean it on both sides.

e  (leanthe pressure rollers and the feed rollers.

6.  Clean the area immediately in front of the scanner, where the scanned sheet rests before scanning.

7. Reconnect the printer's power cable, turn on the power switch at the rear, and turn on the printer using the
Power key.

Calibrate the scanner

Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be recalibrated
during their lifetimes. Nevertheless, because of environmental changes, your scanner may start showing image
defects that can be easily corrected by recalibrating the scanner. The whole procedure takes less than 10
minutes, and you are recommended to recalibrate the scanner whenever you see some undesired artifact or a
lack of quality in scanned files or copies, bearing in mind the limitations of CIS technology already explained in
this guide. If you perform calibration successfully and still have concerns about the image quality, see Scanner
troubleshooting on page 106; alternatively, you may want to consider buying a CCD scanner.
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To calibrate the scanner

1. Clean the scanner. See Clean the scanner’s glass plate on page 172.

2. Goto the front panel and tap , then Scanner preferences > Calibrate scanner.

3. Follow the instructions in the front panel.

The supplied maintenance sheet reqguired to perform scanner calibration looks like this:

Load the maintenance sheet into the scanner face up, centered and with as little skew as possible. Once the
calibration is finished, the maintenance sheet should be carefully placed into its solid cover, and saved in a fresh
and dry place. Otherwise, it could be damaged, which could affect the operation of your scanner in the future.
Check that the maintenance sheet is not dirty, wrinkled, scratched or folded before calibrating the scanner. If
necessary, call your support representative and ask for a new maintenance sheet.

If calibration fails

1. Ensure that the printer is turned on and ready for normal operation.

2. Ensure that the scanner is working correctly. To test it, scan a small document to file.

3. Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the calibration
process.

4.  Eject and reload the calibration sheet, checking that it is clean, in good condition, face up and perfectly
centered in the scanner.

5. If the above steps do not help, eject the sheet and restart the printer (turn off and on). When the system
has restarted, repeat the calibration.

6.  If you cannot perform the calibration successfully in three consecutive attempts, call your support

representative and report the error code that appears in the front panel.
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15 Supplies and accessories

° How to order supplies and accessories

° Introduction to the accessories
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories:

e  \Visit http://www.hp.com, select your printer and click on the accessories button.

e  Contact HP Support (see Contact HP Support on page 223), and check that what you want is available in
your area.

The rest of this chapter lists the available supplies and accessories, and their part numbers, at the time of
writing.

Order ink supplies

The following ink supplies can be ordered for your printer.

Ink cartridges

Cartridge Part number
HP 730 130-ml Cyan DesignJet Ink Cartridge P2v62A

HP 730 130-ml Magenta DesignJet Ink Cartridge P2V63A

HP 730 130-ml Yellow DesignJet Ink Cartridge P2v6e4A

HP 730 130-ml Matte Black DesignJet Ink Cartridge P2V65A

HP 730 130-ml Gray DesignJet Ink Cartridge P2V66A

HP 730 130-ml Photo Black DesignJet Ink Cartridge P2V67A

HP 730 300-ml Cyan DesignJet Ink Cartridge P2V68A

HP 730 300-ml Magenta DesignJet Ink Cartridge P2V69A

HP 730 300-ml Yellow DesignJet Ink Cartridge P2V70A

HP 730 300-ml Matte Black DesignJet Ink Cartridge P2V71A

HP 730 300-ml Gray DesignJet Ink Cartridge P2V72A

HP 730 300-ml Photo Black DesignJet Ink Cartridge P2v73A
Printhead

Printhead Part number
HP 732 Printhead B3P0O6A
Order paper

The following paper types are currently provided for use with your printer.

[%’ NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hplfmedia.com.

[‘_%’ NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

176 Chapter 15 Supplies and accessories ENWW


http://www.hp.com
http://www.hplfmedia.com

Key to availability:

e (A)indicates papers available in Asia (excluding Japan)

e (0 indicates papers available in China

e (E)indicates papers available in Europe, the Middle East and Africa
e  (J)indicates papers available in Japan

e (L)indicates papers available in Latin America

e  (N)indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Roll paper

Paper type g/m2 Length Width Product number

HP Bond and Coated Paper

HP Super Heavyweight Plus Matte 210 30.4m(100ft) 610 mm (24 in) Q66268 (ELN)

Paper
914 mm (36in) Q66278 (AELN)

HP Universal Bond Paper 80 45.7m (150 ft) 594 mm (23.39in) (A1) Q8003A (AJ)
610 mm (24 in) Q1396A

SAD25A (2 Pack) (J)
974 mm (36in) Q1397A
91.4 m (300 ft) 594 mm (23.39in) (A1) Q8004A (EA))

840 mm (33.11 in) (AO) Q8005A (EA))
914 mm (36in) C6810A

HP Bright White Inkjet Paper 90 45.7m(150ft) 419mm (16.5in) Q1446A (EJ)
594 mm (23.4in) (A1) Q1445A (E))
610 mm (24 in) C1860A (LN)
610 mm (24 in) C6035A (EA))
840 mm (33.11 in) (AO) Q1444A (EA))
974 mm (36in) C6036A (EA))
914 mm (36in) C1861A (LN)

91.4m (300 ft) 974 mm (36in) C6810A

HP Heavyweight Coated Paper 130 30.4m (100 ft) 610 mm (24 in) 6029C
914 mm (36in) C6030C

HP Coated Paper 90 45.7m(150ft) 594 mm (23.4in) (A1) Q1442A (AE))
610 mm (24 in) C6019B
840 mm (33.11 in) (AO) Q1441A (E))
914 mm (361n) (€6020B
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Roll paper (continued)

Paper type g/m2 Length Width Product number
91.4 m (300 ft) 914 mm (36 in) C6980A
HP Universal Coated Paper 90 45.7m (150 ft) 610 mm (24 in) Q1404B
914 mm (36 in) Q14058
HP Universal Heavyweight Coated 131 30.4m (100 ft) 610 mm (24 in) Q14128
Paper
914 mm (36 in) Q1413B
HP Technical Paper
HP Translucent Bond Paper 63 45.7m(150ft) 610 mm (24 in) (3860A (LN)
914 mm (36in) (C3859A (AJLN)
HP Natural Tracing Paper 90 45.7m(150ft) 594 mm (23.4in) (A1) Q1439A(J)
610 mm (24 in) (3869A
914 mm (36 in) (3868A
HP Film (Technical and Graphic)
HP Clear Film 174 22.8m (75 ft) 610 mm (24 in) (3876A
914 mm (36 in) (3875A
HP Matte Film 160 38.1m(125ft) 610 mm (24 in) 51642A
914 mm (36 in) 51642B
HP Special Inkjet Paper 131 45.7m (150 ft) 610 mm (24 in) 51631D (ELN)
914 mm (36 in) 51631E
HP Photographic Paper
HP Universal Gloss Photo Paper 200 30.4m(100ft) 610 mm (24 in) Q14268
974 mm (36 in) Q12478
HP Universal Satin Photo Paper 200 30.4m (100 ft) 610 mm (24 in) Q14208
914 mm (36 in) Q14218
HP Universal Instant-dry Gloss Photo 200 30.4m (100 ft) 610 mm (24 in) Q6574A
Paper
914 mm (36 in) Q6575A
HP Premium Instant-dry Gloss Photo 235 30.5m (100 ft) 610 mm (24 in) Q7991A (AELN)
Paper
914 mm (36 in) Q7993A (AELN)
HP Universal Instant-dry Satin Photo 200 30.4m(100ft) 610 mm (24 in) Q6579A
Paper
914 mm (36 in) Q6580A
60.9 m (200 ft) 1066 mm (42 in) Q8755A (AELN)
HP Premium Instant-dry Satin Photo 235 30.5m(100ft) 610 mm (24 in) Q7992A (AELN)
Paper
914 mm (36in) Q7994A (AELN)
HP Premium Matte Photo Paper 210 30.4m (100 ft) 610 mm (24 in) CG4598B
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Roll paper (continued)

Paper type g/m2 Length Width Product number
914 mm (36n) CG460B
HP Self-Adhesive Material
HP Everyday Adhesive Matte 120 22.8m(75ft) 610 mm (24 in) COF18A (AELN)
Polypropylene
168 with 914 mm (36 in) COF19A (AELN)
liner
HP Everyday Adhesive Matte 120 30.5m (100 ft) 914 mm (36in) D9R24A (ELN)
Polypropylene , 3-in Core
HP Everyday Adhesive Gloss 140 22.8m (75 ft) 914 mm (36 in) COF28A (AELN)
Polypropylene
190 with
liner
HP Universal Adhesive Vinyl 160 20 m (66 ft) 914 mm (36in) C2T51B (2 Pack) (ELN)
300 with
liner
HP Banner and Sign Material
HP Everyday Matte Polypropylene 120 30.4m (100 ft) 610 mm (24 in) CHO22A
914 mm (36 in) CHO23A (AELN)
60.9 m (200 ft) 914 mm (36in) CHO24A
Media name: HP Everyday Matte 120 61 m (200 ft) 914 mm (36n) DYR28A (ELN)
Polypropylene , 3-in Core
HP Premium Matte Polypropylene 140 229 m (75 ft) 914 mm (36 in) C2T53A (ELN)
HP Durable Synthetic Banner 133 22.9m (75 ft) 914 mm (36 in) COF12A (LN)
HP Durable Synthetic Banner, 3-in Core 133 30.5m (100 ft) 914 mm (36 in) TAFO9A (LN)
HP Opaque Scrim 495 30.5m (100 ft) 610 mm (24 in) Q8675C (LN)
914 mm (36n) Q1898C (AELN)
HP Everyday Blockout Display Film 220 30.5m (100 ft) 914 mm (36in) Y3Z17A (ELN)

Order accessories

The following accessories can be ordered for your printer.

Name Product number
HP USB 3.0 to Gigabit LAN Adapter N7P47AA

HP DesignJet PostScript®/Pdf Upgrade Kit Coce6C

HP DesignJet 3-in Spindle Adaptor Kit CN538A

HP DesignJet 36-in Spindle LAR66A

HP HD Pro 42-in scanner G6H51B

HP SD Pro 44-in scanner G6H508B
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Introduction to the accessories

PostScript Upgrade

The PostScript Upgrade enables a T2600MFP to print the same file types that a T2600MFP PS can print,
including PDF and PostScript files, and the generation of PDF files from scans (scan-to-PDF). The PostScript
upgrade can be plugged into the printer's USB host. It is not necessary to leave it permanently connected: just
plugitin once, and the printer is upgraded forever.

Spindle

With extra spindles, you can change rapidly from one paper type to another.

3-in Spindle Adaptor Kit

With this adaptor you can use paper rolls with 3-inch cores, provided that the diameter of the roll is within printer
specifications.
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Troubleshooting paper issues

Paper cannot be loaded successfully

Paper type is not in the driver

Printer printed on the wrong paper type

Automatic cut not available

On hold for paper

The paper has jammed in the print platen

The paper has jammed in the stacker

The printer reports unexpectedly that the stacker is full

A strip stays on the output tray and generates jams

Printer displays out of paper when paper is available

Prints do not fall neatly into the basket

Sheet stays in the printer when the print has been completed

Paper is cut when the print has been completed

Cutter does not cut well

Rollis loose on the spindle

Recalibrate the paper advance
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Paper cannot be loaded successfully

e  Ensure that no paper is already loaded.
° Ensure that the paper is far enough inside the printer: you should feel the printer grab the paper.

e Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-
panel display. The printer automatically attempts to straighten the paper.

e  The paper may be crumpled, or warped, or may have irregular edges.

e [t can be difficult to insert a particularly stiff paper from the upper roll. Try moving it to the lower roll.

Unsuccessful roll load issues

e [fthe paper does not load, the leading edge of the paper may not be straight or clean and needs to be
trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new
roll of paper.

e  Ensure theroll ends are tight against the spindle ends.

e  (heckthat the spindle is correctly inserted.

e  (Check that the paper is correctly loaded on the spindle. See Load a roll onto the spindle on page 35.
e  (Check that all roll end plugs have been removed.

e  (heck that the paper is wound tightly on the roll.

e Do not touch the roll or paper at during the alignment process.

e  When loading a roll, the roll cover must remain open until the front panel prompts you to close it.

If the paper has not been inserted straight, the printer attempts to straighten the roll.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from
the end of the spindle until the edge is removed from the printer.

[%9 NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load
e  (uide the sheet, especially thick papers, when the printer initially feeds the sheet.
e  Ensure that the sheet is aligned with the reference line on the roll cover.

e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel
display.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
e  Ensure the single sheet is not skewed.
In case of any problem, follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the
sheet.
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Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Front-panel message

Suggested action

Paper incorrectly loaded

The paper has not been loaded correctly. Remove the paper.

Paper loaded with too much skew

During the paper load process the printer detected that the paper had too much skew.
Follow the instructions on the front-panel display.

Paper loose around core

The end of the roll has become loose around the core. Tighten the paper to the core or
insert a new roll.

Paper not detected

During the paper load process the printer did not detect any paper. Ensure the paper is
inserted fully and is not transparent.

Roll cover closed during paper load process

Do not close the roll cover until you are prompted to do so by the front panel.

Sheet too big

During the load process the printer has detected that the sheet of paper is either too wide
or too long to be loaded correctly. Follow the instructions on the front-panel display.

Sheet too small

During the load process the printer detected that the sheet of paper is too narrow or too
short to be loaded in the printer. Follow the instructions on the front-panel display.

Upper roll load and paper is inserted through ~ Avoid inserting roll paper into the cut sheet slot.

the single sheet path

Paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver,
however, you must identify whether your paper is transparent or translucent, glossy or matte.

Ej?)y NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print well on

glossy paper.

Glossy paper

If your paper is a photo paper, use the Photo Paper category.

Matte paper

If your paper is a matte paper, use any of the papers in the Bond and Coated Paper category. If your paper is
classified as photo matte, its category depends on whether it can hold matte black ink. In this case, try both with
Heavyweight Coated Paper and with Photo Semi Gloss/Satin Paper, and choose the best result.

General-purpose paper

e  For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing Paper >
65 g/m2, depending on the weight of the paper.

e  For thin papers (< 90 g/m?) uncoated papers (for example plain paper or bright white paper) select paper
type Bond and Coated Paper > Plain Paper.

e  For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated Paper.
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e  For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper > Heavyweight
Coated Paper.

e  For cockle-free very thick coated papers (> 200 g/m?), select paper type Bond and Coated Paper > Super
Heavyweight Coated Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select any of
the papers in the Photo Paper category.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from
thinnest to thickest are:

e  Plain Paper

e  Coated Paper

e  Heavyweight Coated Paper

e  Super Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 194.

Printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Use Printer Settings
selected for the Paper Type in the printer driver. When either of these is selected, the printer will print
immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 34, and select
your paper type specifically in the driver.

e Inthe Windows driver dialog: select the Paper/Quality or Paper tab (depending on the driver version), then
select your paper type from the Paper Type list.

B NOTE: Use Printer Settings (Windows) or Any (Mac 0S X) is the driver default.

Automatic cut not available

Some paper types cannot be cut by the automatic cutter. When such a paper type is loaded and active, the
printer cannot switch automatically to the other roll: the active roll must first be unloaded manually.

On hold for paper

Based on a set of conditions that you can set when sending a job (see Solve paper mismatch on page 88), the
printer will decide which of the loaded rolls of paper is more suitable to print the job. If there is no roll of paper
available that meets all the conditions, the printer will put the job on hold for paper. You can manually resume
the job, forcing it to print on a paper other than the one originally specified, otherwise it will stay on hold.

r.%? NOTE: When an uncuttable roll is active, every job sent to any other paper source is put on hold until you
manually unload the uncuttable roll.
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Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set in the driver. The printer will print the job on a roll of
paper of the chosen paper type that is large enough to print the drawing without clipping. If there is more than
one roll on which the job could be printed meeting all the criteria, the roll will be chosen according to your
preferences. These can be set from the front panel: see Roll policies on page 87.

When is a job put on hold for paper?

If the paper mismatch action is set to Pause and ask (see Solve paper mismatch on page 88), ajob is put on hold
for paper in the following cases:

e  The paper type that has been selected by the user is not currently loaded on the specified roll—or on
either of the rolls, if no roll has been specified.

e The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too
large to fit on the roll—or on either of the rolls, if no roll has been specified.

If | load a new roll of paper, will jobs that were on hold for paper be automatically
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that
could be printed on the loaded roll.

| don't like jobs being put on hold for paper. Can | prevent it?

Yes, this can be done from the front panel: see Solve paper mismatch on page 88.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on
hold for paper

Margins are managed in different ways depending on the file type:

e  For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so @ 914 mm (36 in) HP-
GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for paper.

e  For other file formats, such as PostScript, PDF, TIFF, or JPEG, the printer assumes that margins need to be
added outside the drawing (as, in many cases, these formats are used for photographs and other images
that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs to add
margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job to be put
on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip
contents by margins option can be used. This option will force the margins to be set inside of the drawing,
s0a914 mm (36 in) TIFF can be printed on a 974 mm (36 in) roll of paper without being put on hold.
However, if there is no white space already included in the drawing’s borders, some contents could be
clipped because of the margins.

The paper has jammed in the print platen

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display. The front
panel starts the paper jam wizard which displays where the jam has occurred and how to fix it. Clear the paper
jam as instructed on each wizard screen.

1. Turn off the printer at the front panel.
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2.  Lift the scanner.

3. Move the carriage manually to the left side of the printer, if feasible.
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4.  Go to the paper path.
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6.  Open the roll cover.

i

s,

7. Manually rewind paper onto the roll.
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8. Ifthe leading edge of the paper is ragged, trim it carefully with scissors.

9.  Remove the paper left in the printer.
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11. Lower the scanner and close the roll cover.

12. Restart the printer by holding down the power button for a few seconds.

13. Reload theroll, or load a new sheet see Paper handling on page 34.

r.%r NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure
and carefully remove all pieces of paper.

The paper has jammed in the stacker

When a paper jam is detected in the stacker, printing is paused, and the front panel asks you to open the stacker
cover and clear the jam by pulling out the paper.

When the stacker cover is closed and the printer detects no jammed paper, the front panel requests
confirmation to continue printing.

The printer reports unexpectedly that the stacker is full
The printer may report that the stacker is full in the following circumstances:
e Whenthereis a paper jamin the stacker
e  Whenyou are using very thin or very stiff paper, such as heavyweight coated paper

e  When you are sending small paper sizes to the stacker, such as A3 portrait or A2 landscape

A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-bleed print
or after the front-panel option Move and cut has been used, the cut strip remains in the output tray. Only when
the printer is not printing, reach into the tray and remove the strip.

Printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If
possible, tighten the paper to its core or load a new roll.
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Prints do not fall neatly into the basket

e  Ensure that the basket is correctly installed.
e  Ensure that the basket is open.
° Ensure that the basket is not full.

e  Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or
remove prints manually as they are completed.

Sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 50. If the
paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic
cutter is disabled, use the Move and cut option in the front panel, see Clean cut on page 57.

Paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time
on page 50. You can disable the cutter, see Turn the automatic cutter on and off on page 50.

Cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed. If the
cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles.

If the cutter is turned off, Move and cut only advances the paper. Use it to move the print far enough out of the
front of the printer, until it is convenient to cut manually with a straight edge or scissors.

Roll is loose on the spindle

The roll may need to be replaced or reloaded.

Ensure that you are using the right core, and use the HP DesignJet 3-in Core Adapter when needed.

Recalibrate the paper advance

Accurate paper advance is important to print quality because it is part of controlling the proper placement of
dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark
bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select
the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if
you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the
paper advances. See Troubleshooting print-quality issues on page 194 for steps to determine if paper advance
calibration will solve your issue.
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You can check the paper advance calibration status of the currently loaded paper from the front panel at any
time by tapping @ then <+« then o then Calibration status. The status may be one of the following:

e  DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in the Front
Panel have been optimized by default and unless you experience image quality problems in your printed
image such as banding or graininess it is not recommended to recalibrate the paper advance.

e  OK: This status indicates that the loaded paper has been calibrated before. However you may need to
repeat the calibration if you experience print-quality problems such as banding or graininess in your printed
image.

Ej?y NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are reset to
factory default, see Update the firmware on page 168.

Recalibrating the paper advance procedure

A CAUTION: If you are using a transparent paper or film, go directly to step 3 of this procedure.

1. From the front panel, tap @ then Paper advance calibration > Continue. The printer automatically
recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status page, and reprint your print.

[i?"”f NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the paper
advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to
the default calibration, see Return to default calibration on page 193.

3. If you would like to fine-tune the calibration or are using a transparent paper, tap @ then Paper advance
calibration > Continue.
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4.  Select the percentage of change from—=100% to +100%. To correct light banding, decrease the percentage.

To correct dark banding, increase the percentage.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To
return to the default paper advance calibration value, you must reset the calibration.

1. Fromthe front panel, tap , then eee, then {:) then Reset calibration.

2. Wait until the front panel displays the operation has completed successfully.
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17 Troubleshooting print-quality issues

e  (eneral advice

° Horizontal lines across the image (banding)

° Whole image is blurry or grainy

° Paper is not flat

° Print is scuffed or scratched

° Ink marks on the paper

° Black horizontal lines on yellow background

° Black ink comes off when you touch the print

° Edges of objects are stepped or not sharp

° Edges of objects are darker than expected

° Horizontal lines at the end of a cut sheet print

e  \Vertical lines of different colors

° White spots on the print

° Colors are inaccurate

e  (olors are fading

e |mage s incomplete (clipped at the bottom)

° Image is clipped

e  Some objects are missing from the printed image

° Lines are too thick, too thin or missing

° Lines appear stepped or jagged

° Lines print double or in the wrong colors

° Lines are discontinuous

° Lines are blurred

° Line lengths are inaccurate
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° Image Diagnostics Print

° If you still have a problem
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General advice

When you have any print-quality problem:

e Toachieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper on page 176.

e  Make sure that the paper type selected in the front panel is the same as the paper type loaded into the
printer (see View information about the paper on page 48). At the same time, check that the paper type has
been calibrated. Also make sure that the paper type selected in your software is the same as the paper
type loaded into the printer.

A CAUTION: If you have the wrong paper type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printheads.

e  (heckthat you are using the most appropriate print-quality settings for your purposes (see Printing
on page 64). You are likely to see lower print quality if you have moved the print-quality slider to the
'Speed' end of the scale, or set the custom quality level to Fast.

e  (Check that your environmental conditions (temperature, humidity) are in the recommended range. See
Environmental specifications on page 229.

e  (Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain the ink
cartridges on page 167.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Checkthat the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 48.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 64). In
some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For
instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-
quality settings, you may wish to reprint your job at this point in case the problem has been solved.

3. Print the Image Diagnostics Print and follow the instructions in Image Diagnostics Print on page 207,
including printhead cleaning if recommended.

4.  If the printheads are working correctly, go to the front panel and tap , then Paper advance calibration >
Continue, then choose the paper source. See Recalibrate the paper advance on page 191.
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If the problem persists despite all the above actions, contact your customer service representative for further
support.

Whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 48.

2. (Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 64). In some cases, you
can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you
have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings,
you may wish to reprint your job at this point in case the problem has been solved.

4.  Realign the printheads. See Align the printhead on page 213. After alignment, you may wish to reprint your
job in case the problem has been solved.

5. Goto the front panel and tap , then Paper advance calibration, then choose the paper source. See
Recalibrate the paper advance on page 191.

If the problem persists despite all the above actions, contact your customer service representative for further
support.
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Paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves init, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes
saturated with ink.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 48.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus
Matte Paper.

Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to use
less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing,
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

Handle prints carefully.
Avoid stacking prints on top of each other.

Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, leave a
sheet of paper in the basket so that freshly printed sheets do not make direct contact with the basket.

Ink marks on the paper

This problem can occur for several different reasons.
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Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printheads
move over the paper, the printheads may come into contact with the paper and smear the printed image. This

problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Tap . and also cancel the job from your

computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in

your software. See View information about the paper on page 48.

2. Usearecommended paper type (see Order paper on page 176) and the correct print settings.

3. Ifusing sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect
performance.

4.  Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super Heavyweight
Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to use

less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. Trytoincrease the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Black horizontal lines on yellow background

This problem may be caused by storing the printer in a cold environment.

Go to the front panel and tap , then Clean printheads.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select any
paper type from the Photo Paper category.
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Edges of objects are stepped or not sharp

1. If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the
print-guality slider to Quality in the print dialog box, select the custom print-quality options, and try setting
the quality level to Normal. See Printing on page 64.

2. Theissue may be related to orientation. Try rotating the image: you may find that the result looks better.

Edges of objects are darker than expected

1. If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality
in the driver dialog, select the custom print-guality options, and try setting the quality level to Normal. See
Printing on page 64.

2. Theissue may be related to orientation. Try rotating the image: you may find that the result looks better.

Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the paper.
You may see some very thin horizontal lines across the print.

To avoid this problem:
1. Consider using larger margins around your image.

2. Print the Image Diagnostics Print. See Image Diagnostics Print on page 207.

3. Consider printing with roll paper.

Vertical lines of different colors

If your print has vertical bands of different colors along it:
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1. Tryusing thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated
Paper and HP Super Heavyweight Paper. See Order paper on page 176.

2. Tryusing higher print-quality settings (see Printing on page 64). For instance, if you have set the Print
Quality slider to Speed, try setting it to Quality.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust, or loose coating material. To
avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

2. Always keep the cover of your printer closed, and avoid actions that may introduce dust into the printer,
such as handling or cutting paper on the printer cover.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 48.

2. Tap , then «««, then, '0 then Calibration Status to check the color calibration status. If the status is

PENDING or OBSOLETE, you should perform color calibration: see Color calibration on page 120. If you have
made any changes, you may wish to reprint your job in case the problem has been solved.

3. (Check that you are printing on the correct side of the paper.

4.  Check that you are using appropriate print-quality settings (see Printing on page 64). If you have selected
the Speed or Fast options, you may not get the most accurate colors. If you change the print-quality
settings, you may wish to reprint your job at this point in case the problem has been solved.

5. Ifyou are using Application Color Management, check that the color profile you are using corresponds to
the selected paper type and print-quality settings. If you have doubts about which color settings to use,
see Color management on page 119.

6. If agrayscale image shows a color cast in some of the gray shadows, click Color > Grayscale in the driver.
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7.

8.

If the problem consists of color differences between your print and your monitor, try calibrating your
monitor. At this point, you may wish to reprint your job in case the problem has been solved.

Print the Image Diagnostics Print. See Image Diagnostics Print on page 207.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than
two weeks, you should laminate them to achieve longer life.

Alternatively, prints on swellable coated papers such as HP Universal Gloss Photo Paper or HP Universal Satin
Photo Paper will fade much less rapidly.

Lamination can increase the life of prints on all paper types, depending on the type of lamination. For more
information, consult your laminate provider.

Image is incomplete (clipped at the bottom)

Did you tap 6 before all the data were received by the printer? If so, you have ended the data
transmission and will have to print the page again.

The I/0 timeout setting may be too short. This setting determines how long the printer waits for the
computer to send more data, before deciding that the job is finished. From the front panel, increase the 1/0

timeout setting to a longer period and then send the print again. Tap then Connectivity > Network > 1/0
timeout.

There may be a communications problem between your computer and the printer. Check your USB or
network cable.

Check to make sure that your software settings are correct for your current page size (for example, long-
axis prints).

If you are using network software, make sure it has not timed out.

Image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the
printable area as understood by your software. You can often identify this kind of problem before printing by
previewing your print (see Preview a print on page 73).

Check the actual printable area for the paper size you have loaded.
printable area = paper size —margins

Check what your software understands to be the printable area (which it may call "printing area” or
"imageable area"). For example, some software applications assume standard printable areas that are
larger than those used in this printer.

If you have defined a custom page size with very narrow margins, the printer may impose its own minimal
margins, clipping your image slightly. You may want to consider using a larger paper size.
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e Ifyourimage contains its own margins, you may be able to print it successfully by using the Clip Contents
by Margins option (see Select margin options on page 71).

e Ifyouare trying to print a very longimage on a roll, check that your software is capable of printing an
image of that size.

e Ifyoutry to print an image larger than your software can handle, the bottom of the image may be clipped.
To print the whole image, try these suggestions:

—  Savethe file in another format, such as TIFF or EPS, and open it with another application.
—  Use aRIP to print the file.
e  You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

e Ifnecessary, reduce the size of the image or document in your software application, so it fits between the
margins.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific
workflows there may be issues that can lead to some objects missing from the output. Here are some
suggestions to help you to avoid this problem:

e  Select asmaller page size and scale to the desired final page size in the driver or in the front panel.
e  Save thefile in another format, such as TIFF or EPS, and open it with another application.

e  Use HP Click software to print the file.

e  UseaRIP to print the file.

e  Tryprinting from a USB flash drive.

e  Reduce the resolution of bitmap images in your application software.

e  Select alower print quality in order to reduce the resolution of the printed image.

Ej?’y NOTE: If you are working under Mac 0S X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or
the time necessary to generate the print job. Therefore, they should be canceled if they do not help to solve the
problem.
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Lines are too thick, too thin or missing

S

=

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in
your software. See View information about the paper on page 48.

2/1

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 64).
Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if
available). You may wish to reprint your job at this point in case the problem has been solved.

3.  Ifthe resolution of your image is greater than the printing resolution, you may notice a loss of line quality.

4. Iflines are too thin or missing, print the Image Diagnostics Print. See Image Diagnostics Print on page 207.

v

If the problem remains, go to the front panel and tap @ then Printhead alignment to align the

printheads. See Align the printhead on page 213. After alignment, you may wish to reprint your job in case
the problem has been solved.

6.  Gotothe front panel and tap @ then perform paper advance calibration: see Recalibrate the paper
advance on page 191.

If the problem persists despite all the above actions, contact your customer service representative for further
support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are using to
edit it.

2. Check that you are using appropriate print-guality settings. See Printing on page 64.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if
available).
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Lines print double or in the wrong colors

This problem can have various visible symptoms:

e  C(olored lines are printed double, in different colors.

Q

N\

e  The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1.  Reseat the printheads by removing them and then reinserting them. See Remove the printhead
on page 158 and Insert the printhead on page 161.

2. Align the printheads. See Align the printhead on page 213.

Lines are discontinuous

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 64.

2. Reseat the printheads by removing them and then reinserting them. See Remove the printhead
on page 158 and Insert the printhead on page 161.

3. Align the printheads on the paper that you have the issue with. See Align the printhead on page 213.
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Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1.

Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing.
See Environmental specifications on page 229.

Check that the paper type selected in the front panel is the same as the paper type you are using. See View
information about the paper on page 48.

Select the custom print-quality options, then select Best and Maximum detail (if available). See High-
quality printing on page 73.

Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus
Matte Paper.

Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to use
less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper,
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

If you are using glossy paper, try changing to a different type of glossy paper.

Align the printheads. See Align the printhead on page 213.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes,
you can try to improve line length accuracy in the following ways:

1.

W

Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 226.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner
or thicker than HP Matte Film will reduce line length accuracy.

Set the Print Quality slider to Quality.
Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes before printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance
on page 191.
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Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps you
to check the performance of the printheads that are currently installed in your printer, and whether any
printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:
1. Use the same paper type that you were using when you detected a problem.

2. (Check that the selected paper type is the same as the paper type loaded into the printer. See View
information about the paper on page 48.

3. Atthe printer's front panel, tap @ then Print diagnostic.

It takes about two minutes to print the Image Diagnostics Print.
The print is divided into two parts, both of which test printhead performance:

e  Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print
quality that you will get from each color.

e  Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements
the first, and aims more specifically to detect how many faulty nozzles each printhead has.

Look carefully at the print. The names of the colors are shown above the rectangles and in the center of the
patterns of dashes.
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First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any

horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the

dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead

responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing dashes

in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:
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And here is an example of the same printhead in a bad state:

G

Corrective action

1.  Clean any faulty printheads (see Clean the printhead on page 213). Then reprint the Image Diagnostics
Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see whether
the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printhead on page 213).
You could also try reprinting your current print job, in case it now prints satisfactorily.

4. If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges and
printhead on page 153), or contact HP Support (see Contact HP Support on page 223).
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If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further
things that you can do:

e  Tryusing a higher print-quality option. See Printing on page 64.

e  (Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded
from http://www.hp.com/go/DesignJetT2600/drivers.

e  Ifyouare using a non-HP RIP, its settings may be incorrect. See the documentation that came with the RIP.

e  (Check that your printer's firmware is up to date. See Update the firmware on page 168.

e  (Check that you have the right settings in your software application.
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18 Troubleshooting ink cartridge and printhead
issues

° Cannot insert an ink cartridge

° Ink cartridge status messages

° Cannot insert the printhead

e  The front-panel display recommends reseating or replacing the printhead

° Clean the printhead

° Align the printhead

° Printhead status messages
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Cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number).
2. (Checkthat the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side
up and readable.

A CAUTION:  Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

e  OK:The cartridge is working normally, with no known problems.

e  Missing: There is no cartridge present, or it is not correctly connected to the printer.
e  Low: Theink levelis low.

e Verylow: Theink levelis very low.

e  Empty: The cartridge is empty.

e  Reseat: You are recommended to remove the cartridge and then reinsert it.

e  Replace: You are recommended to replace the cartridge with a new cartridge.

e  Expired: It is past the cartridge's expiration date.

e Incorrect: The cartridge is not compatible with this printer. The message includes a list of compatible
cartridges.

e  Non-HP: The cartridge is used, refilled, or counterfeit.

Cannot insert the printhead

1. Check that you have the correct type of printhead (model number).
2. Checkthat the printhead is correctly oriented.

3. Check that you have correctly closed and latched the printhead cover, see Insert the printhead
on page 161.

The front-panel display recommends reseating or replacing the
printhead

1. Remove the printhead, see Remove the printhead on page 158.
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2. (Clean the electrical connections on the backside of the printhead with a lint-free cloth. You can carefully use
a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

A CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles on the
bottom side of the printhead, especially not with any alcohol.

3. Reinsert the printhead, see Insert the printhead on page 161.

4. Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printhead

As long as the printer is kept turned on, automatic cleaning is performed periodically. This ensures there is fresh
ink in the nozzles and prevents nozzle clogs, thus preserving print quality. If you have print quality problems,
please see Image Diagnostics Print on page 207 before proceeding.

To clean the printhead, go to the front panel and tap E] then Printheads, and select the color group including
the color that needs cleaning (Clean all, Clean MK-Y, Clean C-M-PK-G).

Align the printhead

Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in
graphical elements. Your printer has an automatic printhead alignment process which runs whenever the
printhead has been accessed or replaced.

You may need to align the printhead after a paper jam or if you are experiencing print-quality problems.

1. Load the paper you wish to use, see Paper handling on page 34. You can use a roll or a cut sheet; plain
white paper is recommended.

A CAUTION: Do not use transparent or semi-transparent paper to align the printhead. HP recommends
plain or bond paper.

2. Ensure that the scanner is lowered, as a strong light source near the printer during printhead realignment
can affect alignment.

3. From the front panel, tap E] then Align printheads.

[’_ﬁ”f’ NOTE: Printhead alignment can also be started from the Embedded Web Server (Support > Print Quality
Troubleshooting), or from the HP Utility (Windows: Support > Print Quality Troubleshooting; Mac 0S X:
Information and Print Quality > Align).
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4.
5.

If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

The process takes about five minutes. Wait until the front-panel display shows the process complete
before using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead
and try again.

Printhead status messages

These are the possible printhead status messages:

OK: The printhead is working normally, with no known problems
Missing: There is no printhead present, or it is not correctly installed in the printer.

Reseat: You are recommended to remove the printhead and then reinsert it. If that fails, clean the electrical
connections, see The front-panel display recommends reseating or replacing the printhead on page 212. If
that fails, replace the printhead with a new printhead, see Remove the printhead on page 158 and Insert
the printhead on page 161.

Replace: The printhead is failing. Replace the printhead with a working printhead, see Remove the
printhead on page 158 and Insert the printhead on page 161.

Replacement incomplete: The printhead replacement process has not completed successfully; re-launch
the replacement process and let it finish completely.

Remove: The printhead is not a suitable type for use in printing.

Non-HP ink: Ink from a used, refilled, or counterfeit ink cartridge has passed through the printhead. See the
limited warranty document provided with your printer for details of the warranty implications.
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19 Troubleshooting general printer issues

° Printer does not print

° Front panel fails to initialize

° Printer seems slow

° Communication failures between computer and printer

° Cannot access the Embedded Web Server

° Cannot connect to the Internet

° Web Services issues

e  Automatic file system check

° Alerts
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Printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file
you have sent from your computer may not start printing when expected:

You may have an electrical power problem. If there is no activity at all from the printer, and the front panel
does not respond, check that the power cable is connected correctly and that there is power available at
the socket. Press the power key for 5 seconds to reset the printer.

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this
case, turn off the printer using the power key on the front panel and unplug the power cord, wait until the
electromagnetic environment has returned to normal, then turn it on again. If you still experience
problems, contact your support representative.

Nesting may be on, and the printer is waiting for the specified nest wait time before calculating the
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

You may have the wrong graphic language setting, see Change the graphic language setting on page 32.

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

If you are printing on a sheet, you must specify Single sheet as the paper source in your printer driver.

The printer may be holding the job for suitable paper (see On hold for paper on page 184) or accounting ID
information (see Require account ID on page 30).

You may have requested a print preview from your printer driver. This is a function you can use to check
that the image is the one you want. In this case, the preview is displayed on your screen, and you must click
the Print button to start printing.

Front panel fails to initialize

If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended to
replace the firmware, in the following way:

1.
2.

Go to the HP Support Center (see HP Support Center on page 222) and download the firmware.

Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with
the FAT filesystem.

Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port beside the
front panel, then turn the printer on.

The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.

The printer automatically installs the new firmware and restarts.
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Printer seems slow

Here are some possible explanations:

Did you set the print quality to Best or Maximum detail? Best-quality and maximum detail prints take
longer.

Did you specify the correct paper type when loading the paper? Some paper types require more time for
printing; for example, photo and coated papers require more drying time between passes. To find out the
printer's current paper type setting, see View information about the paper on page 48.

If your printer is connected by network, check that all components used in the network (network interface
cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from
other devices on the network?

Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer

Some symptoms are:

The front-panel display does not show the Receiving message when you have sent an image to the printer.
Your computer displays an error message when you are trying to print.
Your computer or printer hangs (stays idle), while communication is taking place.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

Ensure that you have selected the correct printer in your application, see Printing on page 64.

Ensure that the printer works correctly when printing from other applications.
Remember that very large prints may take some time to receive, process and print.

If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, and so on, try using it when connected directly to
your computer.

Try another interface cable.

Ensure that the graphic language setting is correct, see Change the graphic language setting on page 32.

If the printer is connected by network, check that your printer has a static IP address. If it is using DHCP, the
IP address may change every time it is turned on, in which case the driver may not be able to find it.

Cannot access the Embedded Web Server

If you have not done so already, read Embedded Web Server on page 15.

From the front panel, tap , then Security > Embedded Web Server.
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If you are using a proxy server, try bypassing the server and accessing the Web server directly:

e InInternet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check
the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced
button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.

e  InSafari for Mac 0S X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button.
Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not
used, in the Bypass proxy settings for these Hosts & Domains field.

If you still cannot connect, turn the printer off and back on with the power key on the front panel.

Cannot connect to the Internet
If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard automatically.
The Connectivity Wizard performs a series of tests automatically.

If any test fails, the printer describes the problem and recommends how to solve it. You can modify settings and
rerun the test, unless the settings are protected.

Web Services issues

For any issues with HP ePrint, see HP Connected: http://www.hpconnected.com.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel message: File system check.

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

A CAUTION:  If you turn the printer off before the file system check has finished, the file system could be seriously
damaged, making the printer's hard disk unusable. In any case, the file system check will restart from the
beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.

[%,/r NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. However, it can take up to 40 under some conditions, for example, when the printer has not
been used for a long period of time and requires more time to prepare the printheads.

Alerts

Your printer can communicate two types of alerts:

e  FErrors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer
driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is
able to print.

e  Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or for a
possible unprintable situation, such as a preventive maintenance or low ink.
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There are four different alerts communicators within your printer's system:

e  Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a warning,
it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear
when the printer becomes idle and there is not another more severe alert.

X TIP: From the front panel display you can configure paper mismatch alerts, see Solve paper mismatch
on page 88.

e  Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer
status. If there is an alert in the printer, the status shows the alert text.

e  Driver: The driver warns about job configuration settings that may produce a problem in the final output. If
the printer is not ready to print, it displays a warning.

e  HP DesignJet Utility: To see alerts, go to the Overview tab and review the ltems needing attention list on
the right-hand side.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem that
prevents ajob from completing, you see a pop-up window, which explains the reason for the problem.
Follow the instructions to achieve your required result.
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20 Front-panel error messages

The printer may occasionally display a system error, consisting of a numerical code of 12 digits followed by the
recommended action that you should take.

In most cases you will be asked to restart the printer, because when the printer starts it can diagnose the issue
better and may be able to fix it automatically. If the problem persists after restarting, you should contact your
support representative and be ready to give the numerical code from the error message.

If the error message contains some other recommended action, follow the printer’s instructions.

System error log

The printer saves a log of system errors that you can access in the following way.

Using a USB flash drive
1. Take astandard USB flash drive, formatted as FAT32.

2. Create an empty file in the USB flash drive (right-click, New > Text Document), and name it
pdipu_enable.log.

3. When an error message is displayed on the front panel, insert the USB flash drive into the Hi-Speed USB
host port at the front of the printer. The log is automatically copied into the drive. You can remove the USB
flash drive when prompted by the front panel.

4.  Contact your support representative (see Contact HP Support on page 223) to share the file created in the
USB flash drive.

Using the Embedded Web Server
1. Inyour Web browser, go to https://printer IP address/hp/device/support/serviceSupport.
2. Click the Download button to get the Diagnostic package.

3. Save the package in your computer and contact your support representative (see Contact HP Support
on page 223).

220 Chapter 20 Front-panel error messages ENWW



21

ENWW

HP Customer Care
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° Customer Self Repair

° Contact HP Support
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Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing
comprehensive, proven support expertise and new technologies to give you unique end-to-end support.
Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services,
phone and Web support, software updates and self-maintenance services. To find out more about HP Customer
Care, see Contact HP Support on page 223.

To register your warranty, visit http://registerhp.com/.

HP Professional Services

HP Support Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your
HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24x7 access to:

e  Multimedia tutorials

e  Step-by-step how-to guides

e  Downloads: the latest printer firmware, drivers, software, paper presets, etc.

e  Technical support: online troubleshooting, customer care contacts and more

e  Workflows and detailed advice for completing various printing tasks from particular software applications
e  Forums for direct contact with the experts, both HP and your colleagues

e  Warranty tracking online, for your peace of mind

e  Latest product information: printers, supplies, accessories, software, etc.

e  Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/DesignJetT2600/support.

By customizing your registration for the products you have purchased and your type of business, and by setting
your communication preferences, you decide the information you need.

Download printer software

Install the printer software from http://www.hp.com/go/DesignJetT2600/drivers. Be sure to follow the software
installation instructions.

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time
options:

e  Next business day

e  Same business day, within four hours (may not be available in all countries)
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There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, see http://cpc.ext.hp.com/portal/site/cpc.

Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It
enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this
program, you can replace parts at your own convenience.

Convenient, easy to use

e  AnHP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

e  Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact
HP.

e  Available for most HP products currently under warranty or contract.
e  Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support

HP Support is available to you by telephone. What to do before you call:

e  Review the troubleshooting suggestions in this document.

e  Review the relevant driver documentation.

e Ifyou have installed third-party software drivers and RIPs, see their documentation.

e Ifyou call your support representative, please have the following information available to help us answer
your guestions more quickly:

—  The product you are using (the product number and the serial number, found on the label at the back
of the product).

— Ifthereis an error code on the front panel, note it down; see Front-panel error messages
on page 220.

—  The computer you are using.

—  Any special equipment or software you are using (for example, spoolers, networks, switch-boxes,
modems or special software drivers).

—  The type of interface used on your product (USB or network).
—  The software and driver name and version number that you are currently using.

—  The Printer Service information, which you can get from the Embedded Web Server. In a Web browser,
enter the IP address of your printer to access the Embedded Web Server. Then click Support > Service
support > Service information > Display. If you need to send the information by email, you can
download it as a file from your browser, and later send the file.
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[% NOTE: After you click Display, your browser may prevent the pop-up window from opening. In this
case, you have to find the browser option that allows the window to open.

Alternatively, from your browser you can send the page directly: click File > Send > Page by email.

Telephone number

Your HP Support telephone number is available on the Web: see http://welcome.hp.com/country/us/en/
wwcontact_us.html.
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22 Printer specifications

° Functional specifications

° Mobile printing specifications

° Physical specifications

° Memory specifications

° Power specifications

° Environmental specifications

° Acoustic specifications
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Functional specifications

HP ink supplies

Printhead One printhead, with doubled nozzles for matte black

Ink cartridges Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta, and
cyan
Cartridges containing 300 ml of ink: gray, photo black, matte black, yellow, magenta, and
cyan

Paper sizes

Minimum Maximum

Roll width 279 mm (11in) 914 mm (36 in)

Roll length 91 m (300 ft)

Roll diameter 140 mm (5.57 in)**

Roll weight 11.9kg (26.3 Ib)

Sheet width 210 mm (8.26in) 914 mm (36in)

Sheet length 279 mm (11in) 1676 mm (66 in)

Sheet width (scanner) 914 mm (36in)

Sheet length (scanner) 15m (49.21 ft) at 200dpi, TIFF file format and 24

in width

Roll paper thickness 0.5 mm (19.7 mil)*

Sheet paper thickness 0.5 mm (19.7 mil)*

Paper weight 60 g/m?2 328 g/m?

*up to 0.6 mm (23.6 mil) printed to the output stacking tray with manual mode.

**Roll core diameter of 51 mm (2 in). Paper with roll core diameter of 76 mm (3 in) can be used with the HP
DesignJet 3-in Spindle Adaptor Kit (see 3-in Spindle Adaptor Kit on page 180).

Printing resolutions

Rendering resolution  Printing resolution

Print quality Maximum detail Graphic language (ppi) (dpi)
Best (photo paper®) On HP PLC3GUI 600 x 600 2400 x 1200
PostScript/PDF
Off any 600 x 600 1200 x 1200
Best (other papers) Off any 600 x 600 1200 x 1200
Normal Off HP PCL3GUI, 600 x 600** 1200 x 1200
PostScript/PDF
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Printing resolutions (continued)

Rendering resolution  Printing resolution

Print quality Maximum detail Graphic language (ppi) (dpi)

Fast (heavyweight coated, photo) Off HP PCL3GUI, 600 x 600** 1200 x 1200
PostScript/PDF

Fast (plain, coated, natural tracing paper) Off HP PCL3GUI, 600 x 600** 600 x 1200
PostScript/PDF

Economode Off any 300 x 300 600 x 1200

* For a list of supported papers, see Order paper on page 176.

** Except Backlit papers (300 x 300 ppi).

Scanner resolutions: 200, 300, 600 ppi.

Margins
Top, right and left margins 5mm (0.2 in) (default) / 3 mm (0.7 in) (optional)
Bottom margin (trailing edge) 5mm (0.2 in) (default) / 3 mm (0.1 in) (optional) (roll)

22 mm (0.87 in) (sheet)

Mechanical accuracy

+0.1% of the specified vector length or £0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AO printing material
in Best or Normal mode with HP Matte Film roll feed.

Graphic languages supported

HP DesignJet Languages
T2600MFP HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, URF
T2600MFP PS HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, URF, Adobe PDF 1.7, Adobe PostScript 3

ENWW Functional specifications 227



Mobile printing

Mobile printing specifications

Mabile printing

Yes, directly from Android with HP Print Service Plugin

Mabile devices supported by
HP Mobile printing

Smartphones and tablets

Supported operating systems

i0S, Android, Windows

0S Versions

i0S from 7.0 and Android from 4.4, Windows any

Connectivity requirements

Printer and mobile device must use the same network

Supported file formats

PDF, JPEG

Email printing

Mabile devices supported

Smartphones, tablets, PC

Supported operating systems

Any, as long as it has email

Connectivity requirements

Cloud connection

Cloud features

Remote printing through email

Supported file formats

PDF, JPEG, TIFF

Max file size

10MB

Physical specifications

Printer physical specifications

Weight 109 kg (240 lb)
Width 1535 mm (60.4 in)
Depth 920 mm (36.2 in) (stacker and basket open)

760 mm (29.9 in) (stacker and basket closed)

Height 1240 mm (48.8 in) (stacker and front panel deployed)

Memory specifications

Memory specifications
HP DesignJet Physical DRAM File-processing memory Hard disk
T2600MFP Printer Series 8 GB 128 GB 500 GB encrypted
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Power specifications

Printer power specifications

Input voltage 100-240V ac +10%, auto-ranging
Frequency 50/60 Hz

Maximum current <2A

Power <120W

Environmental specifications

Printer environmental specifications

Operating temperature

50 35°C (41 to 95°F)

Recommended operating temperature

15 to 35°C (59 to 95°F), depending on paper type

Storage temperature

—-251t055°C(-13to 131°F)

Recommended operating humidity

20 to 80% RH, depending on paper type

Storage humidity

0t095% RH

Acoustic specifications

Declared noise emission levels for the HP DesignJet T2600 Printer Series. Sound pressure levels at bystander
positions and sound power levels measured per ISO 7779.

Printer acoustic specifications

Operating sound pressure

42 dB(A) (plain paper, line drawing, normal mode)

57 dB(A) (color scan)

Operating sound power

<5.9 B(A) (plain paper, line drawing, normal mode)

<6.6 B(A) (color scan)

Idle sound pressure

32 dB(A) (ready)

<17 dB(A) (sleep)

Idle sound power

<4.9 B(A) (ready)

<3.5B(A) (sleep)
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Glossary

AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP and
Bonjour networking instead. HP DesignJet products no longer support AppleTalk.

Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a
particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of
the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the
printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to
minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the
printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink cartridges). Additionally, to
reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body
movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec

A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes
on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware
whether IPSec is being used or not.

IPv4 address
A unigue identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated
by full stops. Most networks in the world use IPv4 addresses.

IPv6 address

A unigue identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the
world use IPv6 addresses.

Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level
identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Network

A network is a set of connections that pass data between computers and devices. Every device is able to communicate with
every other device in the same network. This allows data to be moved between computers and devices, and allows devices
such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped,
dried and pressed.
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Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it
on the paper, through a cluster of nozzles. In your printer, each printhead prints two different colors.

Spindle
Arod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers.

USB host port
Arectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.
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